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1 Out of Box Audit 
When you receive the instrument, some inspections are necessary, and the condition must be understood and available before 

installing the instrument. 

1.1 Inspect the Package 

Inspect the shipping container for damage after unpacking it. It is not recommended to power on the instrument in the case of 

a damaged container. If the contents in the container do not conform to the packing list, notify us or your dealer. 

1.2 Power Connection 

1) Power-Supplying Voltage Range: 100 ~ 120 V AC or 198 ~ 242 V AC, depending on the power setup on the rear panel. 

2) Power-Supplying Frequency Range: 47 ~ 63 Hz 

3) Power-Supplying Power Range: < 80 VA 

4) The power-supplying input phase line L, zero-line N, ground lead E should be as same as the power plug of the instrument. 

5) After careful design, the instrument can reduce the clutter jamming caused by AC power terminal input, however, it should 

be used under the environment with low noise. Please install power filter if being unavoidable. 

WARNING! 

 

In order to prevent user and instrument from being hurt by leakage, it is necessary for user to guarantee the 

ground line of supply power being reliably grounded. 

1.3 Fuse 

The instrument has installed fuse, so operators should use the installed fuse of our company. 

WARNING! 

 
Be sure that the location of fuse is consistent with power-supplying voltage range before charging. 

1.4 Environment 

1) Please do not operate the instrument in an environment where it may be exposed to vibration, dust, direct sunlight or 

corrosive air! 

2) The normal working temperature is 5 °C ~ 40 °C, with a humidity of ≤ 75 % RH. Use the instrument under these conditions 

to guarantee its accuracy. 

3) There is a heat abstractor on the rear panel to avoid the inner temperature rising. Sufficient space should be provided for 

side and rear air vents to ensure air circulation and maintain accuracy. 

4) Although the instrument has been specially designed for reducing the noise caused by ac power, a place with low noise 

is still recommended. If this cannot be arranged, please make sure to use power filter for the instrument. 

5) Please only store the instrument in an environment where the temperature is between -20 °C ~ 60 °C, with a humidity of 

< 85 % RH. If the instrument will not be used for an extended period of time, please store it properly packed in its original 

box or similar packaging. 

6) The instrument, especially the test cables, should be kept as far away as possible from any strong electromagnetic field, 

to avoid interference during measurement. 
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1.5 Use of Test Fixture 

Please only use the included or additionally purchased original cables and test fixture, as foreign ones may lead to incorrect 

measurements. The test fixture or cable should be kept clean, as well as the DUT pin, to ensure a good con-nection between 

the DUT and fixture. 

Connect the fixture or cables to the four test terminals Hcur, Hpot, Lcur, Lpot on the front panel. For a DUT with shielding, 

connect it to the ground connection ┴. 

Note: If neither test fixture nor cables have been connected, the instrument will display an unstable measurement result. 

1.6 Warm-Up 

1) To guarantee an accurate measurement, the instrument should be given a warm-up time of no less than 30 minutes. 

2) Please do not switch the instrument on and off unnecessarily; this may affect measurement accuracy. 

1.7 Other Features 

• Power: Consumption power ≤ 80 VA 

• Dimension (W × H × D): 400 mm × 132 mm × 385 mm 

• Weight: About 13 kg 

1.8 Safe Usage 

WARNING! 

 

Please use the power button to switch the device on and off. It is prohibited to unplug the power cord or 

disconnect the power supply before the device is completely turned off, otherwise it will damage the device 

hardware and affect the service life of the device. 

It is recommended not to install other software in the device, which may affect the working status of the device! 

If you want to use this device to connect to the internet, it is recommended to install your own antivirus software! 
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2 Introduction 
In this chapter, the basic operation features of ST2851 will be described. 

2.1 Introduction to Front Panel 

 

Figure 2-1 Front Panel 

1) CHANNEL/TRACE 

Switch to curve sweep function and switch channels and curves 

• [Sweep] 

Switch the instrument interface to the sweep interface, and the button signal light is on. 

• [Channel Prev] 

When the instrument function is trace sweep, activate to the previous channel. When this key is pressed, the active 

channel will change from the current channel to the channel with the channel number smaller than the current one. 

Only when the channel is activated, its parameters can be modified. Therefore, use this key to activate the channel 

before changing the channel setting. 

• [Channel Next] 

When the instrument function is trace sweep, activate to the next channel. When this key is pressed, the active 

channel changes from the current channel to the channel with a larger channel number than the current one. 

• [Trace Prev] 

When the instrument function is trace sweep, activate to the previous trace. When this key is pressed, the active 

trace will change from the current trace to a trace whose trace number is smaller than the current one. Only when 

the trace is activated, its parameters can be modified. Therefore, use this key to activate the trace before changing 

the trace settings. 

• [Trace Next] 

When the instrument function is trace sweep, activate to the next trace. When this key is pressed, the active trace 

changes from the current trace to the trace with a larger trace number than the current one. 

• [Channel Max] 

When the instrument function is trace sweep, the display window of the selected channel will be switched between 
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maximum display and normal display. When set to normal display, all set channels (whether activated or not) are 

displayed separately on the screen; when set to maximize display, the display window of the active channel occupies 

the entire display area, and the inactive channel is no longer displayed, the measurement of the inactive channel 

will still be performed. 

• [Trace Max] 

When the instrument function is trace sweep, the display state of the active trace is switched between maximum 

display and normal display. When set to normal display, the traces with settings (whether activated or not) will be 

displayed in the channel display window; when set to maximum display, only the activated traces will be displayed 

in the channel window, and other districts and counties will no longer be displayed. Measurements that do not display 

a trace will still be performed. 

2) STIMULUS 

Parameter setting of the trace stimulus source 

• [Sweep Setup] 

When the instrument function is trace sweep, open the sweep setup menu in the menu bar, you can set the signal 

source parameters, sweep time, number of trace points, etc. 

• [Sweep Type] 

When the instrument function is trace sweep, open the sweep mode setting menu in the menu bar to change the 

sweep mode of the current channel. 

• [Start] 

When the instrument function is trace sweep, open the sweep range menu in the menu bar, and place the cursor in 

the sweep start value input area to set the start value of the sweep range. 

• [Stop] 

When the instrument function is trace sweep, open the sweep range menu in the menu bar, and place the cursor in 

the sweep end value input area to set the end value of the sweep range. 

• [Center] 

When the instrument function is trace sweep, open the sweep range menu in the menu bar, and place the cursor in 

the sweep center value input area to set the center value of the sweep range. 

• [Span] 

When the instrument function is trace sweep, open the sweep range menu in the menu bar, and place the cursor in 

the span input area to set the sweep range. 

3) MKR/ANALYSIS 

Marker and Trace Analysis 

• [Marker] 

When the function of the instrument is trace sweep, open the marker setting menu in the menu bar, you can set the 

marker such as the switch of the marker and the position of the marker can be changed by inputting the value of the 

stimulus value. You can place 10 markers on each curve. 

• [Marker Search] 

When the instrument function is trace sweep, open the marker search menu in the menu bar, and the operation 

menu can move the marker to a specific point on the trace (maximum point, minimum value point, extreme value 

point and specific test value point). 

• [Marker Function] 

Open the marker function menu in the menu bar, and the operation menu can set the sweep range, switch statistical 

data display, etc. According to the marker position. 
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• [Analysis] 

When the function of the instrument is trace sweep, open the trace analysis menu in the menu bar and the operation 

menu can perform the sorting settings in the scanning, as well as the analysis and simulation of the equivalent 

circuit. 

4) RESPONSE 

Used to set the response for the instrument measurement data 

• [Meas] 

When the instrument function is trace sweep, open the measurement setting menu in the menu bar, and the opera-

tion menu can set the measurement parameters of each trace, and switch the display of offset monitoring. 

• [Format] 

When the instrument function is trace sweep, open the ordinate format menu in the menu bar, and the operation 

menu can change the ordinate type of each trace. 

• [Scale] 

When the instrument function is trace sweep, open the coordinate axis setting menu in the menu bar, and the oper-

ation menu can set the vertical coordinate distribution and scaling (including reference position, coordinate division, 

etc.) of each trace. 

• [Display] 

When the instrument function is trace sweep, open the display setting menu in the menu bar, you can specify the 

display mode of channels and traces, set the number of traces, set the value memory, etc. 

• [Avg] 

When the function of the instrument is trace sweep, open the measurement speed menu in the menu bar, and you 

can set the trace sweep speed, the number of sliding averages, and the switch. 

• [Cal] 

When the instrument function is trace sweep, open the user calibration interface in the menu bar, and user calibration 

can be performed. 

5) LCR METER 

Switch the instrument function to the bridge function, and the corresponding function keys 

• [LCR] 

Switch the instrument interface to the point measurement interface, and the button signal light is on. 

• [Meas] 

When the instrument function is point measurement, open the measurement setting menu in the menu bar, and you 

can modify the measurement frequency, range, trigger mode, signal source and other parameters. 

• [Display] 

When the instrument function is point measurement or list sweep, open the measurement parameter setting menu 

in the menu bar, and you can set all the current measurement parameters. 

• [Point/List] 

Switch between point measurement interface and list sweep interface on the screen. 

• [Cal] 

Switch to the user calibration interface, user calibration can be performed. 

• [DC Bias] 

The switch that loads the bias voltage, and the signal light will be on and OFF according to the switch state. 

6) ENTRY 

Keys related to data entry 
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• [0] ~ [9] 

Numeric keys, used to input corresponding numbers. 

• [+] / [–] 

Modify the sign of the input value. 

• [T/p], [G/n], [M/μ], [k/m], [x1] 

Unit keys. When the unit key is pressed, one of the two units in the key name is automatically selected according to 

the entered parameter. The x1 key does not enter any units. 

• [ESC] 

Cancel, which is used to cancel operations in time-consuming operations such as calibration, and to cancel the input 

and restore the previous value during numerical input. 

• [BS ] 

Backspace key, used to backspace while typing. 

• [Help] 

Call out the help document, which can be used to unlock the screen and front panel when they are locked. 

7) INSTR STATE 

The setting button of the instrument state function 

• [Save/Recall] 

Open the save and load menu in the menu bar (bridge and sweep are different menus), you can save and load 

measurement parameter settings and measurement results. 

• [System] 

Open the system settings menu in the menu bar, you can perform various system settings. 

• [Preset] 

After the key is pressed and confirmed, the instrument will return to the initial state. 

8) TRIGGER 

Trigger related settings of the instrument 

• [Trigger Mode] 

Open the trigger setting menu and set the trigger mode. 

• [Hold] 

Set the current measurement mode to hold state. 

• [Trigger] 

Trigger a measurement. 

9) JUDGEMENT 

Display of sorting results, non-operation keys 

• PASS 

When the sorting is passed, the signal light is on. 

• FAIL 

When the sorting fails, the signal light is on. 

10) Direction Keys and Dial 

Used to move the input cursor and adjust the input value. 

• Scroll Wheel 

When inputting numerical value, increase or decrease the input numerical value with a smaller division value. 
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• Up and Down Keys 

When entering numerical values, increase or decrease the entered numerical value with a larger division value. 

• Left and Right Keys 

Move the input cursor left and right when entering numerical values. 

11) Switch Button 

This button is used to switch the instrument on and OFF. The button light illuminates when the instrument is turned on. 

12) Touch Screen 

ST2851 is equipped with a 10.1-inch touch screen for displaying numerical values, traces, division values, setting values, 

keys, and other measurement-related information. You can operate the keys on the screen by clicking with your finger. To 

learn more about touch screens, see the "Display Areas" section. 

WARNING! 

 

Do not use sharp objects (such as toothpicks, pen tips, screwdrivers, etc.) to press on the touch screen surface. 

Pressing the screen with a sharp object may damage the screen or cause dead spots on the screen. 

Note: The ratio of effective dots on the touch screen should be greater than 99.998 %, and the dead dots less than 0.002 

% are not considered screen damage. 

13) Test End 

The four-terminal test terminal is used to connect the four-terminal test fixture or test cable to measure the DUT. 

• Current excitation high side (Hcur) 

• Voltage sampling high-end (Hpot) 

• Voltage sampling low end (Lpot) 

• Current excitation low side (Lcur) 

14) USB Interface 

USB interface can be used to connect USB devices, such as mouse, keyboard, storage device, etc. 

2.2 Introduction to Rear Panel 

 

Figure 2-2 Rear Panel 
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1) Serial Label 

Indicate the production date, manufacturer, instrument number and other information. 

2) Handler Interface 

Handler signal input and output. 

3) USB Device Interface 

USB communication interface to realize communication with other devices. 

4) Ground Terminal 

Connected to the chassis, used to protect or shield the ground connection. 

5) RS232 Serial Interface 

Serial communication interface, realize communication with other equipment. 

6) Power Socket 

Used to supply AC power to the device. 

7) Fuse Holder 

Used to install fuse, protect the instrument, can switch 1 10 V/220 V. 

8) GPIB Interface 

GPIB interface realizes communication with other devices. 

9) Main Board Interface 

The general interface of the computer main board, including USB port, video output port (the screen can be put on other 

video output devices), audio input and output port, LAN port (network interface, realize the communication and control of 

network system). 

2.3 Screen Areas 

2.3.1 Screen Interface Display 

ST2851 includes a variety of measurement interface displays and setting interface displays. The main function interfaces are 

shown in the following table: 

Display Type Function 

Measurement 

Interface 

Point Measurement 

Interface 

The parameters of the measured point and the measurement results are displayed 

in the interface. 

List Measurement 

Interface 

All measurement points and their measurement results are displayed in a table on 

the interface. 

Sweep Measurement 

Interface 

The curve drawn by the measurement points and their measurement results is 

displayed in the coordinate axes of the interface. 

Set Interface 

User Calibration 

Interface 

All user calibration point settings and calibration values are displayed in a table in 

the interface. 

Accessory Calibration 

Interface 
Step prompts for user fixture calibration are displayed in the interface. 
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Point Comparator 

Setting Interface 

In the interface, the setting value of point measurement and comparator is dis-

played. 

List Setting Interface 
All the points to be measured and their setting parameters are displayed in the 

table of the interface, and all points are arranged in order in the table. 

List Quick Edit Interface Quick setup of measuring points for list sweep. 

List Comparator Setting 

Interface 
The setting value of list sweep comparator is displayed in the interface. 

Sweep Comparator 

Setting Interface 

The trace sweep comparator parameter settings are displayed in the table of the 

interface. 

Sweep Segment Setting 

Interface 
The settings of the trace sweep segment are displayed in the table of the interface. 

2.3.2 Point Measurement Display Interface 

Press the LCR button on the front panel, the point measurement interface will be displayed on the screen, as shown in the 

figure below: 

 

1) Channel Number 

The highlighted channel is the currently active channel. There can be 8 channels in the point measurement mode at the 

same time, and each channel can set different measurement conditions (frequency, level, bias, etc.) and measurement 

parameters. Channels can be switched by clicking the channel number button. 

2) Measurement Conditions 

The measurement conditions of the current channel are displayed in the area, including measurement frequency, meas-

urement time, OSC level, AC range, DC bias, and average count. These variables can be changed in the Measurement 

Setup menu. Clicking a control in this area, the menu area will open the "Measurement Settings" menu and automatically 

navigate to the clicked variable. 

3) AC and DC Monitor 

It displays the currently measured AC/DC current and voltage monitoring values. The monitor mode can be changed in 

the "Measurement Settings" menu; click on this area, the menu area will open the "Measurement Settings" menu. 

4) Menu Name 

It displays the name of the current menu, displayed at the top of the menu. 
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5) Menu 

It displays the currently opened menu. The menu contains different types of buttons: normal buttons, editable content 

buttons, selection buttons, etc. An arrow on the right side of the button means that pressing the button will open a sub-

menu; a black square on the left side of the button means the button is currently selected. 

6) Time Display 

It displays the current system date and time. 

7) Device Status 

Various current measurement states are displayed. As shown in the table below: 

Display Definition 

Open (shown in blue) User open calibration is turned on. 

Short (shown in blue) User short calibration is turned on. 

Load (shown in blue) User load calibration is turned on. 

Phase (shown in blue) User phase calibration is turned on. 

Bias (shown in red) Bias voltage is turned on. 

Lock (shown in red) Front panel and screen operations are locked. 

Pass (shown in green) Comparator is passed. 

Fail (shown in red) Comparator is failed. 

Acce (shown in blue) User accessory calibration is turned on. 

Meas (shown in blue) The current trigger mode is internal trigger (continuous measurement). 

Manual (shown in blue) The current trigger mode is manual trigger. 

External (shown in blue) The current trigger mode is external trigger. 

Bus (shown in blue) The current trigger mode is bus trigger. 

8) Measurement Parameters and Results 

It displays the current measurement parameters and measurement results. ST2851 supports simultaneous display of up 

to 4 measurement parameters. Click this area to modify measurement parameters and display settings for measurement 

results (such as reference values, math operations, significant digits, etc.). 
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2.3.3 List Measurement Display Interface 

The list measurement display interface is shown in the following figure: 

 

1) Channel Number 

The highlighted channel is the currently active channel. There can be 8 channels in the list mode at the same time, and 

each channel can set different environmental variables (frequency, level, bias, etc.) and measurement parameters. Chan-

nels can be switched by clicking the channel number button. 

2) Measured Point Serial Number 

The serial number of the measured point is displayed, which can be modified in the list setting page. 

3) Measurement Conditions 

It displays the measurement conditions of the measured point, including: measurement frequency, average count, OSC 

level, AC range, and DC bias. These parameters can be modified in the list settings page. 

4) Measurement Parameters and Measurement Results 

The current measurement parameters and measurement results of the measured point are displayed in sequence. The 

parameters to be measured can be changed in the measurement parameters menu. 

2.3.4 Sweep Measurement Display Interface 

Press the [Sweep] button, and the sweep measurement interface will be displayed on the screen. The main part of the interface 

is the channel window, as shown in the following figure: 
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1) Moving Average State 

This status is only displayed when moving average is turned on. The display format is n/m, where m is the set number of 

moving averages, and n is the moving average count. The moving average switch and counts can be changed in the 

measurement speed menu. 

2) Channel Number 

The serial number of the channel displayed in the current window. The active window can be switched by pressing [Chan-

nel Prev] and [Channel Next] buttons, and you can switch to the channel directly by clicking the channel window. 

3) DC Monitor 

When the DC monitor is turned on, the current measured DC level and the current monitor value are displayed. 

4) Equivalent Circuit Simulation Results 

The selected equivalent circuit model and simulated resistance, capacitance, and inductance values are shown. This 

graph is displayed on the channel window when the equivalent circuit result display is turned on. 

5) Ordinate Label 

The tick distribution of the ordinate axis of the coordinate system is displayed. When the measured trace exists in the 

coordinate system, this area will display the set ordinate scale label of the currently active trace. The ordinate reference 

value (highlighted) can be changed in the Axis Settings menu. At the same time, you can also set the ordinate value of 

the selected marker as the reference value in the marker function menu. The ordinate scale distribution, ordinate reference 

value, etc. Can also be manually changed or automatically set in the axis setting menu. 

6) Marker 

The marker is used to read measurements on the trace. Up to 10 markers can be displayed on a trace. The shape of 

marker 1 in the figure represents the activated marker, and the shape of marker 2 is the inactive marker. The active marker 

can be toggled through the marker settings menu or by clicking on the marker value field. At the same time, you can also 

modify the position of the marker in the marker setting menu, and drag the screen with your finger in the coordinate system 

to directly drag the position of the activated marker. 

7) Marker Value 

It displays the abscissa values of all current markers and the degrees of measurement values on each trace. The ">" 

symbol before the marker serial number indicates that the marker is the currently activated cursor. Clicking on this area 

will switch the active marker to the next marker. 

8) Marker Statistics Parameters 

It displays statistics (range, average, standard deviation, peak-to-peak) for all points of the current trace between marker 1 

and marker 2. The display can be turned on or OFF in the marker function menu. When the display is turned on, if marker 1 

and marker 2 are not turned on, marker 1 and marker 2 are automatically turned on. 

9) Measurement Parameters 

It displays the measurement parameters of the current trace. Measurement parameters can be changed in the measure-

ment setup menu. 

10) Signal Source Voltage/DC Bias/Non-Sweep Frequency 

The signal source voltage, DC bias and frequency of the sweep are displayed, which will be displayed differently in differ-

ent sweep modes, as shown in the following table: 
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Sweep Mode Display Type 

Sweep Frequency Signal source voltage and bias voltage (bias voltage on) 

Sweep Signal Source Level Non-sweep frequency and bias voltage (bias voltage on) 

Sweep Bias Voltage Non-sweep frequency and signal source voltage 

11) Ordinate Scaling Value 

It displays the current ordinate scaling value of each trace. When the vertical axis of the trace is the linear axis, the display 

format is "Scale/Reference"; when the vertical axis of the trace is the logarithmic axis, the display format is "Top/ Bottom". 

12) Span 

It displays the sweep range of the current channel. 

13) Trace Number 

It indicates the trace name and trace number (eg Tr1) in the current channel. The trace name is consistent with the color 

of the trace itself. The triangle symbol before the name indicates that the trace is the active trace, and the settings in the 

current channel coordinate system are based on the active trace. The activated traces can be switched via the [Trace 

Next] and [Trace Prev] buttons on the front panel, or by clicking on the trace number area in the screen. 

14) Trace State 

The possible states for each trace are shown in the following table: 

Classification Status (enclosed in [ ]) Meaning 

When the trace math operation is set to 

OFF, it will be distinguished according to the 

different display states of the trace and the 

stored trace. 

No State Trace display is ON, the stored trace display is OFF. 

M Trace display is OFF, the stored trace display is ON. 

D & M Trace display is ON, the stored trace display is ON. 

OFF Trace display is OFF, the stored trace display is OFF. 

When the trace display is ON and the math 

operation of the trace is not OFF, it is distin-

guished according to the math operation of 

the trace. When the stored trace display is 

ON, it is the state inside (). 

D + M (D + M & M) Math Operations: Calculate Data + Stored Data 

D – M (D – M & M) Math Operations: Calculate Data – Stored Data 

D × M (D × M & M) Math Operations: Calculate Data × Stored Data 

D / M (D / M & M) Math Operations: Calculate Data / Stored Data 
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2.3.5 User Calibration Interface 

The user calibration page displays the calibration settings made by the user, and the user can perform specific calibration 

operations and view calibration data. The specific interface is shown in the following figure: 

 

1) Calibration Point List 

It displays the status of all user calibration points and the calibration data that has been performed. ST2851 provides a 

total of 20 user calibration points; each point has an independent switch and frequency settings. At the same time, the list 

also displays the load reference value, open circuit calibration value, short circuit calibration value and load calibration 

value of the calibration point. Click the row of the calibration point to open the corresponding calibration point setting 

menu. 

2) Calibration Point Setup 

The selected calibration point can be set. Settings include switching, measurement frequency, and load reference. Among 

them, if the calibration point is turned OFF, then in the measurement, the calibration point will not work. The load reference 

parameter will depend on the load type setting. 

3) Point Calibration 

Point calibration can be performed on the currently selected calibration point, including open clear, short clear, and load 

calibration. These calibration data will only be used in the measurement if the calibration point is turned on. 

2.3.6 Accessory Calibration Interface 

The main function is to guide the user to perform accessory calibration, as shown in the following figure: 
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1) Calibration Steps 

The overall progress of the calibration is displayed. Unfinished steps are light gray, completed steps are dark gray, and 

currently active steps are light yellow. You can navigate to a completed step by pressing the button in the menu bar or 

click the step label, and re-calibrate the step (except for some special steps). 

2) Calibration Guide 

Operational guidance for the current calibration step. Follow the instructions to complete the fixture calibration. 

2.3.7 Point Measurement and Comparatpor Setting Interface 

The point measurement and comparator interface shows the conditions for point measurement and comparator, as shown in 

the following figure: 

 

1) Set Serial Number 

The comparator page also has 8 setting pages, and 8 different comparator settings can be performed at the same time. 

The comparator setting page corresponds to the channel of the point test, that is, the comparator setting with serial 

number 1 will be applied to the channel 1 of the point test, and so on. 

2) Good BIN Setup 

It is used to set good BINs and bad BINs. As shown in the figure, it is set to ~BIN3, that is, BIN1 ~ BIN3 are good BINs, 

and BIN4 ~ BIN10 are bad BINs. 

3) Channel State 

Comparator state (channel switch, etc.) can be set and displayed. When the BIN is OFF, it is considered that the BIN 

does not exist during sorting. There are a total of 10 sorting BINs, good BINs are displayed in green, and bad BINs are 

displayed in red. 

4) Comparator Setup 

It is used to set compataror state. There are 4 compataror states for comparator at the same time, and each state has 

independent switches, comparator parameters, operation types, reference values, etc. When the compataror state is 

turned OFF, the corresponding state settings and comparator conditions cannot be set. In the compataror table menu, 

there will be more serial number settings for the points to be sorted. 

5) Comparator Conditions 

Comparator settings for each BIN can be made. The BIN comparator conditions correspond to 4 comparator settings, and 

the comparator qualified interval, upper limit and lower limit can be set. If the test value is within the qualified range, the 

sorting is passed, otherwise it is failed. 
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2.3.8 List Setting Interface 

 

1) Desktop Tab 

Switch to the current setting page. You can switch to the stimulus setting interface and the comparator setting interface. 

2) Points to be Measured 

It displays all the points to be measured and their measurement parameters in the current channel. Click the row of the 

point to be measured (except the first column), the menu bar will open the setting menu corresponding to the point to be 

measured, and click the first column to return to the root menu. 

3) Point Parameter Setting 

The measurement parameters of the current point can be changed. 

2.3.9 List Quick Edit Interface 

The list quick edit page can quickly set the measurement points. 

 

1) Quick Settings Area 

Quickly set measurement point parameters. 

2) Setup is Complete 

Confirm the setting of the stimulus measurement point, save the set data, exit the current interface and return to the 

stimulus setting interface. 
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2.3.10 List Comparator Setting Interface 

Please refer to the point measurement comparator setting interface. 

2.3.11 Sweep Comparator Setting Interface 

Comparator condition settings for sweep test. Before entering this page, first of all, it is necessary to save the current trace to 

the storage data as the reference data for comparator. The sweep comparator setting page is shown below: 

 

1) Comparator Condition List 

The comparator conditions that have been set are displayed. Different comparator conditions are sorted according to 

frequency, and the frequency range does not exceed the sweep frequency range. Click the frequency criteria (except the 

first column) to open the comparator settings menu; click the first column to return to the root menu. 

2) Comparator Condition Setting 

Set the selected comparator conditions. You can set the comparator type; begin stimulus and end stimulus, upper limit 

and lower limit. Among them, the setting of the comparator upper and lower limits is related to the selected comparator 

type. When the comparator type is numeric, to set the numerical value; when the sorting type is percentage, to set the 

percentage. 

2.3.12 Sweep Segment Setting Interface 

This screen shows the settings for the sweep frequency segment. This setting only takes effect when the sweep mode is set 

to segmented sweep. The sweep segment interface is shown in the following figure: 
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1) Segment Table 

All segmentation settings are displayed. All segments are sorted by frequency, and the start frequency of the next segment 

is not lower than the end frequency of the previous segment, and not higher than the end frequency of the same segment. 

Except for frequency and number of points, the display of other parameters needs to turn on the corresponding switches 

in the root menu. Click the segment condition (except the first column) to open the corresponding segment setting menu; 

click the first column to return to the root menu. 

2) Segment Setting 

The selected segment can be set, including frequency (the format includes start/stop and central/span, which can be 

switched in the root menu), number of points, level, bias, etc. Among them, except the frequency and the number of 

points, other parameters can only be set by turning on the corresponding switch in the root menu. 

3) Points 

It shows the point statistics for the current segment setting. The total number of points must not be less than 2, and at 

least one point is required under each segment setting. 

2.4 Measurement Examples 

This section will guide you through the basic operation of the ST2851 with a single measurement example. If you are new to 

the ST2851, this section will help you to quickly become familiar with ST2851. 

2.4.1 Equipment Requirements 

In order to be able to complete all the steps of this example, you need to prepare the following measurement equipment. 

• ST2851 

• ST26005C Fixture 

• 100 Ω Resistor 

• Standard Open and Short Test Pieces 

• Crystal Resonators 

2.4.2 Measurement Preparation 

Complete the preparation of the ST2851 for measurement by following the steps below. This ensures that the ST2851 is 

properly installed and set up. 

2.4.2.1 Connection Fixture ST26005C 

Connect the fixture ST26005C to the ST2851: 

1) Align the 4 test ends of the ST26005C with the test ends on the ST2851, and gently insert the fixture until the two test 

ends are fully fitted; 

2) Turn the rotating operating lever on the test end of the ST26005C fixture clockwise to ensure the stability of the fixture 

during measurement; 

3) When removing the clamp, perform the above steps in reverse order. 
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2.4.2.2 Turn On the Power 

ST2851 can be activated by pressing the switch button. After startup, the program of ST2851 will start automatically, and check 

whether various files are completed during startup. After everything is ready, the device first enters the point measurement 

interface. 

Note: Please do not shut down the program by directly cutting OFF the power supply, which may cause irreversible damage 

to the electronic components of the ST2851. 

2.4.2.3 Initialize the Instrument 

[Preset] initialization restores the device to the factory settings, which can reset the previous measurement conditions and 

parameter settings to avoid the subsequent measurement being affected by the previous measurement. The initialization func-

tion can be set to restore to factory settings or user settings (user setting files are required), and the system defaults to factory 

settings. This setting can be changed in the system settings.  

Press [Preset] on the front panel and click OK on the screen to restore the device to factory settings. 

2.4.3 User Measurement Calibration 

Perform user calibration before measurement. On the point measurement page, click [Cal] in the upper right corner of the front 

panel to enter the user calibration page. 

 

2.4.3.1 User Full Frequency Open Clear 

1) Click [Open] on the user calibration menu to enter the open calibration menu. 

2) Install the standard open measuring piece on the ST26005C fixture, and click [All Frequency Clear]. 

3) After the full frequency clear is completed, the data will be saved and the user open calibration will be turned on. Click 

[Return] to return to the user calibration menu. 

2.4.3.2 User Full Frequency Short Clear 

1) Click [Short] on the user calibration menu to enter the short calibration menu. 

2) Install the standard short measuring piece on the ST26005C fixture, and click [All Frequency Clear]. 

3) After the full frequency clear is completed, the data will be saved, and the user short calibration will be turned on. Click 

[Return] to return to the user calibration menu. 
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2.4.3.3 User Phase Calibration 

1) Click [Phase Cal] on the user calibration menu to enter the Phase Calibration menu. 

2) Install the standard open measuring piece on the ST26005C fixture, click [Start Phase Cal]. 

3) After the calibration is completed, the user phase calibration will be turned on. Click [Return] to return to the user calibra-

tion menu. 

2.4.3.4 User Accessory Calibration 

1) Click [Accessory Cal] on the user calibration menu to enter the accessory calibration menu. 

2) Click the button to select the file location to be saved after calibration. If there is a fixture calibration file in the selected 

location, the file will be overwritten after the calibration is completed (if there is an * in the name of the file location button, 

it means an existing calibration file). 

3) Click [Start Accessory Cal] to enter the accessory calibration page, and complete the calibration process according to the 

guidance on the page. 

4) After calibration is complete, user accessory calibration will be turned on. Click [Return] to return to the calibration menu. 

Note: Because the accessory calibration includes open-short clear and phase calibration, when the user accessory calibration 

is turned on, the user's open calibration, short calibration, and phase calibration will be automatically closed; correspondingly, 

the user's open calibration, short calibration or phase calibration is turned on, the user accessory calibration will be turned OFF. 

2.4.4 Point Measurement Example 

This part demonstrates the point measurement function of ST2851, connect the 100 Ω resistor to the accessory, and press 

[LCR] on the front panel to enter the point measurement page. 

 

2.4.4.1 Set Measurement Conditions (Frequency/Avg Count/Signal Source Voltage, etc.) 

According to user needs, set different measurement conditions, follow the steps below: 

1) Press [Meas] in the upper right corner of the front panel to enter the measurement setting menu. 

2) Select [Frequency] in the measurement setting menu, and press 1 > M / μ on the front panel to set the measurement 

frequency to 1 MHz. 

3) Select [Avg Count] in the measurement setting menu, and press 5 on the front panel to set the measurement average 

count to 5. 
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4) Select [OSC Level] in the measurement setting menu, enter the measurement level menu, set the test voltage, and then 

press return. 

5) Press [DC Bias] on the front panel to turn on the bias voltage switch. 

6) Press [LCR] on the front panel to return to the point measurement menu. 

2.4.4.2 Set Measurement Parameters 

Set the measurement parameters required by the user and display them on the measurement interface. Follow these steps: 

1) Click the parameter name on the screen to enter the test parameter setting interface. 

2) Select and press the parameters to be displayed on the measurement interface. 

3) Press [LCR] on the front panel to return to the point measurement menu. 

2.4.5 List Measurement Example 

This section demonstrates the list measurement function of the ST2851. On the point measurement page, press [Point / List] 

on the front panel to enter the list measurement interface. 

2.4.5.1 List Measurement Point Setting 

 

1) Click [Stim Table] on the List Root on the screen to enter the stimulus setting interface. 

2) Click [Quick Edit] on the stimulus setting menu on the screen to open the quick edit interface. 

3) Set the interpolation mode to linear interpolation, the start frequency to 100 kHz, the stop frequency to 1 MHz, and the 

number of points to 10, click [OK] to quickly set 10 measurement points. 

4) Click the row of each measurement point on the screen to enter the measurement point setting menu, you can set the 

measurement conditions of each point individually, and click [Return] to return to the measurement setting menu. 

5) Click [Exit] to return to the list measurement interface. 

2.4.5.2 Set Measurement Parameters 

Set the list measurement parameters and display them in the measurement page. Follow these steps: 

1) Click [Point Meas] on List Root on the screen to enter the measurement parameter menu. 

2) Click the parameter button that needs to be changed to enter the parameter setting menu. 

3) Select and click the measurement parameter to be set to return to List Root. 
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2.4.5.3 Set the Measurement Speed 

Set the measurement speed of the liat measurement according to the user's requirements for measurement speed and accu-

racy. Follow these steps: 

1) Click [Meas Time] on the List Root on the screen to enter the measurement speed menu; 

2) Select and click the desired measurement speed. 

2.4.6 Sweep Measurement Example 

This part shows the trace sweep measurement function of ST2851. Connect the crystal resonator to the fixture, press [Sweep] 

on the front panel to enter the trace sweep measurement interface. 

2.4.6.1 Set |Z|-Theta as Measurement Parameter 

Set the measurement parameters as follows: 

1) Click [Measurement] of the Sweep Root on the screen to enter the measurement setting menu, then click [Tr1 & Tr2] to 

enter the parameter setting menu; 

2) Make sure that the selected item fo [Tr1 & Tr2] is |Z| – θz (the default state is selected), so that trace 1 reflects the absolute 

value of the resistance value, and trace 2 reflects the phase. 

2.4.6.2 Set the Center and Span 

1) Press [Center] on the front panel to open the sweep range menu and automatically lock at Center. 

2) Enter the center frequency of 8 MHz: Press [8] → [M /μ] on the front panel in sequence. 

3) Press [Span] on the front panel, the sweep range menu is now automatically locked in the Span. 

4) Enter the value range of 30 kHz: Press the [3] → [0] → [k / m] keys on the front panel in sequence. 

2.4.6.3 Set Sweep Speed 

1) Press [Avg] on the front panel to enter the measurement speed menu. 

2) Click [Meas Time], then select and tap [3] as measurement speed. 
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2.4.6.4 Set the Ordinate of the |Z| Curve to the Logarithmic Distribution 

1) Select Trace 1 as the active curve (the measurement parameter of trace 1 is |Z|). 

2) Press [Format] on the front panel to enter the ordinate format menu. 

3) Click the [Vertical Axis Type] and select [Logarithmic Axis]. 

2.4.6.5 Display Traces in Different Coordinate Systems 

1) Press [Display] on the front panel to enter the display setting menu; 

2) Press [Allocate Traces] to enter the trace assignment setting menu, select and click the coordinate system distribution 

button in the menu. 

 

2.4.6.6 Axis Auto Scaling 

Press [Scale] on the front panel to enter the coordinate axis setting menu, and press [Auto Scale All] or all traces. 

2.4.6.7 Analysis of Measurement Results 

Perform equivalent circuit analysis on the trace to find the resonance point of the circuit, and follow the steps below: 

 

1) Press [Analysis] on the front panel to enter the trace analysis menu, and then press the [Equivalent Circuit] to enter the 

equivalent circuit menu. 

2) Click on the screen to [Select Circuit], select and click the Model E button. 
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3) Press the [Calculate] to perform an equivalent analysis on the trace, and the analog values of resistance, inductance and 

capacitance are displayed on the menu. 

4) Turn on the [Display] button in the equivalent circuit menu, and the equivalent circuit model and simulation results will be 

displayed on the screen. 

5) Press [Marker Search] on the front panel to enter the marker search menu. 

6) Keep Tr1 as the active curve, press [Min], the program will automatically open Tr1 and locate the minimum value of |Z|. 

7) Click the toggle [Tracking] button to the on state. When the marker tracking is on, the program will automatically position 

the currently selected marker to the selected position after each sweep cycle. After one sweep period, Tr1 will be auto-

matically positioned to the minimum value of the |Z| trace. 
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3 User Calibration 

3.1 Overview 

User calibration needs to be performed by the user before starting the measurement, which can eliminate measurement errors 

caused by fixtures, test pieces, etc. 

 

Press [Cal] on the front panel to enter into the user calibration interface. After entering, the main area on the left side of the 

interface is a list of calibration points. 

ST2851 provides 20 calibration points, whose switch, frequency, reference, etc. can be individually set; the menu area on the 

right side of the interface is the user calibration menu, which can perform all frequency calibration and its switch operation. 

3.2 All Frequency User Calibration Setup 

3.2.1 Choose a Measuring Accessory 

According to the currently selected measurement accessory, set the measurement accessory data in the user calibration inter-

face. ST2851 provides several measuring accessories for selection; the default selection is 0 m. 

If the user uses a custom accessory to measure, or the accessory used is not in the selectable accessory options, it is recom-

mended to set the measurement accessory to 0 m and perform accessory calibration. 

Set up the measuring accessory as follows: 

1) Click Accessory button in the user calibration menu to enter the measurement accessory menu. 

2) Select and click the button corresponding to the selected measuring accessory. 

3.2.2 User Open Calibration 

3.2.2.1 Toggle Open Calibration Switch 

When the open-circuit calibration in the user calibration is turned off, the user-calibrated open-circuit calibration during the 

measurement process will be calculated using the default data of the ST2851 (the user accessory calibration is not turned on). 

Only the open circuit data of the calibration point is used. 
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Set the switch state of user open circuit calibration according to the following steps: 

1) Click the [Open] button in the user calibration menu to enter the open circuit calibration menu. 

2) Select and click the [ON] or [OFF] button in the Open Calibration menu to set the open state of Open Calibration. 

3.2.2.2 All Frequency Clear for Open Circuit Calibration 

All frequency open-circuit calibration is to perform all frequency open-circuit calibration again. After completion, the user's open-

circuit calibration will automatically switch to the open state. The zero-clearing data will record and overwrite the original all 

frequency open-circuit calibration data. If necessary, please pay attention to backup and save the original data. 

Perform open-circuit all frequency clear according to the following steps: 

1) Click the [Open] button in the user calibration menu to enter the open circuit calibration menu. 

2) Connect the user's open-circuit standard test piece to the measuring accessory. 

3) Click [All Frequency Clear] to start clearing, and wait for the clearing to complete. During this process, press [ESC] on the 

front panel to interrupt the operation. 

3.2.2.3 List Frequency Clear for Open Circuit Calibration 

List frequency clear is to perform a one-time open-circuit calibration of the calibration points whose status is open in the current 

calibration point list, and the calibration results will be recorded and automatically written into the calibration point list. If no 

calibration point is currently open, it will simply end. 

Perform open-circuit list frequency clear according to the following steps: 

1) Click the [Open] button in the user calibration menu to enter the open circuit calibration menu. 

2) Connect the user's open-circuit standard test piece to the measuring accessory. 

3) Click the [List Frequency Clear] to start clearing, and wait for the clearing to complete. 

3.2.3 User Short Calibration 

3.2.3.1 Toggle Short Calibration Switch 

When the short-circuit calibration in the user calibration is turned off, the short-circuit calibration of the user-calibration in the 

measurement process will be calculated using the default data of the ST2851 (the user accessory calibration is not turned on). 

After the short-circuit calibration is turned on, the user's all frequency short calibration data and the short-circuit data for the 

calibration point is only used. 

Set the switch state of user short-circuit calibration according to the following steps: 

1) Click the [Short] button in the user calibration menu to enter the short-circuit calibration menu. 

2) Select and click the [ON] or [OFF] button in the Short Calibration menu to set the on-state of the Short Calibration. 

3.2.3.2 All Frequency Clear for Short Circuit Calibration 

All frequency clear is to perform all frequency short circuit calibration again. After the user short circuit calibration is completed, 

it will automatically switch to the open state. The zero-clearing data will record and overwrite the original all frequency short 

circuit calibration data. If necessary, please pay attention to backup and save the original data. 
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Perform short-circuit all frequency clear according to the following steps: 

1) Click the [Short] button in the user calibration menu to enter the short-circuit calibration menu. 

2) Connect the user's short-circuit standard test piece to the measuring accessory. 

3) Click [All Frequency Clear] to start clearing, and wait for the clearing to complete. During this process, press [ESC] on the 

front panel to interrupt the operation. 

3.2.3.3 List Frequency Clear for Short Circuit Calibration 

List frequency clear is to perform a one-time short-circuit calibration of the calibration points whose status is open in the current 

calibration point list, and the calibration results will be recorded and automatically written into the calibration point list. If no 

calibration point is currently open, it will simply end. 

Perform short-circuit list frequency clear according to the following steps: 

1) Click the [Short] button in the user calibration menu to enter the short-circuit calibration menu. 

2) Connect the user's short-circuit standard test piece to the measuring accessory. 

3) Click the [List Frequency Clear] to start clearing, and wait for the clearing to complete. 

3.2.4 User Load Calibration 

3.2.4.1 Toggle Load Calibration Switch 

When the load calibration in the user calibration is turned off, the user-calibrated load calibration during the measurement 

process will be skipped. After the load calibration is turned on, the user's all frequency load calibration data and the user's 

calibration point load data will be used. 

Set the switch state of user load calibration according to the following steps: 

1) Click [Load] button in the user calibration menu to enter the load calibration menu. 

2) Select and click the [ON] or [OFF] button in the Load Calibration menu to set the Load Calibration on state. 

3.2.4.2 All Frequency Load Calibration 

All frequency clear is to re-calibrate the all frequency load. After completion, the user load calibration will automatically switch 

to the open state, and the calibration data will be recorded and overwritten with the original all frequency load calibration data. 

If necessary, please pay attention to backup and save the original data. For all frequency load calibration, please use the 

components of the following model and install them on the measurement fixture: 

 

Perform load circuit all frequency clear according to the following steps: 

1) Click [Load] button in the user calibration menu to enter the load calibration menu. 

2) It is recommended to use a stable resistor or capacitor, the size of which is similar to the size of the DUT, and the imped-

ance value is known and similar to the DUT. 

3) Set the value of load resistance, load inductor and load capacitance on the load calibration menu. 

4) Click [All Frequency Load] to calibrate and wait for the calibration to complete. During this process, press [ESC] on the 

front panel to interrupt the operation. 
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3.2.4.3 List Frequency Load 

List frequency load is to perform a one-time load calibration on the calibration point in the current calibration point list whose 

status is open, and the calibration result will be recorded and automatically written into the calibration point list. If no calibration 

point is currently open, it will simply end. 

Perform the list frequency load as follows: 

1) Click [Load] button in the user calibration menu to enter the load calibration menu. 

2) Click the [List Frequency Load] to start the calibration and wait for the calibration to complete. 

3.2.4.4 Load Parameter Setting 

1) Click [Load] button in the user calibration menu to enter the load parameter menu. 

2) Click the button corresponding to the desired load parameter combination. 

3.2.5 Phase Calibration 

The phase calibration data is related to the measurement accessory, and when the measurement accessory is set, the phase 

calibration is turned off. After resetting the measurement accessory, if you need to turn on the phase calibration, it is recom-

mended to perform the all frequency phase calibration again. In the [Phase Cal] button of the user calibration menu, the current 

phase calibration switch status and the date of the current all frequency phase calibration data will be displayed. 

3.2.5.1 Toggle Phase Calibration Switch State 

When user phase calibration is turned off, the phase calibration during measurement will use the system phase calibration 

data. If you need to use user phase calibration data, turn phase calibration on. 

Switch the user phase calibration state according to the following steps: 

1) Click [Phase Cal] button in the user calibration menu to enter the phase parameter menu. 

2) Click the [Phase Cal] State to switch the phase calibration switch state. 

3.2.5.2 All Frequency Phase Calibration 

All-frequency phase calibration is to perform all-frequency phase calibration again. After completion, the user phase calibration 

will automatically switch to the open state, and the calibration data will be recorded and overwritten with the original user phase 

calibration data. If necessary, please pay attention to backup and save the original data. 

Perform all frequency phase calibration as follows: 

1) Click [Phase Cal] button in the user calibration menu to enter the phase parameter menu. 

2) Connect the user's open-circuit standard test piece to the measuring accessory. 

3) Click [All Frequency Phase] Calibration to start the calibration, wait for the calibration to complete, press [ESC] on the 

front panel during this process to interrupt the operation. 

3.2.6 Accessory Calibration 

Accessory calibration can be used to calibrate user-defined measurement accessories, which include open calibration, short 

calibration, and phase calibration. If the measurement outcome selected by the user is "0 m", when the accessory calibration 

is turned on, the user-calibrated open calibration, short calibration, load calibration, and phase calibration will be automatically 

turned off (accessory calibration will also be automatically turned off when the above calibration switches are turned on). 
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The [Accessory Cal] button in the user calibration menu will display the name of the currently selected accessory and the state 

of the accessory calibration switch. 

3.2.6.1 Toggle Accessory Calibration Switch Status 

1) Click the [Accessory Cal] button in the user calibration menu to enter the accessory calibration menu. 

2) Select the accessory to be loaded and click its corresponding button to select it. 

3) Click the [Accessory Cal] State button to switch the accessory calibration switch state. 

Note: The name of the accessory button with the * symbol indicates that the accessory currently has a calibration file. Clicking 

the button will automatically load the file (if there is an error in the file, it will prompt and cancel the loading). Only when the 

selected accessory has a corresponding calibration file and accessory calibration can be opened only when it is loaded cor-

rectly. If there is no corresponding file or the loading is wrong, please click [Start Accessory Cal] to generate the calibration file. 

3.2.6.2 Generate Accessory Calibration File 

1) Click the [Accessory Cal] button in the user calibration menu to enter the accessory calibration menu. 

2) Select the accessory to be loaded and click its corresponding button to select it. 

3) Click [Start Accessory Cal] to enter the accessory calibration interface, follow the prompts to complete the calibration 

process and generate a calibration file. 

Note: After completing the above steps, the calibration file corresponding to the accessory selected in step 2 will be overwritten. 

If necessary, make a backup in advance. 

3.3 User Calibration Point Settings 

3.3.1 Toggle Calibration Point Switch State 

1) Click the calibration point to be modified in the list to enter the calibration point setting menu. 

2) Click the [Switch] button to switch the ON/OFF state of the calibration point. Only when the calibration point is on, the 

calibration data of the calibration point will take effect during measurement. 

3.3.2 Set the Frequency of the Calibration Point 

1) Click the calibration point to be modified in the list to enter the calibration point setting menu. 

2) Click the [Measurement Frequency] button and enter the frequency of the calibration point. 

Note: During the measurement process, the ST2851 will search for the frequencies of all open calibration points. When the 

searched frequency is consistent with the current measurement frequency, the measurement data of this calibration point will 

be used in the user calibration process. 

3.3.3 Set the Load Reference for the Calibration Point 

1) Click the calibration point to be modified in the list to enter the calibration point setting menu. 

2) Click the Ref button and enter the reference value. Only when the reference values in both Ref buttons are set, the set 

value will be written to the measuring point list and recorded. 

Note: The parameters corresponding to the reference values need to be set in the Load parameters in the user calibration 

menu. 
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3.3.4 Open-Circuit Calibration of Calibration Point 

1) Click the calibration point to be modified in the list to enter the calibration point setting menu. 

2) Connect the user's open-circuit standard test piece to the measuring accessory. 

3) Click [Open Cal] to complete the open calibration of the calibration point, and write the calculation result into the calibration 

point list and record it. 

Note: Only when the user open calibration is turned on, the calibration point is turned on, and the frequency of the calibration 

point is the current measurement frequency, the open clear data of this point will be called during the measurement. 

3.3.5 Short-Circuit Calibration of Calibration Point 

1) Click the calibration point to be modified in the list to enter the calibration point setting menu. 

2) Connect the user's short-circuit standard test piece to the measuring accessory. 

3) Click [Short Cal] to complete the short calibration of the calibration point, and write the calculation result into the calibration 

point list and record it. 

Note: Only when the user short-circuit calibration is turned on, the calibration point is turned on, and the frequency of the 

calibration point is the current measurement frequency, the short clear data of this point will be called during the measurement. 

3.3.6 Load Calibration of Calibration Point 

1) Click the calibration point to be modified in the list to enter the calibration point setting menu. 

2) Connect the user's standard test piece to the measuring accessory. 

3) Click [Load Cal] to complete the load calibration of the calibration point, and write the calculation result to the calibration 

point list and record it. 

Note: Only when the user load calibration is turned on, the calibration point is turned on, and the calibration point frequency is 

the current measurement frequency, the load calibration data of this point will be called in the measurement. 



ST2851 Precision Impedance Analyzer Point Measurement 

v1.0 36 

4 Point Measurement 
This section describes operations to set the measurement conditions in the point measurement mode, such as frequency, 

average count, etc. Press the [Preset] button on the front panel first to restore the instrument to the factory setting, and then 

confirm the complete status recovery. 

4.1 Channel 

The point measurement interface of ST2851 displays eight channels, and every channel can set different measurement condi-

tions and parameters. During the measurement process, different parameters can be set in different channels to complete 

different measurement requirements. Click the channel buttons on the left side of the interface to switch channel. 

 

4.2 Measurement Frequency 

Operation steps below for setting the measurement frequency: 

1) Two ways to set the frequency… 

a) Click [Frequency] on the screen, or 

b) Click [Meas Setup] on the Point Root Menu and then click [Frequency]. 

2) Enter the frequency to be modified, for example, enter 1 kHz, press 1 and k/m at the front panel in turn, the measurement 

frequency will be changed to 1 kHz. 

3) The frequency can also be adjusted by using the up and down arrows and scroll wheel on the front panel. 

 

Channel 

Buttons 

Current 

Channel 
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4.3 Measurement Time 

Operation steps below for setting the measurement time: 

1) Two ways to set measurement time… 

a) Click [Meas Time] on the screen to enter the measurement time menu, or 

b) Click [Meas Setup] on the Point Root Menu and then click [Meas Time] to enter the measurement time menu. 

2) Select needed number level on Meas Time menu. 

3) Generally, the slower the measurement rate, the more accurate the measurement. 

 

4.4 Avg Count 

Operation steps below for setting the measurement average: 

1) Two ways to set the measurement average count… 

a) Click [Avg Count] on the screen, or 

b) Click [Meas Setup] on the Point Root Menu and then click [Avg Count]. 

2) Enter the average count to be modified; for example, enter 1, and press the 1 and x1 buttons in sequence at the front 

panel to modify the average count to 1. 

3) The average count can also be adjusted by using the up and down arrows and scroll wheel on the front panel. 
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4.5 OSC Level 

Operation steps below for setting the measurement level: 

1) Two ways to set the OSC level… 

a) Click [OSC Level] on the screen, or  

b) Click [Meas Setup] on the Point Root menu and then click [OSC Level] to enter the OSC level menu. 

2) The source mode (OSC Unit) can be voltage or current, switched using the OSC level menu. The way to modify level 

value is to click [Voltage Level] or [Current Level] and set the needed voltage or current value. When the source mode is 

switched, the corresponding value will be automatically applied and displayed on Point Root interface. 

3) Two ways to modify the level value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 

Note: When source internal resistance is 100 Ω, voltage level range is 5 mV ~ 2 V, and current level range is 50 μA ~ 20 mA. 

It is worth noting that voltage level can be greater than 1 V, and current level can be greater than 10 mA, only when frequency 

is < 1 MHz. But when frequency is > 1 MHz, the source level will be automatically adjusted to the maximum allowable value. 

 

4.6 ALC 

Operation steps below to set ALC: 

1) Click [ALC] on the OSC menu to enter the ALC menu. 

2) Click [ALC Control] to switch ALC state. 

3) Click [Max Iteration] to input the needed iteration value whose range is 2 ~ 10. 

4) Click [Target %] to input the needed accuracy whose range is 0.05 ~ 10. 
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4.7 DC Bias 

Operation steps below for setting the DC bias: 

1) Two ways to set DC Bias…  

a) Click [DC Bias] on the screen to enter the DC Bias menu, or 

b) Click [Meas Setup] on the Point Root menu and then click [DC Bias] to enter the DC Bias menu. 

 

Operation steps below to set the corresponding parameters: 

1) Click [DC Bias State] on DC Bias menu or press [DC Bias] button on the front panel to switch state. 

2) Click [Meas Range] on DC Bias menu to select the needed range. 

3) Click [DC Bias Mode] on DC Bias menu to switch mode that is Voltage or Current. If bias mode is Voltage, click [Voltage 

Level] to modify level value, else click [Current Level]. When the bias mode is switched, the corresponding value will be 

automatically applied and displayed on Point Root interface. 

4) Click [Constant Mode] on DC Bias menu to switch constant voltage state. 

5) Click [Max/Min Limit Voltage] on DC Bias menu to set max/min voltage value. Two operations to modify the level value or 

max/min voltage value of constant voltage on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 
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Note: The measurement range and bias voltage/current will apply to the measurement only when the bias state is ON. If the 

bias state is OFF, the measurement range is the default 1 mA, and the bias voltage/current is 0. 

4.8 AC Range 

Operation steps below for setting the AC range: 

1) Two ways to set AC Range… 

a) Click [AC Range] on the screen to enter the AC Range menu, or 

b) Click [Meas Setup] on the Point Root menu and then click [AC Range] to enter the AC Range menu. 

2) On the AC Range menu, if range is set to automatic, the automatic range judgment is made during the measurement, 

and the true range will display in the AC range area. Else select needed range value. 

 

4.9 Trigger 

4.9.1 Trigger Mode 

Operation steps below for setting the trigger mode: 

1) Two ways to select Trigger Mode… 

a) Press the [Trigger Mode] button on the front panel to enter Trigger Mode menu, or  

b) Click [Meas Setup] on the Point Root menu and then click [Trigger Mode] to enter the Trigger Mode menu. 
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There are four trigger modes to select from: 

Trigger Source Function 

Internal 
Use a consecutive signal generated by the firmware as a trigger source. Triggers are sent immediately 

following the completion of each measurement. 

External Use the external trigger input terminal (Handler) as a trigger source. 

Manual Press Trigger to trigger a measurement. 

Bus A trigger is generated through GPIB/LAN/USB. 

4.9.2 Trigger Delay 

Operation steps below for setting the trigger delay: 

1) Click [Meas Setup] on the Point Root menu and then click [Trigger Delay]. 

2) Two ways to modify the delay time value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 

4.10 Result 

4.10.1 Parameter 

In a point measurement, the screen can display up to 4 parameters at same time. Operation steps below for setting the meas-

urement parameters: 

1) Two ways to select measurement parameters… 

a) Click [Parameter 1 ~ 4] to enter the Display menu, or 

b) Click [Display] on the Point Root menu and then click [Parameter 1 ~ 4] to enter the corresponding parameter menu. 

 

There are twenty-four parameters to select from: 

Name Description Name Description 

|Z| Absolute impedance R Equivalent series resistance 

|Y| Absolute admittance G Equivalent parallel conductance 
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θz (rad) Impedance phase (rad) X Equivalent series reactance 

θy (rad) Admittance phase (rad) B Equivalent parallel susceptance 

θz (deg) Impedance phase (deg) Q Q value (Quality factor) 

θy (deg) Admittance phase (deg) D Dissipation factor 

Rs Equivalent series resistance εr' Relative permittivity real part (need permittivity module) 

Rp Equivalent parallel resistance εr'' 
Relative permittivity imaginary part (need permittivity 

module) 

Ls Equivalent series inductance |εr| Relative permittivity (need permittivity module) 

Lp Equivalent parallel inductance μ' Relative troidalcore real part (need troidalcore module) 

Cs Equivalent series capacitance μ'' 
Relative troidalcore imaginary part (need troidalcore 

module) 

Cp Equivalent parallel capacitance tan δ Phase (need troidalcore module) 

 

4.10.2 Math Mode 

There are three modes to display measurement results to select from: 

Mode Description 

OFF Measurement Value 

Deviation Measurement Value – Reference Value 

% Deviation (Measurement Value – Reference Value) × 100 % / Reference Value 

Operation steps below for setting the math mode: 

1) Two ways to select the math mode of different parameter… 

a) Click the corresponding [Math] to enter the parameter menu, or 

b) Click [Display] on the Point Root menu and then click [Parameter 1 ~ 4] to enter the corresponding parameter menu. 

2) On the parameter menu, click [Math Mode] to enter the Math menu and select the needed math mode. 
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4.10.3 Reference 

Operation steps below for setting the reference: 

1) Two ways to select the reference of different parameters… 

a) Click the corresponding [Ref] to enter the parameter menu, or 

b) Click [Display] on the Point Root menu and then click [Parameter 1 ~ 4] to enter the corresponding parameter menu. 

2) On the parameter menu, click [Reference] to modify the reference value or click [Data → Reference]; this will define the 

current measurement result as the reference value. 

3) Two ways to modify reference value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 
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4.11 Comparator 

 

This module is used to sort the measurement results. 

Click [Comparator] on the Point Root Menu to enter the Comparator menu, then click [Edit Comptr Table] to enter the Compa-

rator Table interface. 

 

Related features of BIN setting as shown below: 

1) The interface can be set up to 9 BINs and 4 conditions for the measurement results. And only when the BIN meets all 

current conditions, it can be counted as qualified. 

2) Each BIN or Condition has own switch. 

3) All BINs are sorted from BIN1 to BIN9 to perform sorting calculation. 

4) There are two modes of BIN, one is Good Bin that means qualified judgment, and another is Bad Bin that means unqual-

ified judgment. 

5) If the measurement result doesn't belong to any BIN, it will be sorted to NG. 
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4.11.1 Condition 1 ~ 4 

4.11.1.1 Parameters 

Parameters of Condition 1 ~ 4 are used to perform the sorting judgment and are independent of point measurement parameters 

used to display measurement results. 

Operation steps below for setting the parameter: 

1) Click [Parameter] cell to pop up the selection window. 

2) Select and click the needed parameter. 

 

4.11.1.2 Math Mode and Reference 

The Math Modes of Condition 1 ~ 4 are used to select the format of the upper and lower limit values. Upper and lower limit 

values are set based on the References of Condition 1 ~ 4. 

Operation steps below for setting the math mode and reference: 

1) Click [Mode] cell to pop up the selection window. 

2) Select and click the needed math mode. 

3) Click [Reference] cell to set the value. 

4) Two ways to modify reference value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 

Math Mode Description 

OFF 
Upper and lower limit value of each BIN are absolute values. When this mode is selected, the reference value 

can not be set. 

% Upper and lower limit value of each BIN are the difference between the upper/lower limits and the reference. 

Deviation 
Upper and lower limit value of each BIN are the percentage of the ratio that is the upper/lower limits to the 

reference. 

%Dev 
Upper and lower limit value of each BIN are the percentage of the ratio that is the difference (between the 

upper/lower limits and the.reference) to the reference. 
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4.11.2 BIN 

4.11.2.1 Upper and Lower Limits 

Operation steps below for setting the upper and lower limits: 

1) Click [Upper] and [Lower] cell to set the value.(BIN state is ON) 

2) Two ways to modify the limit value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 

 

4.11.2.2 In/Out 

Operation steps below for setting the acceptable range: 

1) Click [In/Out] cell to pop up the selection window as shown above. 

2) Select and click the needed mode. 

In/Out Mode Description 

All 
This mode defines that the qualified range is independent of the upper and lower limits of BIN, that is, no 

matter what the measurement result is, it is considered as qualified 
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In 
This mode defines that the qualified range is between the upper limit and lower limit of BIN.(greater than the 

lower limit and less than the upper limit) 

Out 
This mode defines that the qualified range is outside the upper and lower limits of BIN.(greater than or equal 

to the upper limit or less than or equal to the lower limit) 

4.11.2.3 Copy, Paste and Clear 

These operations are only for upper/lower limits and in/out mode as shown below. 

Operation steps below to copy, paste and clear BIN settings: 

1) Click [BIN 1 ~ 9] name cell to select the BIN whose settings you wish to copy. 

2) Click [Copy BIN] on Comparator Table menu on the right to copy. 

3) Click [BIN 1 ~ 9] name cell to select the BIN you wish to paste the settings into. 

4) Click [Paste BIN] on Comparator Table menu on the right to paste. 

5) Click [BIN 1 ~ 9] name cell to select the BIN whose settings you wish to. 

6) Click [Clear BIN] on Comparator Table menu on the right to clear. 

 

4.11.2.4 Good/Bad Bin 

In the upper left corner of the Comparator Table interface, click [Good BINs] to set the number of good and bad BINs as shown 

above. 

For example, if the Good BINs setting is "~BIN3", that means BIN1 to BIN3 are good BINs and BIN4 to BIN9 are bad BINs. 

4.11.2.5 Result 

Operation steps below for setting the sorting results (when sorting settings complete): 

1) On the Comparator menu, click [Comparator State] to turn the setting on to display sorting results on the point measure-

ment interface. If the setting is turned off, sorting results are hidden. 

2) On Comparator menu, click [BIN Count] to made state on to display the count on the point measurement interface. 

3) On Comparator menu, click [Clear BIN Count] to clear the count on the point measurement interface.  
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Note: "Latest" in the result column displays the most recent sorting result: 

• If the sorting result fails to meet any BIN, "Latest" displays "Out". 

• If the measurement result is "Overload", "Latest" displays "Invalid". 

• If the sorting result belongs to the good BIN, "Latest" displays the BIN name in blue. 

• If the sorting result belongs to the bad BIN, "Latest" displays the BIN name in red. 
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5 List Measurement 
This section describes the operations to set the measurement conditions in the list measurement mode, such as frequency, 

average count, etc. 

Press the [Preset] button on the front panel first to restore the instrument to factory settings, and then confirm the complete 

status recovery. 

5.1 Channel 

The list interface of ST2851 displays eight channels, and every channel can set different measurement conditions and param-

eters. During the measurement process, different parameters can be set in different channels to complete different measure-

ment requirements. Toggling channel can be operated by clicking channel buttons on the left side of the screen. 

 

5.2 Measurement Point 

1) Click [List Meas] on the Point Root Menu to enter the List Root interface. 

2) Click [Stim Table] on the List Root menu to enter the Stimulus Table interface. 

 

Channel 

Buttons 

Current 

Channel 
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5.2.1 Add Row 

In the initial state, each channel has only one measurement point, the frequency is 1 kHz,the average is 1, the OSC level is 

500 mV, and the AC range is automatic. 

Operation steps below for adding measurement points: 

1) Two ways to add measurement points… 

a) Click [Add Row] to add a new row at the bottom, then click the same button several times to add several rows, or 

 

b) Click [Quick Edit] on the Stimulus menu to enter the setting interface, then set [Num of Points] to the needed value 

to add rows. 
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5.2.2 Copy, Paste and Delete Row 

1) Select any cell of a row and then click [Copy Row] on the Stimulus Table menu. 

2) Click [Paste Row] on the Stimulus Table menu to add the copied row at the bottom. 

3) Select any cell of a row and then click [Delete Row] on the Stimulus Table menu to delete this row. 

 

5.2.3 Measurement Settings 

5.2.3.1 Frequency 

1) Click the [Frequency] cell whose value you wish to modify to enter the corresponding point menu. 

2) Two ways to modify the value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 
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5.2.3.2 Average 

1) Click the [Average] cell whose value you wish to modify to enter the corresponding point menu. 

2) Two ways to modify the value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 

 

5.2.3.3 OSC Level 

1) Click the [OSC Level] cell whose value you wish to modify to enter the corresponding point menu. 

2) Two ways to modify the value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 

 

The specific setting requirements are the same as those in section 4.5 of this manual. 
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5.2.3.4 AC Range 

1) Click the [AC Range] cell on the screen to enter AC Range menu. 

2) On the AC Range menu, if Range is set to "automatic", an automatic range judgment is made during the measurement, 

and the true range will display in the AC Range area. Else select the needed Range value. 

 

5.2.3.5 DC Bias 

1) Click the [DC Bias] cell whose value you wish to modify to enter the corresponding point menu. 

2) Two ways to modify the value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 
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5.2.3.6 List Measurement Time 

1) Click [List Meas Time] on the List Root menu to enter the measurement time menu. 

2) Select the required value on the measurement time menu. 

 

5.3 Trigger 

5.3.1 Trigger Mode 

1) Click [Trigger] on the List Root menu to enter the Trigger Mode menu. 

2) Select the required mode on the Trigger Mode menu. 
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5.3.2 List Type 

1) Click [List Type] on the List Root menu to enter the List Type menu. 

2) Select the required mode on the List Type menu. 

 

Trigger Mode Description 

Sequence 

When triggered, measure the remaining measurement points from the current measurement point to the 

end of the list. If the selected measurement point is at the end of the list when triggered, it will start from the 

first point. 

Step At each trigger, measure the currently selected measurement point, and then select the next point. 

5.3.3 Point Delay 

1) Click the [Point Delay] cell whose value you wish to modify to enter the corresponding point menu. 

2) Two ways to modify the value on the front panel… 

a) Press the digital buttons, or 

b) Press the directional buttons and turn the knob. 
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5.4 Result 

5.4.1 Parameter 

1) Click [Display] on the List Root menu to enter the Display menu. 

2) Click [Parameter 1 ~ 4] to modify the parameters. 

3) See section 4.10.1 for specific parameter selection. 

Note: If the parameter is set to "None", the column of the parameter will be hidden in the list. 

 

5.4.2 Comparator 

Click [Comparator] at the top of the Stimulus Table interface to enter the Comparator Table interface. 

 

1) The interface can set up to 15 BINs and 4 conditions for the measurement results. Only when the BIN meets all current 

conditions, it can be counted as PASS. 

2) Each BIN or condition has its own ON/OFF switch. 

3) Each BIN corresponds to a measurement point in the list measurement, BIN1 corresponds to point 1, BIN2 corresponds 

to point 2, and so on. 

4) If the measurement result does not belong to any BIN, it will be sorted to NG. The final result is PASS only if the sorting 

results of all enabled BINs are PASS; otherwise, the final result will be sorted to NG. 

5) The list sorting settings are similar to point measurement sorting, please refer to Fehler! Verweisquelle konnte nicht 

gefunden werden. and 4.10. 
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6 Trace Sweep Measurement 
This chapter describes how to use the trace measurement mode for the sweep measurement and analysis, etc. 

6.1 Setting Measurement Conditions 

This section describes how to set up the measurement conditions in Sweep mode. 

6.1.1 Initialization 

The ST2851 has three initial modes, as shown in the following table: 

Option Description 

Preset 

• Press [Preset] on the front panel. A confirmation dialog box will appear on the screen (you can 

close it in the settings); press [OK] button and execute it. 

• Preset can be used to restore to factory settings or to restore to user settings (UserPres file is 

required in this case). See also: System Settings → Misc Setup → [Preset] Setup. 

• Preset can also be implemented with the command :SYST:PRES 

*RST External input *RST command 

Factory Settings ST2851 Restore to Factory Settings 

6.1.2 Setting Channels and Traces 

6.1.2.1 Overview of Channels and Traces 

The ST2851 allows multiple channels to be set up simultaneously to perform different measurement at different stimulus states. 

Multiple traces (measurement parameters) can be displayed in each channel, and each channel is independent and not corre-

lated with each other. In other words, you have to set the measurement conditions as well as the measurement parameters, 

etc. For each measured channel. 

When you set up channels/traces, only the currently active channels/traces are applied. You can set only the active chan-

nels/traces to be displayed on the screen. 

The following table lists the setting parameters by the ST2851, along with the scope of each variable (analyzer, channel, or 

trace) and the operating keys: 

Parameters 

Scope of Action 

Setup Keys 

Analyzer Channel Traces 

Stimulus Setting 

Sweep Range  ✓  [Start], [Stop], [Center], [Span] 

OSC Level 

CW Frequency 
 ✓  [Sweep Setup] → [OSC Level] 

Sweep Time 

Point Delay 
 ✓  [Sweep Setup] → [Sweep Time], [Point Delay] 

Number of Points  ✓  [Sweep Setup] → [Points] 

Segmented Display  ✓  [Sweep Setup] → [Segmented Display] 
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DC Bias  ✓  [Sweep Setup] → [DC Bias] 

Trigger Settings 

Trigger Mode  ✓  [Trigger Mode] → [Hold], [Single], [Continuous] 

Trigger Source 

Trigger Event 

Trigger Scope 

✓   
[Trigger Mode] → [Trigger Source], [Trigger Event], [Trigger 

Scope] 

Trigger ✓   [Trigger Mode] → [Restart], [Trigger] 

Response Settings 

Measurement Parameter   ✓ [Meas] 

Data Mode   ✓ [Format] 

Scale   ✓ [Scale] 

Memory Trace 

Data Math 
  ✓ [Display] → [Data Mem], [Data Math] 

Averaging  ✓  [Avg] → [Averaging Restart], [Average Factor], [Averaging] 

Averaging Trigger ✓   [Avg] → [Average Trigger] 

Marker   ✓ [Marker], [Marker Search], [Marker Function] 

Analysis 

Equivalent Circuit   ✓ [Analysis] → [Equivalent Circuit] 

Limit Line   ✓ [Analysis] → [Limit Test] 

Save and Recall ✓   [Save], [Recall] 

System 

System ✓   [System] 

Preset ✓   [Preset] 

The ST2851 sweep mode provides 4 channels with up to 4 traces per channel and a maximum of 1601 measurement points. 

6.1.2.2 Setting Channel Display (Channel Layout) 

The measurement results for each channel are presented in its separate window (channel window), and only one channel's 

trace can be displayed in each window. This means that the layout of channels depends on the number of channels currently 

displayed on screen. 

Note: The measurement results for each channel are independent of the currently displayed channel (channels that are not 

displayed can also be tested). 

Set the layout of channels according to the following steps: 

1) Press [Display] on the front panel to open the Display menu, followed by [Allocate Channels] to open the Allocate menu. 

2) Press the appropriate softkey to select the window layout. 
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6.1.2.3 Changing Active Channel 

Only the active channels can change its setting parameters directly. The window frame of the active channel is displayed 

brighter than the other channels. If you need to change the parameters of a channel, you must activate the channel first. 

The active channels can be switched via keys on the front panel: 

Option Function 

[Channel Next] Change the active channel to the next channel with a larger channel number. 

[Channel Prev] Change the active channel to the previous channel with a smaller channel number. 

6.1.2.4 Setting Trace Display 

You can define the display of traces by setting the number of traces (the upper limit of displayed trace numbers). For example, 

if you set the number of traces to 3, traces 1, 2, 3 are displayed in the channel. 

Set the number of traces according to the following steps: 

1) Switch to the desired channel via the [Channel Next] (or [Channel Prev]) key on the front panel. 

2) Press [Display] on the front panel to open the Display menu. 

3) Press [Num of Traces] to select the number of traces. 

Traces are displayed in the channel according to the number of traces and the trace layout, and the layout of the trace is the 

same as the layout of the channel. If the number of traces is less than the number of traces in the layout, nothing is displayed 

in the remaining area; if the number of traces is more than the number of display areas in the distribution, more than one trace 

may appear in the existing display area. As shown in the figure below, if the number of traces is 4 and the number of display 

areas for trace distribution is 3, traces 1 and 2 will be displayed in the first display area, trace 3 in area 2, and trace 4 in area 3. 

 

Set the distribution of the trace according to the following steps: 

1) Switch to the channel to be set via the [Channel Next] (or [Channel Prev]) button. 

2) Press [Display] on the front panel to open the Display menu. 

3) Press [Allocate Traces] to select the trace allocation mode to be modified. 
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6.1.2.5 Channel and Trace Layout 

 

6.1.2.6 Changing Active Trace 

The active trace is the only one whose parameters can be changed. On the screen, the active trace name (e.g. Tr1) is high-

lighted and labeled with a triangle on the left. Before changing the parameters specific to a trace, you must first activate the 

trace. 

The active traces can be switched via the front panel keys: 

Option Function 

[Trace Next] Change the active trace to the next trace with a larger trace number. 

[Trace Prev] Change the active trace to the previous trace with a smaller trace number. 

6.1.3 Sweep Parameters Settings 

6.1.3.1 Selecting Sweep Type 

Follow the steps below to select the sweep type: 

1) Press [Sweep Type] on the front panel to enter the Sweep Type menu. 

2) Press the corresponding button to select the sweep type: [Lin Freq] / [Log Freq] / [OSC Level] / [DC Bias] / [Log DC Bias] / 

[Segment]. 

When the sweep type is OSC level or DC bias, it can be modified to voltage or current level. The DC bias will only work if the 

bias state in the sweep type is turned on, otherwise it will always be the default value. 

Note: When the internal resistance of the analyzer is set to 100 Ω in the system, the upper limit of the OSC level will change. 

The input range of voltage becomes 5 mV ~ 2 V, and the input range of current becomes 50 μA ~ 20 mA. It should be noted 

that the voltage can be set to > 1 V and the current can be set to > 10 mA only when the measurement frequency is ≤ 1 MHz. 

The sweep type is set for all traces in the entire channel, so there is no need to change the active trace. 

6.1.3.2 Setting Sweep Range 

The sweep range can be set either start/stop values or center/span values. The sweep range is set for all traces in the entire 

channel, so there is no need to change the active trace. 
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Set the sweep range with start/stop values: 

1) Press [Start] on the front panel to enter the Stimulus menu and input the start value. 

2) Press [Stop] on the front panel to input the stop value. 

The start value should not be greater than the stop value! If the input start value is greater than the stop value, the stop value 

will be automatically set to match the start value. If a decreasing frequency measurement is required, you can set the frequency 

to increase and then set the direction to reverse. 

Set the sweep range with center/span values: 

1) Press [Center] on the front panel to enter the Stimulus menu and input the center value. 

2) Press [Span] on the front panel to input the span value. 

Set the sweep range with the marker: 

1) Press [Marker Function] on the front panel to enter the Marker Function menu. 

2) Press the corresponding setting softkey to set the sweep range, and the specific functions are shown in the table below. 

Option Function 

[Marker → Start] Set the start value to the stimulus value of the active marker on the currently active trace. 

[Marker → Stop] Set the stop value to the stimulus value of the active marker on the currently active trace. 

[Marker → Center] Set the center value to the stimulus value of the active marker on the currently active trace. 

 

Option Function 

[Marker Zoom] 

Scale the sweep range according to the zoom aperture and places the stimulus value of the currently 

selected marker at the center value of the sweep range. This function focuses the sweep range around 

the marker and measures and plots the trace within that range. 

[Zoom Aperture] 
Set the zooming aperture used when the Marker Zoom is executed as a percentage. The value can 

range from 0.01 % ~ 100 %, and the default value of Power-On and Preset state is 10 %. 

6.1.3.3 Setting Number of Points 

1) Press [Sweep Setup] on the front panel to access the Sweep Setup menu. 

2) In the input box of the [Points] button, input the number of points. 

Note: The range of points is 2 ~ 1601. If the number of points entered is greater than the current number of points, the default 

point will be added at the right stop of the trace; if the number of points entered is less than the current points, the extra points 

will be deleted in order from right to left. 

6.1.3.4 Setting Sweep Direction 

1) Press [Sweep Setup] on the front panel to access the Sweep Setup menu. 

2) Press [Direction] to switch the sweep direction. 

Note: The sweep direction allows you to select the direction of the sweep. By default, the sweep direction is forward, scanning 

from left to right; when set to reverse, scanning from right to left. 
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6.1.3.5 Setting Time Delay for Measurement 

The measurement delay can be set and used for a period before the sweep or actual measurement starts after the measure-

ment signal is given. This function is important when the parameters of the DUT need a certain time to stabilize after the 

measurement signal is received. Another effect of this function is to observe the changes in the impedance of the DUT over a 

period of time. 

The delay for each measurement point consists of two parts, set as shown in the following equation where the sweep time is 

not a proxy for the time required for the entire sweep process. 

Point Wait Time = Point Delay + (Sweep Time / Number of Points) 

This feature helps reduce the effects of changes in the condition of the stimulus when measuring the slow response devices. 

This function is useful even if the span of the stimulus is 0. 

When the trigger mode is at On Sweep: 

 

When the trigger mode is at On Point: 

 

Modify the point delay and sweep time by following the steps below: 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu and input the point delay value in the input box 

of the [Point Delay] button. 

2) In the [Sweep Time] button's input box, input the sweep time value that needs to be modified. 

The time delay can be set before the start of the sweep cycle. This delay is quite important in controlling the impact to the DUTs 

when starting the new sweep (In general, the stimulus conditions like frequency and OSC level change significantly when a 

sweep is completed to return to the first measurement point). 

To modify the sweep delay, press [Sweep Setup] on the front panel to enter the Sweep Setup menu and input the delay value 

in the input box of the [Sweep Delay] button. 
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6.1.3.6 Setting Sweep Time 

1) Press [Avg] on the front panel to enter the Average menu. 

2) Press [Meas Time] and select the desired measurement speed value. The options are 1/2/3/4/5, with 1 being the fastest 

speed and 5 being the most precise. 

Note: Choosing a larger measurement speed will result in higher measurement accuracy but also require a longer measure-

ment time. 

6.1.3.7 Setting Sweep Averaging (Averaging) 

The sweep averaging is averaged over each of multiple consecutive sweep cycles. The measurement result (vector value) of 

each measurement point is influenced by a certain weight (related to the average factor set by the user) with the measurement 

value of the same point in the completed sweep cycle. The formula for the sweep averaging is shown below: 

An =
Sn

F
+ (1 −

1

F
) × An−1 

• An: The average result (vector value) at the current measurement point when the sweep count is n. 

• Sn: The actual measurement value (vector value) at the current measurement point when the sweep count is n. 

• F: Averaging factor, user setting required. 

Set the average according to the following steps: 

1) Press [Avg] on the front panel to enter the Average menu. 

2) Press [Avg Factor] and input the desired value for the averaging factor value, which can be set from 1 ~ 999 and, if set to 

1, is equivalent to turning off the averaging. 

3) Press [Averaging] to toggle averaging ON/OFF. 

Note: When the averaging is on, the value of the averaging is displayed on the bottom right corner of the status bar. The 

averaging starts once it's turned on or by pressing [Averaging Restart]. When the averaging starts, the averaging on the status 

bar will be displayed as the initial value of 0, increasing by 1 after each sweep is completed, and the value will remain un-

changed when the averaging and the averaging factor are equal. 

6.1.3.8 Making Averaging Measurement with Single Trigger 

When the average trigger is turned on, if the averaging is turned on, a sweep equal to the number of times by the averaging 

factor will be performed when the user performs a single trigger mode. 

Option Function 

ON Single-trigger mode sweeps until the number of sweep cycles equals the average number of slides 

OFF Single-trigger mode sweeps for one sweep cycle only 

Turn on the averaging trigger and perform a single trigger pattern as follows: 

1) Press [Avg] on the front panel to open the Average menu. 

2) Press the [Avg Trigger] button to turn the function on. 

3) Press [Trigger Mode] on the front panel to enter the Trigger menu. 

4) Press [Single] to execute a measurement. 
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6.1.3.9 Setting Averaging for Each Measurement Point 

Single-point averaging is the averaging of measured values for each measurement point based on the number of single-point 

averages (factors) set by the user. The ST2851 measures the same measurement point repeatedly until the averaging factor 

is reached, and then averages all the measurements as the measurement result for that measurement point, and then starts 

measuring the next measurement point. The point averaging algorithm is displayed below: 

M =
1

F
∑ Sn

F

n=1
 

• M: Point averaging measurement (vector value) at the measurement point. 

• F: Point averaging factor (can be set by the user). 

• Sn: the measured value (vector value) of the current measurement point. 

Set up the point averaging according to the following steps: 

1) Press [Avg] on the front panel to enter the Average menu. 

2) Press [Point Avg Factor] and set up the desired value, which can be set from 1 ~ 999, and if set to 1, is equivalent to 

turning off point averaging. 

3) Press [Point Avg] to toggle the point averaging ON/OFF. 

6.1.3.10 Setting Trace Smooth 

Smooth is a secondary processing to the data of the measurement trace, and when it is turned on, it will correct the measure-

ment data in real time to make the trace display smoother. Modifying the frequency, measurement parameters, etc. Will auto-

matically turn off the trace smoothing. 

Set up trace smoothing as follows: 

1) Press [Avg] on the front panel to enter the Average menu. 

2) Press [Smooth] to toggle the trace smoothing ON/OFF. 

6.1.4 Setting Signal Source 

6.1.4.1 Modifying Fixed Frequency At OSC / DC Bias Sweep 

When the sweep stimulus is not a frequency, modify the fixed frequency according to the following steps. 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu. 

2) Press [CW Frequency] to input a fixed frequency value. 

Note: When the internal resistance of the instrument's signal source is set to 100 Ω in the system, the range of the fixed 

frequency will interact with the settable range of OSC if the sweep mode is Level mode. When the voltage is set to > 1 V / the 

current is set to > 10 mA, the maximum allowable setting of fixed frequency is 1 MHz; when the fixed frequency has been set 

to > 1 MHz, the upper limit of sweep voltage/current is 1 V / 10 mA. 

6.1.4.2 Setting Unit for OSC Level 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu, then [OSC Level] to enter the OSC Level menu. 

2) Press [OSC Unit] to change the source mode to voltage/current. 
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Note: The source mode set in the above step can be used to set the OSC level to the sweep stimulus value or to the sweep 

stimulus value at a fixed measurement level of a non-measurement level. The OSC level acts on all traces in the whole channel, 

so there is no need to change the active trace. 

6.1.4.3 Setting Oscillator Level 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu, then [OSC Level] to enter the OSC Level menu. 

2) Depending on the source mode, the button [Voltage Level] and [Current Level] will be available and unavailable respec-

tively. For example, if the source mode is Voltage, the button [Voltage Level] will be available. 

3) Select and enter the voltage/current value. 

Note: When the internal resistance of the instrument's signal source is set to 100 Ω in the system, the upper limit of the OSC 

level changes. The voltage input range becomes 5 mV ~ 2 V, and the current input range becomes 50 μA ~ 20 mA. It should 

be noted that the voltage can be set to > 1 V and the current can be set to > 10 mA only when the frequency (or the fixed 

frequency set in 6.1.4.1 when the sweep type is set to DC bias) is ≤ 1 MHz; when the frequency is set to > 1 MHz, the source 

level that has been set is automatically adjusted to the maximum allowed. 

6.1.4.4 Controlling Oscillator Level (ALC) 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu, then [OSC Level] to enter the OSC Level menu. 

2) Press [ALC] to enter the ALC menu and press [ALC Control] to change the ALC state. 

3) Press [Max Iteration] and input the desired maximum iteration value; range 2 ~ 10. 

4) Press [Target %] and input the desired value; range 0.05 ~ 10. 

6.1.4.5 Setting DC Bias Mode 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu, then [DC Bias] to enter the DC Bias menu. 

2) Press [DC Bias Mode] to switch the DC bias mode between voltage and current. 

Note: The bias mode set in this step can be used to set the DC bias to the sweep stimulus value or to the sweep stimulus 

value at a fixed measurement level of a non-measurement level. The DC bias is applied to all traces in the whole channel, so 

there is no need to switch the active trace. 

6.1.4.6 Setting DC Bias Value 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu, then [DC Bias] to enter the DC Bias menu. 

2) Depending on the bias mode, the button [Voltage Level] and [Current Level] will be available and unavailable respectively. 

For example, if the bias mode is Voltage, the button [Voltage Level] will be available. 

3) Select and enter the voltage/current value 

6.1.4.7 Setting Dc Bias Measurement Range 

Set the DC bias measurement range before turning on the DC bias. The DC bias measurement range is used to optimize the 

DC circuit transmitted to the impedance measurement loop. This setting affects the accuracy of the impedance measurement, 

regardless of whether the DC bias is on or OFF and what mode it is. In general, setting the DC bias measurement range as 

small as possible can give the maximum measurement accuracy. It is recommended that the DC bias measurement range is 

set to 1 mA for the first measurement after the DC bias setting is applied. 

When the DC bias is not turned on, 1 mA will be the default setting and always work in the measurement. 
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Set the DC bias measurement range according to the following steps: 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu, then [DC Bias] to enter the DC Bias menu. 

2) Press [Meas Range] to enter the measurement range menu and select the desired range value: 1 mA / 10 mA / 100 mA. 

6.1.5 Setting Trigger 

6.1.5.1 Overview 

When the ST2851 detects a trigger signal given by the user, it performs a sweep or point measurement in the channel depend-

ing on the trigger signal mode and events and other attributes. 

The measurement process for each channel does not depend on whether that channel is displayed, and each channel can still 

be measured even if it is not displayed (appropriate settings are required). 

6.1.5.2 Selecting Trigger Source 

The trigger source integrates the signal that starts the measurement process. Press [Trigger Mode] on the front panel and 

subsequently press [Trigger Source]. The available trigger sources and their descriptions are shown in the following table: 

Option Function 

Internal 
A firmware-integrated continuous signal is used as the trigger source, and each measurement cycle is 

triggered immediately after the completion. 

External Use external trigger (Handler) as trigger source. 

Manual Trigger once when pressing the Trigger on the front panel. 

Bus A trigger is performed by commands received via GPIB/LAN/USB. 

6.1.5.3 Selecting Trigger Event 

Press [Trigger Mode] on the front panel and subsequently switch by pressing [Trigger Event]. The available trigger events and 

their descriptions are shown in the following table: 

Option Function 

On Sweep Measure all measurement points in the whole cycle after each trigger. 

On Point Measure a single measurement point after each trigger. 

Note: When the trigger source is internal trigger, the point trigger does not work. 

6.1.5.4 Controlling Trigger 

The user can set individual trigger modes for each channel, which allows the user to control the operation of each channel after 

receiving the trigger signal. 

1) Switch to the desired channel via [Channel Next] (or [Channel Prev]) on the front panel. 

2) Press [Trigger Mode] on the front panel to enter the Trigger menu and select the trigger mode. The available trigger mode 

buttons and their descriptions are shown in the following table: 

Option Function 

[Hold] 
Set the active channel to hold and stop sweeping immediately after pressing, any subsequent meas-

urement will not be triggered. 
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[Single] 
Set the active channel to single, switch to hold and stop measurement immediately after a measure-

ment cycle. 

[Continuous] 
Set the active channel to continuous, the measurement signal is always triggered after the measure-

ment cycle. 

[Hold All] Set all channels to hold. 

[Continuous Disp CH] Set all currently displayed channels to continuous. 

6.1.5.5 Setting Trigger Scope 

The trigger scope defines the range of channels that can be triggered currently. For example, if the trigger mode of all 4 channels 

is continuous mode and the trigger scope is set to the active channel, only the currently active channel can be triggered. 

Press [Trigger Mode] on the front panel to enter the Trigger menu and switch by pressing [Trigger Scope]. The available trigger 

scopes and their descriptions are shown in the following table: 

Option Function 

All Channels All channels are triggered in sequence. 

Active Channel Trigger only for the currently active channel. 

6.1.6 Measurement of Multiple Sweep Ranges with Different Conditions in a 
Single Action (Segment Sweep) 

To perform a segment sweep, the user needs to define at least two frequency ranges, called segments. Each segment can be 

set with different number of points, OSC level, DC bias, measurement time, sweep time, sweep delay time, etc. All segments 

are swept sequentially in the same sweep operation. 

Performing segment sweep allows the user to skip frequency ranges that do not need to be swept, while allowing different 

conditions to be measured for specific frequency ranges. For example, the number of points in some segments can be set as 

large as possible to obtain more accurate results, while setting as few points as possible in some segments that do not require 

accurate results. By doing so, you can optimize the measurement time without having to perform a complete operation in a 

specific frequency range for the same measurement conditions. 

To set up a segment, you need to enter Sweep Segment Setup screen and follow the steps below: 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu. 

2) Press [Edit Segment Table] to enter the segment table. 

3) Press the following buttons to change the setting mode of the frequency range for each segment (the setting switches for 

each other measurement condition): 

Option Function 

[Freq Mode] Toggle the setting mode of the frequency range (Start/Stop or Center/Span) 

[List OSC Level] 
Switch the OSC level setting for each segment, and only when it is turned on, the segment settings 

list shows the Source Mode and OSC Level 

[List Bias] 
Switch the OSC level setting for each segment, and only when it is turned on, the segment settings 

list shows the Bias mode and DC Bias 

[List Meas Time] 
Switch the OSC level setting for each segment, and only when it is turned on, the segment settings 

list shows the Meas Time 
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[List Average] 
Switch the OSC level setting for each segment, and only when it is turned on, the segment settings 

list shows the Point Avg 

[List Segment State] 
Switch the OSC level setting for each segment, and only when it is turned on, the segment settings 

list shows the Segment Time 

[List Segment Delay] 
Switch the OSC level setting for each segment, and only when it is turned on, the segment settings 

list shows the Segment Delay 

Apply the segment sweep list you have created by setting the sweep mode as follows: 

1) Return to the sweep measurement interface and press [Sweep Type] on the front panel to enter the Sweep Type menu. 

2) Press the [Segment] button to apply the segment settings to the measurement. 

After setting to segment sweep, you can set the methods of displaying segment traces as follows: 

1) Press [Sweep Setup] on the front panel to enter the Sweep Setup menu. 

2) Press [Segment Display] to switch the display mode between Order Base and Freq Base. 

6.2 Setting Display Format of Measurement Result 

This chapter describes how to set up the ST2851 to display the measurement results in a way that best suits the user. 

6.2.1 Selecting Measurement Parameters 

6.2.1.1 Simultaneous Selection of Measurement Parameters for Traces 1 and 2 

1) Press [Meas] on the front panel to enter the Measurement menu. 

2) Press [Trace 1 & 2] to enter the measurement parameter selection menu. 

3) Select and press the button corresponding to the measurement parameter to be set. The buttons corresponding to the 

combinations of measurement parameters that can be selected are shown in the following table: 

Available Options 

Button 

Trace 1 Trace 2 

Absolute Impedance Value Impedance Phase (Angle) |Z| – θz (deg) 

Equivalent Circuit Resistance Equivalent Circuit Reactance R – X 

Equivalent Circuit Series Inductance Equivalent Circuit Series Resistance Ls – Rs 

Equivalent Circuit Series Inductance Q Factor (Quality Factor) Ls – Q 

Equivalent Circuit Series Capacitance Equivalent Circuit Series Resistance Cs – Rs 

Equivalent Circuit Series Capacitance Q Factor (Quality Factor) Cs – Q 

Equivalent Circuit Series Capacitance Dissipation Factor Cs – D 

Absolute Admittance Admittance Phase (Angle) |Y| – θy (deg) 

Equivalent Circuit Conductance Equivalent Circuit Susceptance G – B 

Equivalent Circuit Parallel Inductance Equivalent Circuit Conductance Lp – G 

Equivalent Circuit Parallel Inductance Equivalent Circuit Parallel Resistance Lp – Rp 
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Equivalent Circuit Parallel Inductance Q Factor (Quality Factor) Lp – Q 

Equivalent Circuit Parallel Capacitance Equivalent Circuit Conductance Cp – G 

Equivalent Circuit Parallel Capacitance Equivalent Circuit Parallel Resistance Cp – Rp 

Equivalent Circuit Parallel Capacitance Q Factor (Quality Factor) Cp – Q 

Equivalent Circuit Parallel Capacitance Dissipation Factor Cp – D 

Absolute Impedance Value Equivalent Circuit Series Inductance |Z| – Ls 

Absolute Impedance Value Equivalent Circuit Series Capacitance |Z| – Cs 

Absolute Impedance Value Equivalent Circuit Parallel Inductance |Z| – Lp 

Absolute Impedance Value Equivalent Circuit Parallel Capacitance |Z| – Cp 

Absolute Impedance Value Equivalent Circuit Series Resistance |Z| – Rs 

Absolute Impedance Value Q Factor (Quality Factor) |Z| – Q 

Absolute Impedance Value Dissipation Factor |Z| – D 

Magnetic Permeability Real Part Magnetic Permeability Imaginary Part 

μr' – μr'' 

(requires magnetic permeability 

module support) 

Impedance (Plural Form) Admittance (Plural Form) Z – Y 

Note: Each trace in the ST2851 has an independent vertical coordinate format, scaling data, memory trace, etc. Each trace is 

distinguished by measurement parameters. Selecting two measurement parameters at the same time makes it easier to detect 

the DUT through different angles by switching between different parameter combinations, thus making it easier to determine 

the type of the DUT. 

6.2.1.2 Setting Measurement Parameters for Individual Trace 

Set the measurement parameters for the individual traces according to the following steps: 

1) Press [Meas] on the front panel to enter the Measurement menu. 

2) Press [Trace 1 ~ 4] to enter the parameter setting menu of the corresponding trace. By default, the trace is 2. If you need 

to set Trace 3 and Trace 4, you need to set the number of traces first. 

3) Select and press the button corresponding to the parameter to be set. 

6.2.2 Setting Format of Y-Axis 

The vertical coordinates corresponding to each trace can be set as linear or logarithmic axes according to the actual measure-

ment, as follows: 

1) Press [Format] on the front panel to access the Format menu. 

2) Press [Y-Axis] to enter the Y-Axis menu and press the button of the axis type you need to set. 

Note: If you select the logarithmic axis, any points in the trace whose vertical coordinate is < 0 will automatically change the 

vertical coordinate to 1 x 10-18. 
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6.2.3 Scaling Trace 

6.2.3.1 Auto Scaling Trace 

1) Activate the trace that needs to be scaled by [Trace Prev] and [Trace Next]. 

2) Press [Scale] on the front panel to enter the Scale menu and press [Auto Scale] to scale the active trace so that all 

measurement points of the active trace are visible in the coordinate system and the overall characteristics of the trace 

can be observed. 

3) Press [Auto Scale All] to scale all current traces. 

6.2.3.2 Manual Scale Settings 

When the vertical coordinate is linear, the user can set the scaling of the trace by first setting the position of the reference value, 

then setting the reference value, and then you can set the scale value of each division. Follow these steps: 

1) Activate the trace that needs to be scaled by [Trace Prev] and [Trace Next]. 

2) Press [Scale] on the front panel to enter the Scale menu, then press [Reference Position]. 

3) Input the position of the reference value scale relative to the bottom of the vertical coordinate. In the current state, the 

number of areas is 10, so the value can be set in the range of 0 ~ 10. The default is 5, i.e. In the middle of the vertical 

coordinate. Note that the reference value scale is a scale parallel to the horizontal coordinate, and its label text color is 

consistent with the corresponding trace. 

4) Press [Reference Y Value] and input the desired vertical coordinate reference value, which is displayed on the vertical 

axis in the same color as the current trace. 

5) Alternatively, if there is a selected marker displayed in the coordinate system, you can press [Marker Function] to open 

the Marker Function menu and press [Marker → Reference] to use the selected marker value as the reference Y value. 

6) Press [Scale/Div] and input the scale value for each division. 

When the axis is logarithmic, you can set the scaling of the trace by setting the maximum and minimum values of the vertical 

coordinates. Proceed according to the following steps: 

1) Activate the trace that needs to be scaled by [Trace Prev] and [Trace Next]. 

2) Press [Scale] on the front panel to enter the Scale menu. 

3) Press [Log-Y Top] and input the upper limit value of the vertical coordinate that needs to be set. 

4) Press [Log-Y Bottom] and enter the lower limit value of the vertical coordinate you need to set. 

6.2.4 Comparison and Calculation of Trace 

The traces in the ST2851 all contain two different trace types: data and memory. Data traces are always consistent with the 

measurement data of the current DUT, and memory traces acquire data from a certain point in time. The following table lists 

the two trace types and functions: 

Option Function 

Data Trace Displays the current measurement data and calculation results (updated according to the sweep cycle) 

Memory Trace Stores and displays previously saved measured values (acquired from [Display] → [Data → Mem]) 

This feature increases the flexibility of the user's measurements, for example, Data traces and memory traces can be displayed 

and compared with each other on the same screen simultaneously or to display the results of data traces and memory traces 

calculated from each other. 
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6.2.4.1 Distinguishing Between Data Trace and Memory Trace by Comparison and Cal-

culation 

1) Activate the trace that needs to be operated by [Trace Prev] and [Trace Next]. 

2) Press [Display] on the front panel to enter the Display menu. 

3) Press [Display] to select [Data] (only the data trace is displayed in the current coordinate system). 

4) Start testing the DUT and then display the results. 

5) At the moment, the user can stop (hold) the measurement trace by pressing the [Hold] button on the front panel, which 

ensures that the data trace can be accurately reproduced when the data is later stored into the memory trace. 

6) Press [Data → Mem] and store measurement data into the memory trace. 

7) The ST2851 provides a number of options to control how the trace is displayed. Press [Display]; the available display 

functions are shown below: 

Option Function 

Data Displays data traces on the screen only 

Mem Displays the memory trace on the screen only 

Data & Mem Displays the data trace and memory trace on the screen simultaneously for easy comparison 

OFF None of the traces are displayed 

8) At this point, you can start the measurement of the DUT to observe the two traces, or if you stopped the measurement 

before, you now need to restart it in the trigger menu. 

Note: When the [Data → Mem] button is pressed, the memory trace will acquire the data on the current screen. The memory 

trace always acquires the measurement result, even if the current screen shows the result after the calculation. The 

[Data → Mem] button only works on the currently active trace. If you need to operate on other traces, you need to activate the 

trace first. 

6.2.4.2 Setting Offset Operation 

The user can set the mathematical offset with respect to the measured data, and the result of the operation is displayed through 

the data trace. The operation is performed according to the following steps: 

1) Press [Display] → [Data → Mem] to store the measurement data. 

2) Press [Data Math Offset] and input the desired offset value (0 in the default state). 

3) Press [Data Math] and select the operation corresponding to one of the following buttons: 

Option Function 

OFF Turns off any math operations. 

Data + Mem Adds the measured data to the memory data and stores in data trace. 

Data – Mem Subtracts the measured data from the memory data and stores in data trace. 

Data × Mem Multiplies the measured data with the memory data and stores in data trace. 

Data / Mem Divides the measured data by the memory data and stores result in data trace. 

4) Press [Display] and select the format of the trace display on the screen. 

5) Start the measurement. 
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6.2.5 Monitoring Source Signal Level 

6.2.5.1 Monitoring of AC Measurement Signal Level 

In most cases, the actual AC voltage applied to the DUT will deviate from the setting value because the loss occurs between 

each measurement terminal and the DUT. The ST2851 provides a function that allows the user to monitor the actual source 

signal of AC voltage and current applied to the DUT, called "signal level monitor". 

Set up level signal monitoring according to the following steps. 

1) Press [Meas] to display the Measurement menu. 

2) Press [OSC Monitor Trace] and set it to ON. When the number of traces in the channel is set to 4, the measurement 

parameter of trace 3 is set to VAC, the measurement parameter of trace 4 is set to IAC, and traces 3 and 4 are the AC 

level monitoring traces. 

3) Press [OSC Monitor Trace] and set it to OFF. The number of traces in the channel is set to 2, trace 3 and 4 are not 

displayed. 

6.2.5.2 Monitoring Dc Bias Level 

In most cases, the actual DC bias applied to the DUT will deviate from the set value due to losses between each measurement 

terminal and the DUT, and the ST2851 provides a function that allows the user to monitor the actual DC bias voltage and 

current applied to the DUT. This feature is called the "DC bias level monitor". 

The user can monitor the voltage and current values of the DC bias, which are refreshed before each sweep cycle and displayed 

in the upper right corner of the screen, labeled DCV and DCI. 

Turn on the DC monitoring by following these steps: 

1) Press [Meas] to display the Measurement menu. 

2) Press [DC Monitor Setup] → [DC Monitor] to toggle the DC bias monitoring ON/OFF. 

6.2.6 Setting Form Display 

6.2.6.1 Maximizing the Display of Specific Channels/Traces 

When there are multiple channels, you can maximize the display of a specific channel on the screen; when there are multiple 

traces in the channel, you can also maximize the display of a specific trace in the channel form. 

Switch the maximized display state of the channel according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel that needs to be set up. 

2) Press [Channel Max] to maximize the channel form. 

3) Press [Channel Max] again to restore the channel form to its original size. 

Switch the maximum display state of the trace according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel where the trace to be set is located. 

2) Press [Trace Next] (or [Trace Prev]) to switch to the trace that needs to be set. 

3) Press [Trace Max] to maximize the trace within the channel window. 

4) Press [Trace Max] again to restore the trace to its original size. 
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6.2.6.2 Turning OFF Graticule Label Display 

You can expand the display of the coordinate system by turning off the label display of the vertical coordinates. To do so, follow 

these steps. 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel that needs to be set up. 

2) Press [Display] on the front panel to enter the Display menu. 

3) Press [Graticule Label] to toggle the Graticule Label ON/OFF. 

6.3 Analysis and Processing of Measurement Data 

6.3.1 Analyzing Data by Marker 

6.3.1.1 About Marker Function 

The marker has the following uses: 

• Reading the value of the measurement result (as an absolute value or a relative value to the reference point). 

• Finding a specific point on a trace (marker search). 

• Analyzing trace measurement results and calculating statistical data. 

• Using the value of the marker to modify the stimulus as well as the scale. 

The ST2851 can display 10 markers on each trace, including the reference marker. Each marker has a stimulus value (the 

value corresponding to the X-axis of the coordinate system) and a response value (the value corresponding to the Y-axis of the 

coordinate system). 

6.3.1.2 Reading Marker Value on the Trace 

The user can read the marker value displayed on the trace, and the response value of the marker is always in the same format 

as the Y-axis. When the sweep range is set to 0, the stimulus value of the marker is displayed as the serial number of the 

current measurement point. When the function [Marker] → [Discrete] is turned off, the marker can be moved between meas-

urement points by interpolation. 

Create a marker on the trace according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace on which a 

marker is used. 

2) Press [Marker] to enter the Marker menu. 

3) Press the marker button that needs to be opened to open the marker. The Marker button can be used to open or activate 

the marker. 

Move the marker according to the following steps: 

1) Press the button corresponding to the marker that needs to be moved and enter the new stimulus value. This enables 

you to move the position of the marker in the trace. 

2) When the marker is active, the marker can be moved by sliding your finger across the screen. 

Remove the marker according to the following steps: 

1) Press Marker to enter the Marker menu. 

2) Press [Clear Markers], and then press the button corresponding to the marker that needs to be removed. 
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6.3.1.3 Reading Relative Value with Respect to Reference Point 

The user can transform the marker value into a relative value with respect to the reference point. 

Set the reference marker according to the following steps: 

1) Press [Marker] to enter the Marker menu and press [Ref Marker] to create the reference marker. 

2) Move the reference marker to the position that needs to be set as a reference point. 

3) Activate the desired marker and move it to the desired position, the reading of the marker at this point is the value relative 

to the reference marker. 

Note: Pressing [Marker → Ref Marker] can automatically open the reference marker and moves it to the currently active marker 

position. 

6.3.1.4 Reading Interpolation Between Actual Measurement Points/Measurement Points 

Depending on the setting of the measurement points in the marker function, the points that can be positioned by the marker on 

the trace will differ, as shown in the following table: 

Option Description 

Discrete ON 

The marker can only be positioned to the actual measurement point. 

A marker stimulus setting value is automatically positioned to the nearest measurement point if it is 

between measurement points. 

The marker that sets between measurement points with the discrete function off is automatically posi-

tioned to the nearest measurement point when this function is turned on. 

Discrete OFF 
The marker positioning is not necessarily limited to the actual measurement point but can be positioned 

between the measurement points and obtain the response value at that location by interpolation. 

Set the discrete mode according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel that needs to be set up. 

2) Press [Marker Function] to enter the Marker Function menu. 

3) Press [Discrete] to toggle the discrete mode ON/OFF. 

6.3.1.5 Setting Up Marker Couple Between Traces 

The marker can be set to move on all traces in the channel at the same time or on each trace individually. 

Option Function 

Marker Couple ON The marker of the same number on all traces is set up and moved at the same time in the channel. 

Marker Couple OFF The marker on each trace is set up as well as moved individually. 

Set the marker couple mode according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel that needs to be set up. 

2) Press [Marker Function] to enter the Marker function menu. 

3) Press [Couple] to toggle the couple mode ON/OFF. 
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6.3.2 Searching Specific Measurement Point on a Trace 

6.3.2.1 Overview 

The user can search for a specific measurement point that meets the user's criteria by using the Marker Search function. 

Marker Search allows the user to search for measurement points with the following criteria: 

• Maximum Value 

• Minimum Value 

• Peak: contains positive peak (extreme values), negative peak (minimal values), the nearest peak to the left of the marker, 

and the nearest peak to the right of the marker. 

• Multiple Peaks 

• Target: contains the nearest target value to the marker, the nearest target value to the left of the marker, and the nearest 

target value to the right of the marker. 

• Multiple Targets 

6.3.2.2 Setting Search Range 

The Marker Search function allows the user to use part of the sweep range as search range (Partial Search function). 

Toggle the Partial Search function ON/OFF according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel that needs to be set up. 

2) Press [Marker Search] to enter the Marker Search menu and press [Search Range] to enter the Search Range menu. 

3) Press [Search Range State] to toggle the Search Range ON/OFF. 

Set the search range according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) to switch to the channel that needs to be set up. 

2) Press [Marker Search] to enter the Marker Search menu and press [Search Range] to enter the Search Range menu. 

3) Press [Search Range State] to turn on the Search Range function. 

4) Press [Start] to enter the lower limit value of the search range. 

5) Press [Stop] to enter the upper limit value of the search range. 

6.3.2.3 Auto-Complete Search (Marker Tracking) 

The Marker Tracking feature automatically performs a search at the stop of each sweep cycle, even if the associated marker 

search button is not pressed. This feature allows the user to easily observe the measurement results, such as the maximum 

value of a trace. 

Toggle the marker tracking function ON/OFF according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that need 

to be set up. 

2) Press [Marker Search] to access the Marker Search menu. 

3) Press [Tracking] to toggle the tracking ON/OFF. 
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6.3.2.4 Searching for Maximum and Minimum Values 

The user can search for the maximum and minimum value points on the measurement trace and move the marker to that point. 

Search for the maximum or minimum value point according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that require 

the use of the marker. 

2) Activate the marker that needs to be used for searching for. 

3) Press [Marker Search] to access the Marker Search menu. 

4) Press [Max] or [Min] to complete the search. 

6.3.2.5 Searching for Peak 

The Search Peak function allows the user to search for the peaks on a trace. Peaks are measurement points on the trace 

where the measured value is greater or less than two adjacent points on the left and right. Depending on the quantitative 

relationship between the measured value and the adjacent measurement points, the peaks can be classified into the following 

two categories: 

Option Description 

Positive 
The maximal value; that is, the measured value is greater than the adjacent measurement points on the 

left and right. 

Negative 
The minimal value; that is, the measured value is smaller than the adjacent measurement points on the 

left and right. 

The peak excursion is defined as the minimum difference (absolute value) between the measured value at the peak point and 

the measured value at the adjacent measurement point. 

There are three ways to find the peaks as follows: 

Option Description 

Search Peaks Move the marker to the closest point that matches the search criteria. 

Search Left Move the marker to the closest point on the left that matches the search criteria. 

Search Right Move the marker to the closest point on the right that matches the search criteria. 

Set up according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that require 

the use of the marker. 

2) Activate the marker that needs to be used for searching for. 

3) Press [Marker Search] to enter the Marker Search menu and press [Peak] to enter the Peak menu. 

4) Press [Peak Excursion] to enter the desired peak excursion, a value that defines the minimum value of the difference 

between the peak point and the measured value of the adjacent measurement point. 

5) Press [Peak Polarity] and select the type of peak to search for (Both, Positive, Negative). 

6) Press the corresponding search button ([Search Peak], [Search Left], [Search Right]) to perform a peak search. 
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6.3.2.6 Searching for Multiple Peaks 

Searching for multiple peaks allows the user to search for multiple peaks on a trace. The peak points and peak excursion are 

set in the same way as Search Peaks. When the ST2851 finds a peak point that meets the criteria, it automatically moves the 

marker to that point. Depending on the number of peak points, markers 1-9 are sequentially arranged from the starting fre-

quency order. Note that the reference point marker is not affected. 

Search for the multiple peaks according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that require 

the use of the marker. 

2) Press [Marker Search] to enter the Marker Search menu and press [Multiple Peaks] to enter the Multiple Peaks menu. 

3) Press [Peak Excursion] to enter the desired peak excursion, a value that defines the minimum value of the difference 

between the peak point and the measured value of the adjacent measurement point. 

4) Press [Peak Polarity] and select the type of peak to search for (Both, Positive, Negative). 

5) Press [Search Multi Peak] to complete the multiple peaks search. 

6.3.2.7 Searching for Target Value 

The Search Target Value is a function that searches for the measurement point on the trace where the measurement value 

matches the target value and the trends of data change (Positive, Negative, Both), while moving the marker to that point. 

The target value point is the measurement point on the trace where the measured value is equal to the set target value. 

Depending on the trends of data change at the measurement point, it can be classified into two types: 

Option Description 

Target Transition 

Type (Positive) 
The data of the measurement point is greater than the data of the adjacent point on the left. 

Target Transition 

Type (Negative) 
The data of the measurement point is smaller than the data of the adjacent point on the left. 

ST2851 provides the following three ways to search for the target value: 

Option Description 

Search Target 
The marker moves to the measurement point where the nearest measured value is equal to the target 

value. 

Search Left 
The marker moves to the measurement point on the left where the closest measurement value is equal 

to the target value. 

Search Right 
The marker moves to the measurement point on the right where the closest measurement value is 

equal to the target value. 

Find the target value according to the following steps. 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that require 

the use of the marker. 

2) Activate the marker that needs to be used for searching for. 

3) Press [Marker Search] to enter the Marker Search menu and press [Target] to enter the Target menu. 

4) Press [Target Value] and input the target value that needs to be set up. 
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5) Press [Target Transition] and select the target transition that needs to be set up. 

6) Press the corresponding search button ([Search Target], [Search Left], [Search Right]) to perform a target value search. 

6.3.2.8 Searching for Multiple Target Values 

Searching for Multiple Target Values allows the user to search for multiple target values on the trace. The target value point 

and target value are set to match the search target value. When the ST2851 finds a target value point that meets the criteria, 

it automatically moves the marker to that point. Depending on the number of target points, markers 1-9 are sequentially ar-

ranged from the starting frequency order. Note that the reference point marker is not affected. 

Perform a multiple target value search according to the following steps. 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that require 

the use of the marker. 

2) Press [Marker Search] to enter the Marker Search menu and press [Multi Target] to enter the Multi Target menu. 

3) Press [Target] and input the target value that needs to be set up. 

4) Press [Target Transition] and select the target transition that needs to be set up. 

5) Press [Search Multi Target] to complete the search for multiple target values. 

6.3.3 Analyzing Equivalent Circuit and Simulate Frequency Characteristics 

6.3.3.1 Equivalent Circuit Analysis Based on Measurement Results 

Perform the equivalent circuit analysis operation according to the following steps: 

1) Perform trace sweep with frequency as the stimulus value. 

2) Press [Analysis] → [Equivalent Circuit] → [Select Circuit]. 

3) Select the equivalent circuit model according to the following table: 

Equivalent Circuit Model Frequency Characteristics Example of DUT 

A 

 
 

Inductor with high loss 

B 

 
 

Inductor, resistor 

C 

 
 

High value resistor 

D 

 
 

Capacitor 
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E 

 
 

Resonator 

F 

 
 

Inductor with equivalent series resistance 

G 

 
 

Capacitor 

In the frequency characteristic plot in the above table, the measurement parameters are all |Z| – θz (deg), the sweep type is 

logarithmic sweep, the vertical coordinate of |Z| is the logarithmic axis, and the vertical coordinate of θz (deg) is the linear axis 

4) Press [Calculate] to perform equivalent circuit analysis calculation and the calculated parameters R1, C1, L1, R0, C0 are 

displayed in the corresponding input box. 

6.3.3.2 Simulating Frequency Characteristics Based on Equivalent Circuit Parameters 

The frequency characteristics are simulated according to the following steps: 

1) Perform trace sweep with frequency as the stimulus value. 

2) Press [Analysis] → [Equivalent Circuit] → [Select Circuit]. 

3) Select the equivalent circuit model. 

4) Press [R1], [C1], [L1], [R0], [C0] to select and input the equivalent circuit parameters that need to be modified. 

Equivalent Circuit Parameters Description 

R1 Resistance R1 in the equivalent circuit 

C1 Capacitance C1 in the equivalent circuit 

L1 Inductance L1 in the equivalent circuit 

C0 Capacitance C0 in the equivalent circuit model E 

R0 Capacitance R0 in the equivalent circuit model F, G  

5) Press [Stimulate] to toggle it ON and complete the simulation of the frequency characteristics. 

6) Press [Display] to toggle it ON, and the current equivalent circuit model and the values of the equivalent circuit parameters 

are displayed on the bottom left corner. 

7) Press [Export] to save the equivalent circuit parameters and model. 

6.3.4 Crystal Oscillator Analysis 

You can measure and analyze the performance of crystals such as piezoceramics, and obtain important parameters such as 

resonant frequency, anti-resonant frequency, and quality factor of the crystal after measurement and calculation. 
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6.3.4.1 Opening Crystal Oscillator Analysis 

Set the crystal oscillator analysis switch state according to the following steps: 

1) Perform trace sweep with frequency as the stimulus value. 

2) Press [Analysis] → [OSC Analysis]. 

3) Press [State] to toggle the analysis ON/OFF. 

Crystal oscillator analysis is a frequency-based trace analysis and calculation, so this function can only be turned on when the 

sweep type is frequency mode (both linear and logarithmic frequencies are possible). When the crystal oscillator analysis 

function is turned on, the instrument performs a measurement at a frequency of 1 kHz after each trace sweep cycle, and then 

analyzes and calculates each parameter based on the measurement results, which are displayed in the menu on the right. 

 

6.3.4.2 Setting Quality Factor Calculation Formula 

According to the actual situation, choose the formula for the quality factor Qm: 

1) Perform trace sweep with frequency as the stimulus value. 

2) Press [Analysis] → [OSC Analysis] → [Q Equation]. 

3) Select the corresponding formula button and press it to configure. 

6.3.5 Trace Statistical Data 

The user can obtain statistical data on the trace, including range, mean, standard deviation, and peak-to-peak values. The 

statistics are defined as shown below, only for the trace between marker 1 and 2, markers 1 and 2 are turned on automatically. 
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Statistical Data Element Description 

Range (span) Span between marker 1 and 2 

Mean Value (mean) 

∑ xi
n
i=1

n
 

• n is the number of measurement points between markers 1 and 2 

• xi is the measurement value at the ith measurement point. 

Standard Deviation (s.dev) 

√
∑ (xi − mean)2n

i=1

n − 1
 

• n is the number of measurement points between markers 1 and 2 

• xi is the measurement value at the ith measurement point 

• mean is the average value 

Peak-to-Peak (p-p) The difference between the maximum and minimum values between marker 1 and marker 2 

Switch the display of the statistics according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the channel and trace that require 

the use of the marker. 

2) Press [Marker Function] to enter the Marker Function menu and press [Statistics] to switch it ON. 

3) Markers 1 and 2 are automatically turned on. Move to the appropriate position, and the statistics are displayed on the 

upper left of the coordinate system. 

6.3.6 Trace Limit Line 

The trace limit line feature allows the user to set a pass range for each trace and determine if the measurement results "PASS" 

or "FAIL". 

The user can add limit lines to certain intervals in the sweep range, which contain the upper and lower limits of the passing 

value. The measured value of the measurement point contained in the limit line must be between the upper and lower limits to 

be considered a pass point, and vice versa. If there is a fail point in the trace, the trace is judged to be a failure (Fail). 

6.3.6.1 Setting Limit Line 

Setting the limit line first needs to set a standard trace as a reference value, the upper and lower limits of the limit line is set up 

based on the setting of the reference trace, according to the following steps: 

1) Perform a measurement with a standard test piece to obtain a standard trace. 

2) Press [Channel Next] (or [Channel Prev]) and [Trace Next] (or [Trace Prev]) to activate the trace on which the limit test is 

used. 

3) Press [Analysis] → [Limit Test] to enter the Limit Test menu. 

4) Press [Data → Reference] to set the active trace as the reference value. 

5) After setting up the reference value, the button [Edit Limit Line] becomes available. Press it to enter the list limit test 

interface, and set up the limit line. 
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. 

6) Press [Add] to add a new limit line. 

7) Press the row where the limit line is located to enter the Limit Test menu. 

8) Set the parameters in the limit line according to the following table: 

Limit Line Set Parameters Description 

Limit Type 

The types of upper and lower limits of the qualifying values in the limit line are selected as 

follows: 

• ABS: The upper and lower limits are definite values. 

• Dev: The upper and lower limits are the differences from the set reference trace. 

• %: The upper and lower limits are percentages relative to the set reference trace. 

• % Dev: The upper and lower limits are percentages of the difference with respect to the 

set reference trace. 

Begin Stimulus Starting value of the stimulus value on the limit line 

End Stimulus Ending value of the stimulus value on the limit line 

Upper Limit Upper limit of qualified measurements on the limit line, data type depends on the limit line type 

Lower Limit Lower limit of qualified measurements on the limit line, data type depends on the limit line type 

9) After setting up, you can export the set data to a file/import existing data from a file by using the [Export/Import] button. 

6.3.6.2 Proceeding Limit Line of Measurement Trace 

1) Press [Analysis] → [Limit Test] to enter the Limit Test menu. 

2) Press [Limit Line] to toggle it ON, and the limit line is displayed in the coordinate system. 

3) Start to perform the limit line of the current measurement trace. 

4) The limit line results are displayed at the position of the trace state above the coordinate system. 
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6.3.7 Trace Trails Comparison 

The trace trails comparison is for continuous measurement of many different DUT, all traces are displayed in the same coordi-

nate system, and the trace trails under different measurement conditions can be compared. At the same time, different fre-

quency points can be set up and the measured values of all traces at that frequency point can be calculated. 

 

Trace trails measurement steps: 

1) Press [Parameter 1] and [Parameter 2] to set the parameters that need to be measured, noting that modifying the meas-

urement parameters can clear the measured traces and data. 

2) Press [Log X] and set the horizontal coordinate to logarithmic or linear axis, noting that modifying the axis can clear the 

measured trace and data. 

3) Set the start and stop frequencies, noting that setting the frequency can clear the measured traces and data. 

4) Press [Measure] once to perform a sweep, and press [Cancel] once to cancel the previous measurement trace. 

5) After completing the measurement, replace the DUT and press [Measure] once again for the next measurement. 

6) Repeat steps 5 and 6 until the measurement is complete, up to 10 measurements (20 traces in total). 

7) Press [Get Screen] to save the current measurement image. 
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Press [Data] tab at the top to switch to the data table and set the frequency point at which the data needs to be read, as follows: 

1) Press [Add Line] to add a new row to the trails table. 

2) Select the line and then, in [Frequency], modify the frequency that needs to be read. 

3) Repeat steps 1 and 2 to complete the frequency setting. 

4) Press [Calculate] to calculate the measurement data for the corresponding frequency point based on the previously meas-

ured trace and display it on the data table. 

5) Press [Export Data] to export the measurement data from the data table to the hard disk. 

6.3.8 Marker Limit 

It is to set the reference value and upper and lower limits of marker limit for the marker in the trace scanning to judge whether 

its measurement value is within the set qualified range. 

 

Shown above is the interface of Marker Limit setting, which contains the limit parameters of marker 1 ~ 9 on the 4 traces of the 

current channel (the reference marker cannot be sorted). 

Set the marker limit parameters according to the following steps: 

1) Press [Channel Next] (or [Channel Prev]) button to activate the channel for marker limit; 

2) Press [Analysis] → [Marker Limit] to enter the marker limit interface; 

3) Click the marker whose limit parameters you wish to set, and do so according to the following table: 
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Parameter Description 

State The ON/OFF switch for this marker limit 

Type 

The type of the upper and lower limits with the following type options: 

• Absolute Value: The upper and lower limits are defined values. 

• Deviation Value: The upper and lower limits are differences from a set reference value. 

• %: The upper and lower limits are percentages relative to a set reference value. 

• % Deviation: The upper and lower limits are a percentage of the difference with respect to a set 

reference value. 

Reference Reference value for qualified marker limit 

Upper Upper limit of qualified measurements on the limit line, data type depends on the limit line type 

Lower Lower limit of qualified measurements on the limit line, data type depends on the limit line type 

4) Return to the trace interface after configuration is complete, activate the marker that needs to be sorted, measure and 

complete limit, and query the limit result through the command. 

5) Limit setting interface can import and export limit results. 
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7 Save and Load 

7.1 Point Measurement 

7.1.1 Save 

1) When in the point measurement interface, press [Save/Recall] on the front panel to enter the Save/Recall menu, then 

click [Save State] to enter the Save State menu. 

2) Select and click the required state to save your settings. 

 

The specific key meanings are as follows: 

Option Description 

State 01 ~ 08 Save the setting status in the file corresponding to the serial number. 

Autorec 

Save the setting status in the auto save file. 

When Start from Setup of system setting is set to Auto, ST2851 will automatically save the device status 

on a regular basis. The saved file name is SaveData\PointAutorec.sta, and the automatically saved file 

will be overwritten.When the auto saved file can be detected during startup, it will be loaded. 

UserPres 

Save the setting status in the user saved file. 

The user saved file can be used to start loading or initialization. It needs to be changed in the system 

settings. 

File Customize the save location and file name. 

Note: If the key name is marked with "*", it means that there is a saved file in the save field. Click this button to prompt whether 

to overwrite the existing file, and click [OK] to save and overwrite it. 
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7.1.2 Load 

1) When in the point measurement interface, press [Save/Recall] on the front panel to enter the Save/Recall menu, then 

click [Recall State] to enter the Recall State menu. 

2) Select and click the required state to load settings. 

 

3) If a saved file exists in State01~08/Autorec/UserPres, the corresponding key will be available. Click the key to load the 

saved file. 

4) If you need to load a saved file with any name at any location in the hard disk, click [Recall State], select the required file 

in the pop-up window, and press [Open] to load it. 

7.1.3 Screen Capture 

1) When in the required interface, press [Save/Recall] on the front panel to enter the Save/Recall menu, then click [Dump 

Screen Image] to open the pop-up window. 

2) Find the location to be saved in the navigation window, enter an appropriate file name, and save the picture. 

3) This function can also be achieved by clicking [Dump Screen Image] on the System menu. 

7.2 List Measurement 

1) When in the point/list measurement interface, press [Save/Recall] on the front panel to the enter Save/Recall menu, then 

click [Export List Data] to open the pop-up window. 

2) Find the location to be saved in the navigation window, enter an appropriate file name, and save the file. The default file 

format for export is .csv. 

7.3 Comparator 

7.3.1 Save 

1) When in the comparator setting interface, press [All Tables] on the Comparator Table menu to enter the All Tables menu. 

2) Click [Export All] to open the pop-up window. 

3) Find the location to be saved in the navigation window, enter an appropriate file name, and save the file. The default file 

format for export is .pbi. 
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7.3.2 Load 

1) When in the comparator setting interface, press [All Tables] on the Comparator Table menu to enter the All Tables menu. 

2) Click [Import All] to open the pop-up window. 

3) Select the required file in the navigation window, and press [Open] to load the file. 

7.4 Sweep 

1) Click [Sweep] on the Point Root Menu to enter the Sweep Root menu. 

2) Click [Save/Recall] on the Sweep Root menu, or press [Save/Recall] button on the front panel to enter Save/Recall menu. 

 

7.4.1 State 

Save the relevant data in a file and reload it later. 

The save mode is as follows: 

Option Description 

State Only Only save the sweep settings. 

State & Trace Save settings and measurement data. 

The save data mode is as follows: 

Option Description 

Display Only Only save relevant data of the channels/traces currently displayed. 

All Save relevant data of all channels and traces. 

7.4.1.1 Save 

The pairs of Save Type and Channel/Trace are as follow: 

 Save Type: State Only Save Type: State & Trace 

Channel/Trace: 

Display Only 

Saves… 

• only the settings 

• of the currently displayed channels and traces. 

Saves… 

• the settings and measurement data 

• of the currently displayed channels and traces. 
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Channel/Trace: 

All 

Saves… 

• only the settings  

• of all channels and traces. 

Saves… 

• the settings and measurement data 

• of all channels and traces. 

Operation steps below to save state: 

1) When in the sweep interface, press [Save/Recall] on the front panel to enter the Save/Recall menu, then click [Save State] 

to enter the Save State menu. 

2) Select and click the required state to save settings. 

3) The specific saving method is the same as that of point measurement (See section 7.1.1 for details). 

7.4.1.2 Load 

The specific loading method is the same as that of point measurement (See section Fehler! Verweisquelle konnte nicht 

gefunden werden. for details). 

7.4.2 Channel 

ST2851 allows the user to save/load the setting status of a channel separately. This function allows the user to save the state 

of the activated channel to one of the four positions (A-D) separately, and then load the stored settings after activating the other 

channel. This function is very convenient for copying status between channels. It should be noted that, unlike the state of saving 

the whole trace sweep, this function saves the data in the memory as a temporary file, so once the power is off or the program 

is closed, the stored data will be lost. 

7.4.2.1 Save 

1) When in the sweep interface, press [Channel Next] or [Channel Prev] on the front panel to switch to the channel to be 

saved. 

2) Press [Save/Recall] on the front panel to enter the Save/Recall menu, then click [Save Channel] to enter the Save Channel 

menu. 

3) Select and click the required key to save settings. 

Note: If the key name is marked with "*", it means that there is a saved file in the save field. Click this button to prompt whether 

to overwrite the existing file, and click [OK] to save and overwrite it. 

7.4.2.2 Load 

1) When in the sweep interface, press [Channel Next] or [Channel Prev] on the front panel to switch to the channel to be 

loaded. 

2) Press [Save/Recall] on the front panel to enter the Save/Recall menu, then click [Recall Channel] to enter the Recall 

Channel menu. 

3) Select and click needed key to load settings. 

7.4.2.3 Clear 

1) When in the sweep interface, press [Save/Recall] on the front panel to enter the Save/Recall menu, then click [Save 

Channel] to enter the Save Channel menu. 

2) Click [Clear States] to clear all channel save files. 
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7.4.3 Trace Data 

1) When in the sweep interface, press [Channel Next] or [Channel Prev] on the front panel to switch to the required channel. 

2) Press [Save/Recall] on the front panel to enter the Save/Recall menu, then click [Save Trace Data] to enter the Save 

Trace Data menu. 

3) Click [Scope] to select the scope of trace to save: 

Option Description 

Single Save only the currently active trace. 

Channel Save all traces in the currently active channel. 

Displayed Save all visible traces in all visible channels. 

4) After selecting the scope, click [Save Trace Data] on the Save Trace Data menu to open the pop-up window. 

5) Find the location to be saved in the navigation window, enter an appropriate file name, and save the file. 
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8 System Setup 

8.1 System Calibration 

System calibration is the various calibrations performed on the ST2851 before the device leaves the factory, and system cali-

bration directly affects the measurement accuracy of the ST2851. A password is required to enter the system calibration inter-

face, and in principle, users are prohibited from entering this interface. 

8.2 Language Settings 

ST2851 can set different language environment according to user requirements. After setting the language, the software inter-

face is displayed in the set language text. Currently, ST2851 supports Chinese and English settings. 

Set the software language according to the following steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Language Set] to enter the Language Set menu and press the button corresponding to the language you need to 

set to complete the setting. 

8.3 System Test 

The system test is a functional test of some of the ST2851's hardware in software. The test results are displayed on the screen. 

8.3.1 Front Panel Test 

 

The front panel test is a test of the ST2851 front panel keys. The front panel keys are displayed graphically in this interface. 

When the test is performed, if the key function is normal after pressing the key, a green tick √ will be displayed on the upper 

right corner of the corresponding key graphic in this interface, indicating that the test is passed. At the same time, after entering 

this interface, the keys with background lights on the front can light up and turn off the background lights intermittently. 

Perform the front panel test according to the following steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Test] → [Front Panel Test] to perform the front panel test. 
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8.3.2 Handler Test 

 

The Handler corresponding to the gray/green indicator in the interface can switch between high and low levels. When the 

indicator is switched from gray to green by Pressing on it, the corresponding Handler can issue a command to set the level to 

high; when the indicator is switched from green to gray by Pressing on it, the corresponding Handler can issue a command to 

set the level to low. Pressing the [Start Test] button can automatically cycle through all Handlers in order. 

Perform the Handler test according to the following steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Test] → [Handler Test] to perform the Handler test. 

8.4 Preset 

You can restore the setting state of the ST2851 to its initial state. Depending on the options in the initialization settings, the 

instrument can be restored to the factory state or to a user-saved state. 

Follow the steps below: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Preset] to start the Preset operation. 

8.5 System Information and Software Updates 

The system information page displays the current instrument information of the ST2851, including product name, measurement 

frequency range, manufacturer, software version number, serial number, MAC address, IP address, etc., and allows for software 

updates. 

Open the system information screen according to the following steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press the [Info] button to open the System Information screen. 

3) The system IP address (only when the LAN port is connected) is displayed with the normal setting value, otherwise the 

default display is 127.0.0.1. 

4) Press [Update] on the lower left corner to update the software. Select the software update package on the pop-up window 

and open it. The software is closed and updated automatically and will start automatically after the update is completed. 
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8.6 Misc Setup 

8.6.1 GPIB Setup 

Set and modify the address of the GPIB. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [GPIB] Setup, enter the new address in the input box and press [x1] to finish the modification. 

8.6.2 Network Setup 

You can set up the network parameters of the ST2851 and switch the network connection on and off. The modified settings 

can only take effect after the software is restarted. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Network Setup] to configure. 

8.6.3 Serial Port Setup 

Set the baud rate of the serial port of the ST2851. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Serial Port Setup] to select and modify the baud rate. 

8.6.4 Preset Setup 

You can modify the Preset setup of the ST2851. Using Preset, you can restore to factory settings or previously saved user 

settings. If no user settings file exists, only the factory settings can be restored. It is also possible to set whether a secondary 

confirmation is required when the Preset setup is performed. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Preset Setup] to configure. 

8.6.5 Startup Setup 

Setting the state loading performed by the ST2851 at startup can be set to factory setting/user setting/auto setting. 

When set to factory settings, the system automatically loads the factory settings when powering up. When set to user settings, 

the system loads the user settings file (if the file exists) when powering up; when set to auto settings, the system loads the auto 

settings file (if the file exists) when powering up. 
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When the startup setup is set to auto setting, the status setting file can be saved automatically every time during the software 

operation. If there is no relevant file when the software is started after user setting or auto setting is selected, it will be started 

with factory settings. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Startup Setup] to configure. 

8.6.6 Start Form Setup 

Set up the measurement interface that the ST2851 enters by default when the ST2851 starts up. It can be set to single point 

measurement / list measurement / trace sweep interface. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Start Form Setup] to configure. 

8.6.7 Key Lock 

The front panel or touch screen can be temporarily locked to prevent maloperation during remote operation. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Key Lock] to configure. 

8.6.8 Handler Setup 

Set up and modify the Handler output rules of ST2851. 

8.6.8.1 Effective Level Setup 

Set the effective output level of Handler, when set to high, the output is ON when it is high; when set to low, the output is ON 

when it is low. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Handler Setup] to enter the Handler Setup menu. 

4) Press [Effective Level] to configure. 
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8.6.8.2 Signal Type Setup 

Set the output signal of the Handler as a level signal or a pulse signal. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Handler Setup] to enter the Handler Setup menu. 

4) Press [Signal Type] to configure. 

8.6.8.3 Pulse Width Setup 

Set the pulse width when the output signal of Handler is a pulse signal, and the valid range of pulse width is 1 ms ~ 1000 ms. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Handler Setup] to enter the Handler Setup menu. 

4) Press [Pulse Width (ms)] and enter the required pulse width. 

8.6.8.4 Supply Voltage Setup 

Set the supply voltage of the Handler to Internal or External. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Handler Setup] to enter the Handler Setup menu. 

4) Press [Supply Voltage] to configure. 

8.6.9 Beeper 

Set whether the buzzer sounds when a front panel button or a button in the menu bar is pressed. 

Follow these steps: 

1) Press [System] on the front panel to enter the System menu. 

2) Press [Misc Setup] to access the Misc Setup menu. 

3) Press [Beeper] to toggle the buzzer sounds ON/OFF. 
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9 Programming Commands 

9.1 Remote Control 

9.1.1 Types of Remote Control 

Depending on the system controller and the interface, the user can choose the types of remote-control system shown in the 

following table (after starting remote control, the front panel and screen will be locked and unlocked by pressing the [Help] key). 

System Controller Interface Summarize 

External controller (external computer, such 

as the PC or workstation) 

GPIB Connecting an external controller to the ST2851 via GPIB 

LAN Connecting an external controller to the ST2851 via LAN 

USB Connecting an external controller to the ST2851 via USB 

RS232 Connecting an external controller to the ST2851 via RS232 

9.1.1.1 GPIB Remote Control System 

GPIB (General Purpose Interface Bus) is an interface standard used to connect computers to peripheral devices that conform 

to IEEE 488.1, IEC-625, IEEE 488.2 and JIS-C1901 international standards. The GPIB interface enables the user to control 

the ST2851 from an external computer. The computer sends commands and commands to the ST2851 and receives data sent 

from the ST2851 via GPIB. 

9.1.1.2 LAN (Local Area Network) Remote Control System 

The ST2851 and the external controller are connected via LAN (Local Area Network) and the ST2851 is programmed and 

controlled using SCPI commands after connection. 

In the control system utilizing SCPI commands, communication between the external controller (client) and the ST2851 (server) 

is performed using the SICL-LAN protocol. Using SICL (Standard Instrument Control Program Library), the user can control 

the ST2851 by programming using SICL or VISA, in the UNIX environment using the C language, or in the Windows environ-

ment, the programming environment such as Visual C++ and Visual Basic language are used. 

When using LAN for remote control, you need to set the network environment of the ST2851 first. 

Set up the network environment of the ST2851 according to the following steps: 

1) Press [System] on the front panel to enter the System Setup menu. 

2) Click [Misc Setup] → [Network Setup] to open the Network Setup menu 

3) Click [Enable] to set the network status of the ST2851 to ON. 

4) Click [Network Config] to bring up the system's Network Setup window and set the system's IP address. 

5) When you have finished making changes, click [Return] and the ST2851 will pop up a dialog box prompting that the 

software needs to be restarted to enable the settings, click [OK] to restart. 

6) On the device to be connected, set the IP address to the same network segment as the ST2851 and the port number to 

5025, then connect the ST2851. 

9.1.1.3 USB and RS232 Remote Control System 

The ST2851 is controlled by programming the ST2851 through the RS232 serial port connected to the ST2851 and the external 

controller. The USB control system is using USB as a serial port. 
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Modify the baud rate of the ST2851 serial communication protocol according to the following steps: 

1) Press [System] on the front panel to enter the System Setup menu. 

2) Click [Misc Setup] → [Serial Port Setup] to open the Serial Port Setup menu. 

3) Click the button corresponding to the baud rate to be set to complete the setting. 

9.1.2 RS232 Remote Interface 

9.1.2.1 Introduction to RS232 

Currently widely used serial communication standard is the RS232 standard, also called asynchronous serial communication 

standard, used to realize the data communication between computers and computers, computers and peripheral devices.RS 

for the "Recommended Standard" (Recommended Standard) of the English acronym, 232 is the standard number. The stand-

ard was OFFicially announced by the Electronic Industries Association of America (EIA) in 1969. It specifies that one bit of data 

at a time is transmitted over one data line. Most serial port configurations are usually not strictly based on the RS232 standard. 

The most commonly used RS232 signals are shown in the table: 

Code Notation 25 Pole Connector Pin Number 9 Pole Connector Pin Number 

Request to Sent RTS 4 7 

Clear to Send CTS 5 8 

Data Set Ready DSR 6 6 

Data Carrier Detect DCD 8 1 

Data Terminal Ready DTR 20 4 

Transmit Data TXD 2 3 

Received Data RXD 3 2 

Grounding GND 7 5 

Note: The serial port pin definition of this instrument is the same as the pin definition of the connector of the standard 9-pole 

RS232C. The RS232 connector on this instrument uses a 9-pole pin DB type socket with the pinout sequence shown below: 

 

Direct connection is possible using a standard 9-pole DB-type hole plug. 

WARNING! 

 

To avoid electrical shock, turn off the power when plugging and unplugging the connectors; do not short the 

output terminals or short to the chassis at will to avoid damage to the device.. 
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9.1.2.2 RS232 Operation 

1) RS232 is Connected to the Computer as Shown Below: 

 

As can be seen from the above figure, the pin definition of this instrument is the same as that of the 9-pole connector 

serial interface pin definition used by IMB AT-compatible machines. Users can use a two-core shielded cable to make 

their own three-wire connection cable as shown in the diagram (the length should be less than 1.5 m) or purchase the 

serial interface cable between the computer and the instrument from our company. 

When making your own connecting cable, note that you should short pins 4 and 6 and pins 7 and 8 on the computer 

connector. 

2) Data Formats Sent and Received 

The ST2851 uses a full-duplex asynchronous communication transmission method containing start and stop bits. The 

RS232 data transmission format is: 8-bit (bit) data bits, 1-bit (bit) stop bit, no parity bit (bit), and the terminating character 

is <LF> (line feed character, ASCII code 10). 

3) Select Baud Rate 

The baud rate is the rate at which the ST2851 communicates with the computer; select an appropriate baud rate: 

• 9600 

• 14400 

• 19200 

• 38400 

• 57600 

• 115200 

Note: The default baud rate is 9600 (minimum 9600, maximum 115200; the list does not include all possible baud rates). 

When the user selects the baud rate, first make sure that the programmable controller (generally referred to as a com-

puter) you connect to the ST2851 can support the baud rate you select. 

9.1.3 About the SCPI Commands 

9.1.3.1 Type of Commands 

1) ST2851 Commands 

The ST2851-specific commands include all the measurement functions that the ST2851 has and some general-purpose 

functions. The commands in this group are arranged in a hierarchical structure, which is called the command tree. Each 

command consists of character strings (mnemonics) indicating each hierarchical level and the colon separators between 

the hierarchical levels. 

ST2851 
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2) IEEE Common Commands 

Commands that relate to the generic functions defined in the IEEE 488.2 standard and are commonly available to instru-

ments that support this standard. The commands in this group all begin with an asterisk (*) and the commands in them 

are not arranged in the hierarchical structure. 

9.1.3.2 The Concept of Command Trees 

The commands at the top of the command tree are called "root command" or simply "root". To access lower-level commands 

in the tree, the user specifies a dedicated path in the DOS file system, such as the directory path. When the PC is powered on 

or restarted, the current path is set to the root command. The following describes changing the path setting using special 

characters in the message: 

• End-of-Message Symbol 

The end-of-message symbol, such as the <new line> character sets the current path to the root command. 

• Colon 

A colon between two command mnemonics lowers the level of the current path in the command tree. A colon used as the 

first character of a command specifies the command mnemonic that are located below the root command. 

• Semicolon 

The semicolon does not change the current path but is used to distinguish between two commands in the same message. 

9.1.3.3 Grammar of the Message 

This section describes the grammar for sending program messages over the GPIB. Program messages are messages that the 

user sends from the external controller to the instrument for controlling the instrument. A program message consists of one or 

more commands and their necessary parameters. 

• Program Message End Symbol 

A program message must end with one of the following three program message end symbols: <newline>, <^END> or 

<newline><^END>. <^END> indicates that the EOI on the GPIB interface is activated immediately after the previous data 

byte is sent. For example, the OUTPUT command on HTBasic automatically sends the end-of-message symbol when the 

last data byte has been sent. When programming, use '\n' (0x0a in hex) as the end symbol. 

• Parameters 

A space (ASCII Code: 32) needs to be added between the command and its first parameter. When sending several 

parameters in a single command, each parameter should be separated by a comma. 

• Messages Containing Multiple Commands 

When sending two or more commands in a single message, the commands are separated by a semicolon. 

9.1.4 Programming Examples 

The programming language of the programming example is C#. In the example, command is the command variable to be sent, 

data is the return data variable to be read, SendData is the command send function, and ReadData is the get return data 

function. Users can refer to the example and modify the command according to their actual situation. 

9.1.4.1 Single Point Measurement 

Set the measurement frequency to 1 MHz, the measurement speed to 1, the measurement level to 200 mV, the averaging 

times to 1, the AC range to auto range, the measurement parameters to |Z|,θ z(deg), R, X, trigger one measurement and read 

the measurement data as follows: 
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string command = ":TRIG:SOUR BUS" + '\n'; 

SendData(command); 

command = ":FREQ 1E6;:APER 1;:VOLT 0.2;:AVER:COUN 1;:FUNC:IMP:RANG AUTO" + '\n'; 

SendData(command); 

command = ":FUNC:PAR1:FORM Z; :FUNC:PAR2:FORM TZD; :FUNC:PAR3:FORM R; :FUNC:PAR4:FORM X" + 

'\n'; 

SendData(command); 

Thread.Sleep(100); 

SendData("*TRG" + '\n'); 

string data = ReadData(); 

9.1.4.2 List Measurement 

Set the number of points in the list to 10 and the frequency of each point to 1 MHz, 2 MHz … 10 MHz in that order, followed by 

a trigger signal and read the measurement data: 

string command = ":LIST:TRIG BUS" + '\n'; 

SendData(command); 

command = ":LIST:POIN 10" + '\n'; 

SendData(command); 

command = ""; 

for(int i = 0; i < 10; i++) 

{ 

double freq = 1000000 * (i + 1); 

command += ":LIST:FREQ" + (i + 1) + " " + freq; 

if(i ! = 9) command += ";"; 

else command += '\n'; 

} 

SendData(command); 

Thread.Sleep(100); 

SendData("*TRG" + '\n'); 

string data = ReadData(); 

9.1.4.3 Trace Sweep 

The system is initialized, and then the number of trace points for channel 1 is set to 100, the start frequency to 100 kHz, the 

end frequency to 1 MHz, the measurement speed is 3, and the number of single point averages is 1. Then a measurement is 

triggered, and the R and X values for each measurement point are read after completing one measurement cycle: 

string command = ":SYST:PRES" + '\n'; 

SendData(command); 

Thread.Sleep(500); 
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command = ":TRIG:SOUR BUS" + '\n'; 

SendData(command); 

command = ":SENS1:SWE:POIN 100;:SENS1:APER 3;:INIT1:CONT 1" + '\n'; 

SendData(command); 

Thread.Sleep(50); 

command = ":SENS1:FREQ:STAR 1E5;:SENS1:FREQ:STOP 1E6" + '\n'; 

SendData(command); 

Thread.Sleep(50); 

command = ":TRIG:SING" + '\n';; 

Thread.Sleep(100); 

string data = ""; 

while(data ! = "+1\n") 

{ 

SendData("*OPC?" + '\n'); 

data = ReadData(); 

} 

command = ":CALC1:DATA:RDAT?" + '\n' 

SendData(command);  

data = ReadData(); 

9.1.5 Symbolic Conventions 

This section describes the symbolic conventions of the commands listed in the following chapter and how the command reading 

should be performed. 

9.1.5.1 Command Type 

This section describes the type of command, of which there are three main types: 

• Command/Query 

Can be used to set parameters or to query them. 

• Command 

Only used to set parameters. 

• Query 

Only used to query parameters. 

9.1.5.2 Syntax 

This section describes the syntax used to send commands from the external controller to the ST2851. The syntax consists of 

a command part and a parameter part. These two parts are separated by the space. 

If there are several parameters, a comma is used as a separator between adjacent parameters. Ellipsis (...) between commas 

indicates omitted parameters. 

Example: <number 1>,…, <number 4> denotes four parameters, i.e. <number 1>, <number 2>, <number 3> and <number 4>. 
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String-type parameters, <string>, <string1>, etc. Also, <block> represents data in block format data. 

The user can omit the lowercase letters in syntax. For example, ":BIAS:CURRent" can be shortened as: "BIAS:CURR". 

The definition of the symbols used in the syntax is shown below: 

• The characters in the angle brackets are the necessary parameters for sending the command. 

• [ ] the part in the square brackets can be omitted. 

• { } the characters in the curly brackets indicate that the user must select one of the bracketed characters. Each character 

option is separated by a vertical bar {|}. 

Example: "BIAS:CURR 0.001", ":BIAS:CURRENT:LEVEL 1E-3", etc. can be used in the following syntax: 

BIAS:CURRent[:LEVel] <numeric> 

9.1.5.3 Parameters 

This section describes the necessary parameters when sending the command. When the parameter is a numeric type or string 

type in < >, the allowable value range, the preset (factory-set) value, etc. are given, and when the parameter is a selection type 

in { }, the description of each selection item is given. 

9.1.5.4 Examples 

A brief example is provided to the usage of the command. 

9.1.5.5 Query Response 

This section describes the format of the reading return data when the command contains a query. 

Each parameter that can be read is contained in curly brackets { }, and if the curly brackets contain multiple parameters sepa-

rated by vertical bars (|) at points, only one parameter can be read at a time. 

When several parameters are read, they are separated by a comma (,). An ellipsis (...) between the commas indicates omitted 

parameters. 

Example: <number 1>,…, <number 4> denotes four parameters, i.e. <number 1>, <number 2>, <number 3> and <number 4>. 

<newline><^END> represents the end of the program message. 

9.1.5.6 Related Keys 

This section indicates the operation of the front panel keys and menu buttons that have the same effect as this command. 
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10 Command Reference 

10.1 Commonly Used Standard Commands 

10.1.1 *IDN 

Description: Get product information (manufacturer, model number, product serial number, etc.) of the ST2851. 

Command Type: Query 

Syntax: 

Query Format: *IDN? 

Query Response: {text 1}, {text 2}, {text 3} <newline><^END> 

• Text 1: Manufacturer, the default display is "Sourcetronic GmbH" 

• Text 2: Product name and model number, the default product name is " ST2851" 

• Text 3: Product serial number 

Related Keys: System → Info 

10.1.2 *OPC 

Description: Read "+1" after all operations are complete, otherwise read "0". 

Command Type: Query 

Syntax: 

Query Format: *OPC? 

Query Response: {+1|0} <newline><^END> 

Related Keys: None 

10.1.3 *RST 

Description: Reset the instrument to the factory state, this command is different from the command: SYSTem:PREset. 

Command Type: Command 

Syntax: 

Command Format: *RST 

Related Keys: Preset 

10.1.4 *TRG 

Description: Trigger a measurement. When the current measurement mode is point measurement or list sweep, the meas-

urement result will be returned at the end of the measurement; when the current measurement is sweep mode, the trigger 

source is required to be set to Bus. 
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Command Type: Command 

Syntax: 

Command Format: *TRG 

Related Keys: Trigger 

10.2 Public Commands 

Public commands can be responded to at all measurement interfaces. 

10.2.1 Correction 

10.2.1.1 :CORR:CLE 

Description: Initialize data for all user calibration points. 

Command Type: Command 

Syntax: 

Command Format: :CORRection:CLEar 

10.2.1.2 :CORR:LOAD 

Description: Perform load calibration for all frequency points. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:LOAD[:EXECute] 

Related Keys: Cal → Load → All Frequency Load 

10.2.1.3 :CORR:LOAD:{R|C|L} 

Description: Set and query the resistance/capacitance/inductance setting value of the load calibration. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:LOAD: {R|C|L} <number> 

Query Format: [:SENSe]:CORRection:LOAD: {R|C|L}? 

Query Response: {<number>} <newline><^END> 

Related Keys: Cal → Load → Load Resistance / Load Capacitance / Load Inductor 

10.2.1.4 :CORR:LOAD:STAT 

Description: Set and query the ON/OFF status of the user load calibration. 

Command Type: Command/Query 
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Syntax: 

Command Format: [:SENSe]:CORRection:LOAD:STATe {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection:LOAD:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn ON the load calibration… 

Command: :CORR:LOAD:STAT ON 

Example: To query the load calibration ON/OFF status… 

Query: :CORR:LOAD:STAT? 

Related Keys: Cal → Load 

10.2.1.5 :CORR:LOAD:TYPE 

Description: Set and query the parameters used for load calibration. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:LOAD:TYPE 

{RX|CPD|CPQ|CPG|CPRP|CSD|CSQ|CSRS|LPD|LPQ|LPG|LPRP|LSD|LSQ|LSRS|ZT

D|ZTR|GB|YTD|YTR} 

Query Format: [:SENSe]:CORRection:LOAD:TYPE? 

Query Response: {RX|CPD|CPQ|CPG|CPRP|CSD|CSQ|CSRS|LPD|LPQ|LPG|LPRP|LSD|LSQ|LSRS 

|ZTD|ZTR|GB|YTD|YTR}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: RX = R-X 

 CPD = Cp-D 

 CPQ = Cp-Q 

 CPG = Cp-G 

 CPRP = Cp-Rp 

 CSD = Cs-D 

 CSQ = Cs-Q 

 CSRS = Cs-Rs 

 LPD = Lp-D 

 LPQ = Lp-Q 

 LPG = Lp-G 

 LPRP = Lp-Rp 
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 LSD = Ls-D 

 LSQ = Ls-Q 

 LSRS = Ls-Rs 

 ZTD = |Z|-θz (deg) 

 ZTR = |Z|-θz (rad) 

 GB = G-B 

 YTD = |Y|-θy (deg) 

 YTR = |Y|-θy (rad) 

Preset Value: RX 

Example: To set the load calibration parameter to Cp-D… 

Command: :CORR:LOAD:TYPE CPD 

Example: To query the load calibration parameter… 

Query: :CORR:LOAD:TYPE? 

Related Keys: Cal → Load Type 

10.2.1.6 :CORR:OPEN 

Description: Open clear for all frequency points. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:OPEN[:EXECute] 

Related Keys: Cal → Open → All Frequency Clear 

10.2.1.7 :CORR:OPEN:STAT 

Description: Set and query the ON/OFF status of the user open calibration. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:OPEN:STATe {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection:OPEN:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the open calibration… 

Command: :CORR:OPEN:STAT ON 
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Example: To query the open calibration open state… 

Query: :CORR:OPEN:STAT? 

Related Keys: Cal → Open 

10.2.1.8 :CORR:SHOR 

Description: Short clear for all frequency points. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:SHORt[:EXECute] 

Related Keys: Cal → Short → All Frequency Clear 

10.2.1.9 :CORR:SHOR:STAT 

Description: Set and query the ON/OFF status of the user short calibration. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:SHORt:STATe {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection:SHORt:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the short calibration… 

Command: :CORR:SHOR:STAT ON 

Example: To query the short calibration open state… 

Query: :CORR:SHOR:STAT? 

Related Keys: Cal → Short 

10.2.1.10 :CORR:SPOT{1-20}:FREQ 

Description: Query and set the frequency of the specified user calibration point. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:SPOT{1-20}:FREQ <number> 
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Query Format: [:SENSe]:CORRection:SPOT{1-20}:FREQ? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 10 ~ 130M 

Preset Value: 1000 

Unit: Hz 

Example: To set the frequency of point 1 to 1MHz… 

Command: :CORR:SPOT1:FREQ 1M 

Example: To query the frequency of point 2… 

Query: :CORR:SPOT2:FREQ? 

10.2.1.11 :CORR:SPOT{1-20}:LOAD 

Description: Perform the load calibration for the specified user calibration point. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:SPOT{1-20}:LOAD[:EXECute] 

10.2.1.12 :CORR:SPOT{1-20}:LOAD:STAN 

Description: Set and query the load reference value of the specified user calibration point. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:SPOT{1-20}:LOAD:STANdard <number1>,<number2> 

Query Format: [:SENSe]:CORRection:SPOT{1-20}:LOAD:STANdard? 

Query Response: {<number1>, <number2>}<newline><^END> 

Parameters: 

Description: Load Reference Value 1 (number 1) 

 Load Reference Value 2 (number 2) 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on load parameter settings  

Example: To set the load reference value of point 1… 

Command: :CORR:SPOT1:LOAD:STAN 1E6,1E6 
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Example: To query the load reference value of point 2… 

Query: :CORR:SPOT2:LOAD:STAN? 

The parameters of the return value depend on the set load parameters. 

10.2.1.13 :CORR:SPOT{1-20}:OPEN 

Description: Perform open circuit clear for the specified user calibration point. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:SPOT{1-20}:OPEN[:EXECute] 

10.2.1.14 :CORR:SPOT{1-20}:SHOR 

Description: Perform short circuit clear for the specified user calibration point. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:SPOT{1-20}:SHORt[:EXECute] 

10.2.1.15 :CORR:SPOT{1-20}:STAT 

Description: Set and query the ON/OFF status of the specified user calibration point. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection:SPOT{1-20}:STATe {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection:SPOT{1-20}:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on point 1… 

Command: :CORR:SPOT1:STAT ON 

Example: To query the ON/OFF status of point 2… 

Query: :CORR:SPOT2:STAT? 
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10.2.1.16 :CORR:USE:DATA? 

Description: Query the calibration data of all user calibration points. 

Command Type: Query 

Syntax: 

Query Format: [:SENSe]:CORRection:USE:DATA? 

Query Response: {<number 1>},{<number 1>},...,{<number 120>}<newline><^END> 

A total of 20 user calibration points is returned for a total of 120 data, in the order of open circuit calibration data G, open circuit 

calibration data Cp, short circuit calibration data R, short circuit calibration data Ls, load calibration data 1, load calibration 

data 2. The type of load calibration data depends on the parameters that have been set for the load calibration. 

10.2.1.17 :CORR2:COLL:ACQ:LOAD 

Description: Perform load calibration for all frequency points. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:COLLect:ACQuire:LOAD 

Related Keys: Cal → Load → All Frequency Load 

10.2.1.18 :CORR2:COLL:ACQ:OPEN 

Description: Perform open circuit clear for all frequency points. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:COLLect:ACQuire:OPEN 

Related Keys: Cal → Open → All Frequency Clear 

10.2.1.19 :CORR2:COLL:ACQ:SHOR 

Description: Perform short circuit clear for all frequency points. 

Command Type: Command 

Syntax: 

Command Format: [:SENSe]:CORRection:COLLect:ACQuire:SHORt 

Related Keys: Cal → Short → All Frequency Clear 

10.2.1.20 :CORR2:LOAD 

Description: Set and query the ON/OFF status of the user load calibration. 

Command Type: Command/Query 
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Syntax: 

Command Format: [:SENSe]:CORRection2:LOAD {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection2:LOAD? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the load calibration… 

Command: :CORR2:LOAD ON 

Example: To query the load calibration open state… 

Query: :CORR2:LOAD? 

Related Keys: Cal → Load 

10.2.1.21 :CORR2:OPEN 

Description: Set and query the ON/OFF status of the user open calibration. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection2:OPEN {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection2:OPEN? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the open calibration… 

Command: :CORR2:OPEN ON 

Example: To query the open calibration open state… 

Query: :CORR2:OPEN? 

Related Keys: Cal → Open 
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10.2.1.22 :CORR2:SHOR 

Description: Set and query the ON/OFF status of the user short calibration. 

Command Type: Command/Query 

Syntax: 

Command Format: [:SENSe]:CORRection2:SHORt {ON|OFF|1|0} 

Query Format: [:SENSe]:CORRection2:SHORt? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the short calibration… 

Command: :CORR2:SHOR ON 

Example: To query the short calibration open state: 

Query: :CORR2:SHOR? 

Related Keys: Cal → Short 

10.2.2 Display 

10.2.2.1 :DISP:CCL 

Description: Clear the warning message at the bottom of the screen. 

Command Type: Command 

Syntax: 

Command Format: :DISPlay:CCLear 

10.2.3 System 

10.2.3.1 :SYST:KLOC:KBD 

Description: Set and query whether the front panel is disabled. 

Command Type: Command/Query 

Syntax: 

Command Format: :SYSTem:KLOCk:KBD {ON|OFF|1|0} 

Query Format: :SYSTem:KLOCk:KBD? 

Query Response: {1|0}<newline><^END> 
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Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To lock the front panel… 

Command: :SYST:KLOC:KBD ON 

Example: To query the front panel lock state… 

Query: :SYST:KLOC:KBD? 

Related Keys: System → Misc Setup → Key Lock → Front Panel Lock 

10.2.3.2 :SYST:KLOC:MOUS 

Description: Set and query whether the touch screen is disabled. 

Command Type: Command/Query 

Syntax: 

Command Format: :SYSTem:KLOCk:MOUSe {ON|OFF|1|0} 

Query Format: :SYSTem:KLOCk:MOUSe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To lock the touch screen… 

Command: :SYST:KLOC:MOUS ON 

Example: To query the touch screen lock state… 

Query: :SYST:KLOC:MOUS? 

Related Keys: System → Misc Setup → Key Lock → Screen Lock 

10.2.3.3 :SYST:POFF 

Description: Turn off the ST2851 program. 

Command Type: Command 

Syntax: 

Command Format: :SYSTem:POFF 

Related Keys: System → Exit Application 
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10.2.3.4 :SYST:PRES 

Description: When the current measurement is in sweep mode, preset the ST2851 to the factory setting state, at this time the 

command differs from *RST in that the trigger mode of channel 1 will be set to continuous mode automatically after the com-

pletion; when the current measurement is point measurement or list measurement, restore the instrument to the factory setting 

and return to the main page of point measurement. 

Command Type: Command 

Syntax: 

Command Format: :SYSTem:PRESet 

10.2.3.5 :SYST:UPR 

Description: Reset the ST2851 to the user settings, or return an error if the user settings file does not exist. 

Command Type: Command 

Syntax: 

Command Format: :SYSTem:UReset 

10.3 Point Measurement and List Command 

This section introduces the commands for point measurement and List sweep. Only if the current page belongs to point meas-

urement or list sweep (or its related setup screen), inputting commands in this section will take effect 

10.3.1 Amplitude 

10.3.1.1 :AMPL:ALC 

Description: Set and query the ALC (Automatic Level Control) state of the point measurement. 

Command Type: Command/Query 

Syntax: 

Command Format: :AMPLitude:ALC {ON|OFF|1|0} 

Query Format: :AMPLitude:ALC? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the ALC to ON… 

Command: :AMPL:ALC ON 
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Example: To query the ALC state… 

Query: :AMPL:ALC? 

Related Keys: Meas Setup → OSC Level → ALC → ALC Control 

10.3.2 Aperture 

10.3.2.1 :APER 

Description: Set and query the point measurement speed. 

Command Type: Command/Query 

Syntax: 

Command Format: :APERture {1|2|3|4|5} 

Query Format: :APERture? 

Query Response: {1|2|3|4|5}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 5 

Preset Value: 3 

Example: To set the measurement speed to 1… 

Command: :APER 1 

Example: To query the point measurement speed… 

Query: :APER? 

Related Keys: Meas Setup → Meas Time 

10.3.3 Average 

10.3.3.1 :AVER:COUN 

Description: Set and query the point averaging count. 

Command Type: Command/Query 

Syntax: 

Command Format: :AVERage:COUNt <number> 

Query Format: :AVERage:COUNt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 999 
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Preset Value: 1 

Example: To set the averaging factor to 5… 

Command: :AVER:COUN 5 

Example: To query the averaging factor… 

Query: :AVER:COUN? 

Related Keys: Meas Setup → Avg Count 

10.3.4 Bias 

10.3.4.1 :BIAS:CURR 

Description: Set and query the DC bias current. The setting does not mean that the DC bias is turned on. 

Command Type: Command/Query 

Syntax: 

Command Format: :BIAS:CURRent <number> 

Query Format: :BIAS:CURRent? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -0.1 ~ 0.1 

Unit: A 

Preset Value: 0 

Example: To set the bias current to 0.1 A… 

Command: :BIAS:CURR 0.1 

Example: To query the bias current… 

Query: :BIAS:CURR? 

Related Keys: Meas Setup → DC Bias → Current Level 

10.3.4.2 :BIAS:MODE 

Description: Set and query the point DC bias mode. The setting does not mean that the DC bias is turned on. 

Command Type: Command/Query 

Syntax: 

Command Format: :BIAS:MODE {VOLTage|CURRent} 

Query Format: :BIAS:MODE? 

Query Response: {VOLT|CURR}<newline><^END> 
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Parameters: 

Data Type: String 

Data Range: VOLT = Voltage Mode 

 CURR = Current Mode 

Preset Value: VOLT 

Example: To set the DC bias mode to voltage mode… 

Command: :BIAS:MODE VOLT 

Example: To query the DC bias mode… 

Query: :BIAS:MODE? 

Related Keys: Meas Setup → DC Bias → DC Bias Mode 

10.3.4.3 :BIAS:RANG 

Description: Set and query the DC bias range. The setting does not mean that the DC bias is turned on. 

Command Type: Command/Query 

Syntax: 

Command Format: :BIAS:RANGe {M1|M10|M100} 

Query Format: :BIAS:RANGe? 

Query Response: {M1|M10|M100}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: M1 = 1 mA 

 M10 = 10 mA 

 M100 = 100 mA 

Preset Value: M1 

Example: To set the DC bias range to 1 mA… 

Command: :BIAS:RANG M1 

Example: To query the DC bias range… 

Query: :BIAS:RANG? 

Related Keys: Meas Setup → DC Bias → Meas Data Range 

10.3.4.4 :BIAS:STAT 

Description: Set and query the ON/OFF status of the DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :BIAS:STATe {ON|OFF|1|0} 
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Query Format: :BIAS:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the DC bias… 

Command: :BIAS:STAT ON 

Example: To query the ON/OFF status of the DC bias… 

Query: :BIAS:STAT? 

Related Keys: Meas Setup → DC Bias → DC Bias State 

10.3.4.5 :BIAS:VOLT 

Description: Set and query the DC bias voltage. The setting does not mean that the DC bias is turned on. 

Command Type: Command/Query 

Syntax: 

Command Format: :BIAS:VOLTage <number> 

Query Format: :BIAS:VOLTage? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -40 ~ 40 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage to 1 V… 

Command: :BIAS:VOLT 1 

Example: To query the bias voltage… 

Query: :BIAS:VOLT? 

Related Keys: Meas Setup → DC Bias → Voltage Level 
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10.3.5 Comparator 

10.3.5.1 :COMP 

Description: Set and query the point comparator ON/OFF status. 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator[:STATe] {ON|OFF|1|0} 

Query Format: :COMParator[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the point measurement comparator… 

Command: :COMP ON 

Example: To query the status of the point measurement comparator… 

Query: :COMP? 

Related Keys: Comparator → Comparator State 

10.3.5.2 :COMP:BIN{1-9} 

Description: Set and query the BIN (1 ~ 9) state in the point comparator. 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:BIN{1-9} [:STATe] {ON|OFF|1|0} 

Query Format: :COMParator:BIN{1-9} [:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on BIN1… 

Command: :COMP:BIN1 ON 
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Example: To query the BIN2 ON/OFF status… 

Query: :COMP:BIN2? 

Related Keys: Comparator → Edit Comptr Table → BIN → State 

10.3.5.3 :COMP:BIN{1-9}:COND{1-4}:LIM 

Description: Set and query the limit line of each BIN table condition (1 ~ 4) of each BIN (1 ~ 9) in the point comparator. The 

limit line contains upper and lower limit values. 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:BIN{1-9}:CONDition{1|2|3|4}:LIMit <number1>,<number2> 

Query Format: :COMParator:BIN{1-9}:CONDition{1|2|3|4}:LIMit? 

Query Response: {<number1>}, {<number2>}<newline><^END> 

Parameters: 

Description: Lower Limit Value (number 1) 

 Upper Limit Value (number 2) 

Data Type: Double 

Data Range: -1E9 ~ 1E9 

Preset Value: 0 

Unit: Depends on BIN parameters 

Example: To set the upper limit of BIN1 condition 1 to 2k and the lower limit to 1k… 

Command: :COMP:BIN1:COND1:LIM 1E3,2E3 

Example: To query the upper and lower limits of BIN2 condition 2… 

Query: :COMP:BIN2:COND2:LIM? 

Related Keys: Comparator → Edit Comptr Table → BIN → Upper / Lower 

10.3.5.4 :COMP:BIN{1-9}:COND{1-4}:LTYP 

Description: Set and query the limit line type of each BIN table condition (1 ~ 4) of each BIN (1 ~ 9) in the point comparator. 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:BIN{1-9}:CONDition{1|2|3|4}:LTYPe {IN|OUT|ALL} 

Query Format: :COMParator:BIN{1-9}:CONDition{1|2|3|4}:LTYPe? 

Query Response: {IN|OUT|ALL}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: IN 
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 OUT 

 ALL 

Preset Value: ALL 

Example: To set the limit line type of BIN1 condition 1 to IN… 

Command: :COMP:BIN1:COND1:LTYP IN 

Example: To query the limit line type of BIN2 condition 2… 

Query: :COMP:BIN2:COND2:LTYP? 

Related Keys: Comparator → Edit Comptr Table → BIN → In/Out 

10.3.5.5 :COMP:CLE 

Description: Restore all point measurement comparator table to their initial values. 

Command Type: Command 

Syntax: 

Command Format: :COMParator:CLEar 

Related Keys: Comparator → Edit Comptr Table → All Tables → Clear All 

10.3.5.6 :COMP:COND{1-4}:MODE 

Description: Set and query the data math of the point measurement comparator table condition (1 ~ 4). 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:CONDition{1|2|3|4}:MODE {OFF|DEV|PCNT|PDEV} 

Query Format: :COMParator:CONDition{1|2|3|4}:MODE? 

Query Response: {OFF|DEV|PCNT|PDEV}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: OFF 

 DEV = Deviation 

 PCNT = Percent 

 PDEV = Deviation Percent 

Preset Value: OFF 

Example: To set the data math of condition 1 to Deviation… 

Command: :COMP:COND1:MODE DEV 

Example: To query the data math of condition 2… 

Query: :COMP:COND2:MODE? 

Related Keys: Comparator → Edit Comptr Table → Mode 
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10.3.5.7 :COMP:COND{1-4}:NOM 

Description: Set and query the reference value of the point measurement comparator table condition (1 ~ 4). 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:CONDition{1|2|3|4}:NOMinal <number> 

Query Format: :COMParator:CONDition{1|2|3|4}:NOMinal? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E9 ~ 1E9 

Preset Value: 0 

Example: To set the reference value of condition 1 to 1000… 

Command: :COMP:COND1:NOM 1E3 

Example: To query the reference value of condition 2… 

Query: :COMP:COND2:NOM? 

Related Keys: Comparator → Edit Comptr Table → Reference 

10.3.5.8 :COMP:COND{1-4}:PAR 

Description: Set and query the measurement parameters of the point measurement comparator table condition (1 ~ 4). 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:CONDition{1|2|3|4}:PARameter{Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP| 

CS|CP|R|G|X|B|Q|D} 

Query Format: :COMParator:CONDition{1|2|3|4}:PARameter? 

Query Response: {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: Z = |Z| 

 Y = |Y| 

 TZR = θz (rad) 

 TZD = θz (deg) 

 TYR = θy (rad) 

 TYD = θy (deg) 

 RS = Rs 

 RP = Rp 

 LS = Ls 

 LP = Lp 
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 CS = Cs 

 CP = Cp 

 R = R 

 G = G 

 X = X 

 B = B 

 Q = Q 

 D = D 

Preset Value: Z 

Example: To set the parameters of condition 1 to R… 

Command: :COMP:COND1:PAR R 

Example: To query the parameters of condition 2: 

Query: :COMP:COND2:PAR? 

Related Keys: Comparator → Edit Comptr Table → Parameter Type 

10.3.5.9 :COMP:COND{1-4}:SW 

Description: Set and query the ON/OFF status of the point measurement comparator table condition (1 ~ 4). 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:CONDition{1|2|3|4}:SWitch {ON|OFF|1|0} 

Query Format: :COMParator:CONDition{1|2|3|4}: SWitch? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the setting conditon 1… 

Command: :COMP:COND1:SW ON 

Example: To query the ON/OFF status of the setting condition 2… 

Query: :COMP:COND2:SW? 

Related Keys: Comparator → Edit Comptr Table → State 

10.3.5.10 :COMP:COUN 

Description: Set and query the ON/OFF status of the point measurement comparator count. 

Command Type: Command/Query 
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Syntax: 

Command Format: :COMParator:COUNt[:STATe] {ON|OFF|1|0} 

Query Format: :COMParator:COUNt[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the comparator count… 

Command: :COMP:COUN ON 

Example: To query the ON/OFF status of the comparator count… 

Query: :COMP:COUN? 

Related Keys: Comparator → BIN Count 

10.3.5.11 :COMP:COUN:CLE 

Description: Clear the current point measurement comparator count. 

Command Type: Command 

Syntax: 

Command Format: :COMParator:COUNt:CLEar 

Related Keys: Comparator → Clear BIN Count 

10.3.5.12 :COMP:DATA:BCO 

Description: Query each BIN count of the comparator in the point measurement. 

Command Type: Query 

Syntax: 

Query Format: :COMParator:DATA:BCOunt? 

Query Response: {<number 1>}, {<number 2>},{<number 3>}, {<number 4>},{<number 5>}, {<number 

6>},{<number 7>}, {<number 8>},{<number 9>}, {<number 10>}<newline><^END> 

Number 1 to number 9 represent the BIN count of the BIN 1 ~ BIN 9, and the number 10 represents counts that failed to be 

sorted into any BIN (Out of Good). 

10.3.5.13 :COMP:DATA:BIN 

Description: Query the most recent BIN result. 

Command Type: Query 
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Syntax: 

Query Format: :COMParator:DATA:BIN? 

Query Response: {0|1|2|3|4|5|6|7|8|9|10}<newline><^END> 

In the command, 0 indicates that the BIN cannot be sorted into any BIN, 1-9 indicates the corresponding bin sequence number, 

and 10 indicates the bin failure caused by measurement errors (usually Overload). 

10.3.5.14 :COMP:OGB 

Description: Set and query the number of qualified BINs of the point measurement comparator. 

Command Type: Command/Query 

Syntax: 

Command Format: :COMParator:OGBINs <number> 

Query Format: :COMParator:OGBINs? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 9 

Preset Value: 9 

Example: To set the BIN 1 ~ BIN 3 as qualified BINs… 

Command: :COMP:OGB 3 

Example: To query the number of qualified BINs… 

Query: :COMP:OGB? 

Related Keys: Comparator → Edit Comptr Table → Good BINs 

10.3.6 Current 

10.3.6.1 :CURR 

Description: Set and query the current of the point measurement signal source and set the level mode to current mode auto-

matically after setting the current. 

Command Type: Command/Query 

Syntax: 

Command Format: :CURRent <number> 

Query Format: :CURRent? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 
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Data Range: 0.0002 ~ 0.02 

Preset Value: 0.02 

Unit: A 

Example: To set the current to 10 mA… 

Command: :CURR 0.01 

Example: To query the current value… 

Query: :CURR? 

Related Keys: Meas Setup → OSC Level → Current Level 

10.3.7 Display 

10.3.7.1 :DISP:PAGE 

Description: Open the specified page, or query the currently displayed page. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:PAGE {MEASurement|LIST|STIMulus|SWEEp|CAL|COMParator|PoinTCOm-

parator} 

Query Format: :DISPlay:PAGE? 

Query Response: {MEAS|LIST|STIM|SWEE|CAL|COMP|PTCO}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: MEASurement = Point Measurement Interface 

 LIST = List Measurement Interface 

 STIMulus = Stimulus Interface 

 SWEEp = Sweep Measurement Interface 

 CAL = User Calibration Interface 

 COMParator = Comparator Interface 

 PoinTCOmparator = Point Measurement Comparator Interface 

Example: To open the list measurement interface… 

Command: :DISP:PAGE LIST 

Example: To query the currently opened page… 

Query: :DISP:PAGE? 
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10.3.8 Fetch 

10.3.8.1 :FETC 

Description: Query the current measurement results of the point measurement/list sweep. 

Command Type: Query 

Syntax: 

Query Format: :FETCh[:IMPedance]? 

Query Response: Point: {<number1>},{<number2>},{<number3>},{<number 4>},{1|0},{0|1|2|3|4|5|6|7|8|9|10} 

<newline> <^END> 

 List: {<point 1 parameter 1>},{<point 1 parameter 2>},{<point 1 parameter 3>},{<point 1 

parameter 4>},..., {<point n parameter 1>},{<point n parameter 2>},{<point n parameter 

3>},{<point n parameter 4>},{1|0},{0|1 ~ 5|6|7|8|9|10}<newline><^END> 

In the response to the point measurement, number 1 ~ 4 are the measured values of the 4 parameters of the current page. 

In the response to the list sweep, n is the number of measurement points in the list, and the first 4 × n numbers are the 4 

parameter measurements of the n points. 

In the point measurement and list sweep, if the measurement error (overload) occurs, next implies the value of 1, otherwise 0. 

If the comparator is turned on, the last digit is the BIN result, 10 (list sweep is 16) indicates that the BIN cannot be sorted into 

any BIN, 1 ~ 9 (list is 1 ~ 15) indicate the corresponding BIN sequence number, -1 indicates that the BIN is failed due to the 

measurement error (usually overload will appear) 

10.3.8.2 :FETC:CORR 

Description: Query the point measurement/list sweep corrected measurements (R-X). 

Command Type: Query 

Syntax: 

Query Format: :FETCh[:IMPedance]:CORRected? 

Query Response: Point: {<number>},{<number2>}<newline><^END> 

 List: {<point 1R value>}, {<point 1X value>},..., {<point nR value>}, {<point nX value>} 

<newline><^END> 

In the response to the point measurement, number 1 is the R value and number 2 is the X value. 

In the response to the list sweep, n is the number of measurement points in the list, and the parameters of the response are 

the R and X values of each point in turn. 

10.3.8.3 :FETC:SMON:IAC 

Description: Query the measurement data of AC current monitoring in point measurement/list sweep. 

Command Type: Query 

Syntax: 

Query Format: :FETCh:SMONitor:IAC? 

Query Response: {<number>}<newline><^END> 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 128 

10.3.8.4 :FETC:SMON:IDC 

Description: Query the measurement data of DC current monitoring in point measurement/list sweep. 

Command Type: Query 

Syntax: 

Query Format: :FETCh:SMONitor:IDC? 

Query Response: {<number>}<newline><^END> 

10.3.8.5 :FETC:SMON:VAC 

Description: Query the measurement data of AC voltage monitoring in point measurement/list sweep. 

Command Type: Query 

Syntax: 

Query Format: :FETCh:SMONitor:VAC? 

Query Response: {<number>}<newline><^END> 

10.3.8.6 :FETC:SMON:VDC 

Description: Query the measurement data of DC voltage monitoring in point measurement/list sweep. 

Command Type: Query 

Syntax: 

Query Format: :FETCh:SMONitor:VDC? 

Query Response: {<number>}<newline><^END> 

10.3.9 Frequency 

10.3.9.1 :FREQ 

Description: Set and query the frequency of the point measurement. 

Command Type: Command/Query 

Syntax: 

Command Format: :FREQuency <number> 

Query Format: :FREQuency? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 10 ~ 130M 

Preset Value: 1000 

Unit: Hz 
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Example: To set the frequency to 1 MHz… 

Command: :FREQ 1E6 

Example: To query the current measurement frequency… 

Query: :FREQ? 

Related Keys: Meas Setup → Frequency 

10.3.10 Function 

10.3.10.1 :FUNC:DEV{1-4}:MODE 

Description: Set and query the math mode of the selected measurement parameter. 

Command Type: Command/Query 

Syntax: 

Command Format: :FUNCtion:DEV{1|2|3|4}:MODE {OFF|ABSolute|PERCent} 

Query Format: :FUNCtion:DEV{1|2|3|4}:MODE? 

Query Response: {OFF|ABS|PERC }<newline><^END> 

Parameters: 

Data Type: String 

Data Range: OFF 

 ABSolute = Deviation Mode 

 PERCent = Deviation Percent Mode 

Preset Value: OFF 

Example: To set the math mode of parameter 1 to the deviation mode… 

Command: :FUNC:DEV1:MODE ABS 

Example: To query the math mode of parameter 2… 

Query: :FUNC:DEV1:MODE? 

Related Keys: Display → Parameter Type → Math Mode 

10.3.10.2 :FUNC:DEV{1-4}:REF 

Description: Set and query the reference value of the selected measurement parameter. 

Command Type: Command/Query 

Syntax: 

Command Format: :FUNCtion:DEV{1|2|3|4}:REFerence <number> 

Query Format: :FUNCtion:DEV{1|2|3|4}:REFerence? 

Query Response: {<number>}<newline><^END> 
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Parameters: 

Data Type: Double 

Data Range: -1E9 ~ 1E9 

Preset Value: 0 

Unit: Depends on measurement parameters 

Example: To set the reference value of parameter 1 to 1000… 

Command: :FUNC:DEV1:REF 1E3 

Example: To query the reference value of parameter 2… 

Query: :FUNC:DEV1:REF? 

Related Keys: Display → Parameter Type → Reference 

10.3.10.3 :FUNC:IMP:RANG 

Description: Set and query the AC range of the point measurement. 

Command Type: Command/Query 

Syntax: 

Command Format: :FUNCtion:IMPedance:RANGe {AUTO|50|500|5K|50K} 

Query Format: :FUNCtion:IMPedance:RANGe? 

Query Response: {AUTO|50|500|5K|50K}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: AUTO 

 50 = 50 Ω 

 500 = 500 Ω 

 5K = 5 kΩ 

 50K = 50 kΩ 

Preset Value: AUTO 

Example: To set the AC range to AUTO… 

Command: :FUNC:IMP:RANG AUTO 

Example: To query the current AC range… 

Query: :FUNC:IMP:RANG? 

Related Keys: Meas Setup → ACData Range 

10.3.10.4 :FUNC:PAR{1-4}:FORM 

Description: Set and query the parameter name of the selected measurement parameter. 

Command Type: Command/Query 
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Syntax: 

Command Format: :FUNCtion:PARamater{1|2|3|4}:FORMat {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP| 

R|G|X|B|Q|D} 

Query Format: :FUNCtion:PARamater{1|2|3|4}:FORMat? 

Query Response: {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D|ER|ER1|ER2|U1|U2|TAN} 

<newline><^END> 

Parameters: 

Data Type: String 

Data Range: Z = |Z| 

 Y = |Y| 

 TZR = θz (rad) 

 TZD = θz (deg) 

 TYR = θy (rad) 

 TYD = θy (deg) 

 RS = Rs 

 RP = Rp 

 LS = Ls 

 LP = Lp 

 CS = Cs 

 CP = Cp 

 R = R 

 G = G 

 X = X 

 B = B 

 Q = Q 

 D = D 

 DCR = DCR 

 ER = |εr| (requires permittivity module support) 

 ER1 = εr' (requires permittivity module support) 

 ER1 = εr'' (requires permittivity module support) 

 U1 = μ' (requires troidalcore module support) 

 U2 = μ'' (requires troidalcore module support) 

 TAN = tan δ (requires troidalcore module support) 

Preset Value: Z 

Example: To set the parameter 1 to |Z|… 

Command: :FUNC:PAR1:FORM Z 

Example: To query the parameter name of parameter 2… 

Query: :FUNC:PAR2:FORM? 

Related Keys: Display → Parameter Type → Parameter Type 
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10.3.10.5 :FUNC:SMON:{IAC|VAC} 

Description: Set and query the ON/OFF status of AC monitor. When it is off, the DC monitor will be on. 

Command Type: Command/Query 

Syntax: 

Command Format: :FUNCtion:SMONitor:{IAC|VAC} {ON|OFF|1|0} 

Query Format: :FUNCtion:SMONitor:{IAC|VAC}? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the AC monitor… 

Command: :FUNC:SMON:IAC ON 

Example: To query the ON/OFF status of the AC monitor… 

Query: :FUNC:SMON:IAC? 

Related Keys: Meas Setup → AC/DC Monitor 

10.3.10.6 :FUNC:SMON:{IDC|VDC} 

Description: Set and query the ON/OFF status of DC monitor. When it is off, the AC monitor will be on. 

Command Type: Command/Query 

Syntax: 

Command Format: :FUNCtion:SMONitor:{IDC|VDC} {ON|OFF|1|0} 

Query Format: :FUNCtion:SMONitor:{IDC|VDC}? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the DC monitor… 

Command: :FUNC:SMON:IDC ON 

Example: To query the ON/OFF status of the DC monitor… 

Query: :FUNC:SMON:IDC? 

Related Keys: Meas Setup → AC/DC Monitor 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 133 

10.3.11 Initiation 

10.3.11.1 :INIT 

Description: Set the trigger mode to internal trigger. 

Command Type: Command 

Syntax: 

Command Format: :INITiate 

10.3.11.2 :INIT:CONT 

Description: Set the trigger mode to internal trigger, query whether the current trigger mode is internal trigger. 

Command Type: Command/Query 

Syntax: 

Command Format: :INITiate:CONTinuos {ON|OFF|1|0} 

Query Format: :INITiate:CONTinuos? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the point measurement trigger mode to internal trigger… 

Command: :INIT:CONT ON 

Example: To query whether it is internal trigger… 

Query: :INIT:CONT? 

10.3.12 List 

10.3.12.1 :LIST:APER 

Description: Set and query the measurement time of the list sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:APERture {1|2|3|4|5} 

Query Format: :LIST:APERture? 

Query Response: {1|2|3|4|5}<newline><^END> 

Parameters: 

Data Type: Integer 
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Data Range: 1 ~ 5 

Preset Value: 1 

Example: To set the measurement time to 2… 

Command: :LIST:APER 2 

Example: To query the list measurement time… 

Query: :LIST:APER? 

Related Keys: Meas Setup → Meas Time 

10.3.12.2 :LIST:BIAS:CURR 

Description: Set and query the DC bias current of the selected measurement point in the list sweep. The setting does not 

mean that the DC bias is switched on. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:BIAS:CURRent[point number] <number> 

Query Format: :LIST:BIAS:CURRent[point serial number]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -0.1 ~ 0.1 

Preset Value: 0 

Unit: A 

Example: To set the bias current of the 10th point to 0.1 A… 

Command: :LIST:BIAS:CURR10 0.1 

Example: To query the bias current of the 20th point… 

Query: :LIST:BIAS:CURR20? 

Related Keys: Stim Table → DC Bias 

10.3.12.3 :LIST:BIAS:MODE 

Description: Set and query the DC bias mode of the selected measurement point in the list sweep. The setting does not mean 

that the DC bias is switched on. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:BIAS:MODE[point serial number] {VOLTage|CURRent} 

Query Format: :LIST:BIAS:MODE[point serial number]? 

Query Response: {VOLT|CURR}<newline><^END> 
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Parameters: 

Data Type: String 

Data Range: VOLT = Voltage Mode 

 CURR = Current Mode 

Preset Value: VOLT 

Example: To set the DC bias mode of the 10th point to voltage mode… 

Command: :LIST:BIAS:MODE10 VOLT 

Example: To query the DC bias mode of the 20th point… 

Query: :LIST:BIAS:MODE20? 

Related Keys: Stim Table → Bias Mode 

10.3.12.4 :LIST:BIAS:RANG 

Description: Set and query the DC bias range of the selected measurement point in the list sweep. The setting does not mean 

that the DC bias is switched on. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:BIAS:RANGe[point serial number] {M1|M10|M100} 

Query Format: :LIST:BIAS:RANGe[point serial number]? 

Query Response: {M1|M10|M100}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: M1 = 1 mA 

 M10 = 10 mA 

 M100 = 100 mA 

Preset Value: M1 

Example: To set the DC bias range of the 10th point to 1 mA… 

Command: :LIST:BIAS:RANG10 M1 

Example: To query the DC bias current of the 20th point… 

Query: :LIST:BIAS:RANG20? 

Related Keys: Stim Table → Meas Data Range 

10.3.12.5 :LIST:BIAS:STAT 

Description: Set and query the ON/OFF status of the DC bias of the selected measurement point in the list sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:BIAS:STATe[point] {ON|OFF|1|0} 
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Query Format: :LIST:BIAS:STATe[point]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the DC bias of the 10th point… 

Command: :LIST:BIAS:STAT10 ON 

Example: To query the DC bias state of the 20th point… 

Query: :LIST:BIAS:STAT20? 

Related Keys: Stim Table → Bias State 

10.3.12.6 :LIST:BIAS:VOLT 

Description: Set and query the DC bias voltage of the selected measurement point in the list sweep. The setting does not 

mean that the DC bias is switched on. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:BIAS:VOLTage[point] <number> 

Query Format: :LIST:BIAS:VOLTage [point]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -40 ~ 40 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage of the 10th point to 1 V… 

Command: :LIST:BIAS:VOLT10 1 

Example: To query the bias voltage of the 20th point… 

Query: :LIST:BIAS:VOLT20? 

Related Keys: Stim Table → DC Bias 

10.3.12.7 :LIST:CLE 

Description: Clear the list measurement points of the current page, restore them to the default value. 

Command Type: Command 
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Syntax: 

Command Format: :LIST:CLEar 

10.3.12.8 :LIST:CLE:ALL 

Description: Clear the list measurement points of all pages, restore them to the default value. 

Command Type: Command 

Syntax: 

Command Format: :LIST:CLEar:ALL 

10.3.12.9 :LIST:COMP 

Description: Set and query the list comparator state. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator[:STATe] {ON|OFF|1|0} 

Query Format: :LIST:COMParator[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the list comparator… 

Command: :LIST:COMP ON 

Example: To query the list comparator state… 

Query: :LIST:COMP? 

Related Keys: Comparator → Comparator State 

10.3.12.10 :LIST:COMP:BIN{1-15} 

Description: Set and query the ON/OFF status of BIN (1 ~ 15) in the list comparator. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator:BIN{1-15} [:STATe] {ON|OFF|1|0} 

Query Format: :LIST:COMParator:BIN{1-15} [:STATe]? 

Query Response: {1|0}<newline><^END> 
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Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on BIN 1… 

Command: :LIST:COMP:BIN1 ON 

Example: To query the ON/OFF status of BIN 2… 

Query: :LIST:COMP:BIN2? 

Related Keys: Stim Table → Comparator → BIN → State 

10.3.12.11 :LIST:COMP:BIN{1-15}:COND{1-4}:LIM 

Description: Set and query the limit line of the comparator condition setting (1 ~ 4) of BIN (1 ~ 15) in the list. The limit line 

contains the upper and lower limit values. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LIMit <number1>,<number2> 

Query Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LIMit? 

Query Response: {<number1>}, {<number2>}<newline><^END> 

Parameters: 

Description: Lower Limit Value (number 1) 

 Upper Limit Value (number 2) 

Data Type: Double 

Data Range: -1E9 ~ 1E9 

Preset Value: 0 

Unit: Depends on comparator parameters 

Example: To set the upper limit of BIN 1 condition 1 to 2k and the lower limit to 1k… 

Command: :LIST:COMP:BIN1:COND1:LIM 1E3,2E3 

Example: To query the upper and lower limits of BIN 2 condition 2… 

Query: :LIST:COMP:BIN2:COND2:LIM? 

Related Keys: Stim Table → Comparator → BIN → Upper/Lower 

10.3.12.12 :LIST:COMP:BIN{1-15}:COND{1-4}:LTYP 

Description: Set and query the limit line type of the comparator condition setting (1 ~ 4) of BIN (1 ~ 15) in the list. 

Command Type: Command/Query 
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Syntax: 

Command Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LTYPe {IN|OUT|ALL} 

Query Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:LTYPe? 

Query Response: {IN|OUT|ALL}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: IN 

 OUT 

 ALL 

Preset Value: ALL 

Example: To set the limit line type of BIN 1 Condition 1 to IN… 

Command: :LIST:COMP:BIN1:COND1:LTYP IN 

Example: To query the limit line type of BIN 2 Condition 2… 

Query: :LIST:COMP:BIN2:COND2:LTYP? 

Related Keys: Stim Table → Comparator → BIN → In/Out 

10.3.12.13 :LIST:COMP:BIN{1-15}:COND{1-4}:MODE 

Description: Set and query the data math of the comparator condition setting (1 ~ 4) of the list comparator setting BIN (1 ~ 15). 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:MODE {OFF|DEV|PCNT|PDEV} 

Query Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:MODE? 

Query Response: {OFF|DEV|PCNT|PDEV}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: OFF 

 DEV = Deviation 

 PCNT = Percent 

 PDEV = Percent Deviation 

Preset Value: OFF 

Example: To set the data math of BIN 1 Conditon 1 to Deviation… 

Command: :LIST:COMP:BIN1:COND1:MODE DEV 

Example: To query the data math of BIN 2 Condition 2… 

Query: :LIST:COMP:BIN2:COND2:MODE? 

Related Keys: Stim Table → Comparator → BIN → Mode 
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10.3.12.14 :LIST:COMP:BIN{1-15}:COND{1-4}:NOM 

Description: Set and query the reference value of the comparator condition setting (1 ~ 4) of the list comparator BIN (1 ~ 15). 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:NOMinal <number> 

Query Format: :LIST:COMParator:BIN{1-15}:CONDition{1|2|3|4}:NOMinal? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E9 ~ 1E9 

Preset Value: 0 

Example: To set the reference value of BIN 1 Condition 1 to 1000… 

Command: :LIST:COMP:BIN1:COND1:NOM 1E3 

Example: To query the reference value of BIN 2 Condition 2… 

Query: :LIST:COMP:BIN2:COND2:NOM? 

Related Keys: Stim Table → Comparator → BIN → Reference 

10.3.12.15 :LIST:COMP:CLE 

Description: Restore all list comparator settings to the initial values. 

Command Type: Command 

Syntax: 

Command Format: :LIST:COMParator:CLEar 

Related Keys: Stim Table → Comparator → All Tables → Clear All 

10.3.12.16 :LIST:COMP:COND{1-4}:PAR 

Description: Set and query the measurement parameters of the list comparator setting condition (1 ~ 4). 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator:CONDition{1|2|3|4}:PARameter {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS| 

LP|CS|CP|R|G|X|B|Q|D} 

Query Format: :LIST:COMParator:CONDition{1|2|3|4}:PARameter? 

Query Response: {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D}<newline><^END> 

Parameters: 

Data Type: String 
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Data Range: Z = |Z| 

 Y = |Y| 

 TZR = θz (rad) 

 TZD = θz (deg) 

 TYR = θy (rad) 

 TYD = θy (deg) 

 RS = Rs 

 RP = Rp 

 LS = Ls 

 LP = Lp 

 CS = Cs 

 CP = Cp 

 R = R 

 G = G 

 X = X 

 B = B 

 Q = Q 

 D = D 

Preset Value: Z 

Example: To set the parameters of Condition 1 to R… 

Command: :LIST:COMP:COND1:PAR R 

Example: To query the parameters of Condition 2… 

Query: :LIST:COMP:COND2:PAR? 

Related Keys: Stim Table → Comparator → Parameter Type 

10.3.12.17 :LIST:COMP:COUN 

Description: Set and query the ON/OFF status of the list comparator count. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COMParator:COUNt[:STATe] {ON|OFF|1|0} 

Query Format: :LIST:COMParator:COUNt[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the comparator count… 

Command: :LIST:COMP:COUN ON 
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Example: To query the ON/OFF status of the comparator count… 

Query: :LIST:COMP:COUN? 

Related Keys: Comparator → BIN Count 

10.3.12.18 :LIST:COMP:COUN:CLE 

Description: Clear the count of the current list comparator. 

Command Type: Command 

Syntax: 

Command Format: :LIST:COMParator:COUNt:CLEar 

Related Keys: Comparator → Clear BIN Count 

10.3.12.19 :LIST:COMP:DATA:BCO 

Description: Query the comparator count of each BIN in the list. 

Command Type: Query 

Syntax: 

Query Format: :LIST:COMParator:DATA:BCOunt? 

Query Response: {<number 1>}, {<number 2>},{<number 3>}, {<number 4>},{<number 5>}, {<number 

6>},{<number 7>}, {<number 8>},{<number 9>}, {<number 10>}<newline><^END> 

Number 1 ~ 9 represent the comparator count of BIN 1 ~ BIN 9, and the number 10 represents counts that fail to be sorted into 

any BIN (Out of Good). 

10.3.12.20 :LIST:COMP:DATA:BIN 

Description: Query the most recent comparator result. 

Command Type: Query 

Syntax: 

Query Format: :LIST:COMParator:DATA:BIN? 

Query Response: {0|1|2|3|4|5|6|7|8|9|10}<newline><^END> 

In the command, 0 indicates that the BIN cannot be sorted into any BIN, 1-9 indicate the corresponding BIN sequence number, 

and 10 indicates the comparator failure caused by measurement errors (usually Overload). 

10.3.12.21 :LIST:COUN 

Description: Set and query the average count of the selected measurement points in the list sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:COUNt[point] <number> 

Query Format: :LIST:COUNt[point]? 
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Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 999 

Preset Value: 1 

Example: To set the average count of the 10th point to 5… 

Command: :LIST:COUN10 5 

Example: To query the average count of the 20th point… 

Query: :LIST:COUN20? 

Related Keys: Stim Table → Avg Count 

10.3.12.22 :LIST:CURR 

Description: Set and query the signal source current of the selected measurement point in the list sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:CURRent[point] <number> 

Query Format: :LIST:CURRent[point]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.0002 ~ 0.02 

Preset Value: 0.02 

Unit: A 

Example: To set the signal source current of the 10th point to 1 mA… 

Command: :LIST:CURR10 1E-3 

Example: To query the signal source current of the 20th point… 

Query: :LIST:CURR20? 

Related Keys: Stim Table → OSC Level 

10.3.12.23 :LIST:DEL 

Description: Set and query the point delay of the selected point. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:DELay[point] <number> 
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Query Format: :LIST:DELay[point]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 30 

Preset Value: 0 

Unit: s 

Example: To set the point delay of point 10 to 100 ms… 

Command: :LIST:DEL10 0.01 

Example: To query the point delay of point 20… 

Query: :LIST:DEL20? 

Related Keys: Stim Table → Point Delay 

10.3.12.24 :LIST:FREQ 

Description: Set and query the measurement frequency of the selected point. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:FREQ[point] <number> 

Query Format: :LIST:FREQ[point]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 10 ~ 130M 

Preset Value: 1000 

Unit: Hz 

Example: To set the frequency of point 10 to 1 MHz… 

Command: :LIST:FREQ10 1E6 

Example: To query the measurement frequency of point 20… 

Query: :LIST:FREQ20? 

Related Keys: Stim Table → Frequency 

10.3.12.25 :LIST:MODE 

Description: Set the list type of the list sweep. 

Command Type: Command/Query 
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Syntax: 

Command Format: :LIST:MODE {SEQuence|STEP} 

Query Format: :LIST:MODE? 

Query Response: {SEQ|STEP}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: SEQ = Sequence 

 STEP = Step 

Preset Value: SEQ 

Example: To set the list type to Sequence… 

Command: :LIST:MODE SEQ 

Example: To query the list type… 

Query: :LIST:MODE? 

Related Keys: Point/List → List Type 

10.3.12.26 :LIST:OSC 

Description: Set and query the signal source level mode of the selected measurement point. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:OSC[point] {VOLTage|CURRent} 

Query Format: :LIST:OSC[point]? 

Query Response: {VOLT|CURR}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: VOLT = Voltage Mode 

 CURR = Current Mode 

Preset Value: VOLT 

Example: To set the 10th point signal source to voltage mode… 

Command: :LIST:OSC10 VOLT 

Example: To query the signal source mode of the 20th point… 

Query: :LIST:OSC20? 

Related Keys: Stim Table → OSC Mode 
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10.3.12.27 :LIST:PAR:FORM 

Description: Set and query the parameter name of the specified measurement parameter. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:PARameter {1|2|3|4}:FORMat {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G| 

X|B|Q|D} 

Query Format: :LIST:PARameter {1|2|3|4}:FORMat? 

Query Response: {Z|Y|TZR|TZD|TYR|TYD|RS|RP|LS|LP|CS|CP|R|G|X|B|Q|D|ER|ER1|ER2|U1|U2|TAN} 

<newline><^END> 

Parameters: 

Data Type: String 

Data Range: Z = |Z| 

 Y = |Y| 

 TZR = θz (rad) 

 TZD = θz (deg) 

 TYR = θy (rad) 

 TYD = θy (deg) 

 RS = Rs 

 RP = Rp 

 LS = Ls 

 LP = Lp 

 CS = Cs 

 CP = Cp 

 R = R 

 G = G 

 X = X 

 B = B 

 Q = Q 

 D = D 

 ER = |εr| (requires permittivity module support) 

 ER1 = εr' (requires permittivity module support) 

 ER2 = εr'' (requires permittivity module support) 

 U1 = μ' (requires troidalcore module support) 

 U2 = μ'' (requires troidalcore module support) 

 TAN = tan δ (requires troidalcore module support) 

 NONE = None (not displayed) 

Preset Value: Z 

Example: To set the parameter 1 to |Z|… 

Command: :LIST:PAR1:FORM Z 

Example: To query the parameter name of the parameter 2… 

Query: :LIST:PAR2:FORM? 

Related Keys: Display → Parameter Type 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 147 

10.3.12.28 :LIST:PERM:A1 

Description: Set and query the electrode in the calculation of permittivity. This command must be enabled with the permittivity 

permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:PERMittivity:A1 {ON|OFF|1|0} 

Query Format: :LIST:PERMittivity:A1? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF (Electrode is A2) 

 1 = ON (Electrode is A1) 

Preset Value: ON 

Example: To set the current electrode to A1… 

Command: :LIST:PERM:A1 ON 

Example: To query the electrode… 

Query: :LIST:PERM:A1? 

Related Keys: Point/List → Electrode 

10.3.12.29 :LIST:PERM:THIC 

Description: Set and query the thickness in the calculation of permittivity. This command must be enabled with the permittivity 

permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:PERMittivity:THICkness <number> 

Query Format: :LIST:PERMittivity:THICkness? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.01 

Unit: m 

Example: To set the thickness to 5 mm… 

Command: :LIST:PERM:THIC 5E-3 
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Example: To query the thickness… 

Query: :LIST:PERM:THIC? 

Related Keys: Point/List → Thickness 

10.3.12.30 :LIST:POIN 

Description: Set and query the number of measurement points in the list sweep, the measurement point parameter set by this 

command will be the default parameter. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:POINt <number> 

Query Format: :LIST:POINt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 1601 

Preset Value: 1 

Example: To set the number of measurement points to 20… 

Command: :LIST:POIN 20 

Example: To query the number of measurement points… 

Query: :LIST:POIN? 

10.3.12.31 :LIST:RANG 

Description: Set and query the AC range of the selected measurement point. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:RANGe[point] {AUTO|50|500|5K|50K} 

Query Format: :LIST:RANGe[point]? 

Query Response: {AUTO|50|500|5K|50K}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: AUTO 

 50 = 50 Ω 

 500 = 500 Ω 

 5K = 5 kΩ 

 50K = 50 kΩ 

Preset Value: AUTO 
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Example: To set the AC range of the 10th point to auto range… 

Command: :LIST:RANG10 AUTO 

Example: To query the AC range of the 20th point… 

Query: :LIST:RANG20? 

Related Keys: Stim Table → AC Data Range 

10.3.12.32 :LIST:TRIG 

Description: Set the trigger mode of the list sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:TRIG {INTernal|MANualEXTernal|BUS} 

Query Format: :LIST:TRIG? 

Query Response: {INT|MAN|EXT|BUS}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: INT = Internal Trigger 

 MAN = Manual Trigger 

 EXT = External Trigger 

 BUS = Bus Trigger 

Preset Value: INT 

Example: To set the trigger mode to manual trigger… 

Command: :LIST:TRIG MAN 

Example: To query the current trigger mode… 

Query: :LIST:TRIG? 

Related Keys: Point/List → Trigger Mode 

10.3.12.33 :LIST:TROI:HEIG 

Description: Set and query the troidal core height in the calculation of troidalcore. This command must be enabled with the 

troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:TROIdalcore:HEIGht <number> 

Query Format: :LIST:TROIdalcore:HEIGht? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 
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Data Range: 1E-9 ~ 999 

Preset Value: 0.005 

Unit: m 

Example: To set the troidal core height to 10 mm… 

Command: :LIST:TROI:HEIG 0.01 

Example: To query the troidal core height… 

Query: :LIST:TROI:HEIG? 

Related Keys: Point/List → Troidal Core Height 

10.3.12.34 :LIST:TROI:INN 

Description: Set and query the troidal core inner in the calculation of troidalcore. This command must be enabled with the 

troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:TROIdalcore:INNer <number> 

Query Format: :LIST:TROIdalcore:INNer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.008 

Unit: m 

Example: To set the troidal core inner to 10 mm… 

Command: :LIST:TROI:INN 0.01 

Example: To query the troidal core inner… 

Query: :LIST:TROI:INN? 

Related Keys: Point/List → Troidal Core Inner 

10.3.12.35 :LIST:TROI:OUT 

Description: Set and query the troidal core outer in the calculation of troidalcore. This command must be enabled with the 

troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:TROIdalcore:OUTer <number> 

Query Format: :LIST:TROIdalcore:OUTer? 
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Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.015 

Unit: m 

Example: To set the troidal core outer to 20 mm… 

Command: :LIST:TROI:OUT 0.02 

Example: To query the troidal core outer… 

Query: :LIST:TROI:OUT? 

Related Keys: Point/List → Troidal Core Outer 

10.3.12.36 :LIST:VOLT 

Description: Set and query the signal source voltage of the selected measurement point in the list sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :LIST:VOLTage[point] <number> 

Query Format: :LIST:VOLTage [point]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.005 ~ 1 

Unit: V 

Preset Value: 0.5 

Example: To set the signal source voltage of the 10th point to 1 V… 

Command: :LIST:VOLT10 1 

Example: To query the signal source voltage of the 20th point… 

Query: :LIST:VOLT20? 

Related Keys: Stim Table → OSC Level 
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10.3.13 Permittivity 

10.3.13.1 :PERM:A1 

Description: Set and query the electrode in the calculation of permittivity. This command must be enabled with the permittivity 

permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :PERMittivity:A1 {ON|OFF|1|0} 

Query Format: :PERMittivity:A1? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF (Electrode is A2) 

 1 = ON (Electrode is A1) 

Preset Value: ON 

Example: To set the current electrode to A1… 

Command: :PERM:A1 ON 

Example: To query the electrode… 

Query: :PERM:A1? 

Related Keys: Meas Setup → Electrode 

10.3.13.2 :PERM:THIC 

Description: Set and query the thickness in the calculation of permittivity. This command must be enabled with the permittivity 

permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :PERMittivity:THICkness <number> 

Query Format: :PERMittivity:THICkness? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.01 

Unit: m 
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Example: To set the thickness to 5 mm… 

Command: :PERM:THIC 5E-3 

Example: To query the thickness… 

Query: :PERM:THIC? 

Related Keys: Meas Setup → Thickness 

10.3.14 Memory 

10.3.14.1 :MMEM:LIST 

Description: Save the list measurement data to the specified file name. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:LIST <filename> 

Related Keys: Save/Reall → Export List Data 

10.3.14.2 :MMEM:LOAD 

Description: Load the measurement state settings file of the specified file path. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:LOAD[:STATe] "<filename>" 

Related Keys: Save/Recall → Recall State → Recall State 

10.3.14.3 :MMEM:LOAD:STAT 

Description: Read the measurement state settings saved at the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:LOAD:STATe {1|2|3|4|5|6|7|8} 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 8 

Example: To read the data of position 3… 

Command: :MMEM:LOAD:STAT 3 

Related Keys: Save/Recall → Recall State 
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10.3.14.4 :MMEM:STOR 

Description: Store the current measurement state settings to the specified file path. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STOR[:STATe] "<filename>" 

Related Keys: Save/Recall → Save State → Save State 

10.3.14.5 :MMEM:STOR:STAT 

Description: Store the current measurement state settings to the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:STATe {1|2|3|4|5|6|7|8} 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 8 

Example: To store the measurement state settings in position 3… 

Command: :MMEM:STOR:STAT 3 

Related Keys: Save/Recall → Save State 

10.3.15 Trigger 

10.3.15.1 :TRIG 

Description: Trigger a measurement. 

Command Type: Command 

Syntax: 

Command Format: :TRIGger 

10.3.15.2 :TRIG:DEL 

Description: Set and query the trigger delay of the point measurement. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger:DELay <number> 

Query Format: :TRIGger:DELay? 

Query Response: {<number>}<newline><^END> 
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Parameters: 

Data Type: Double 

Data Range: 0 ~ 30 

Preset Value: 0 

Unit: s 

Example: To set the point measurement trigger delay to 1 s… 

Command: :TRIG:DEL 1 

Example: To query the point measurement trigger delay… 

Query: :TRIG:DEL? 

Related Keys: Meas Setup → Trigger Delay 

10.3.15.3 :TRIG:SOUR 

Description: Set the trigger mode of the point measurement. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger:SOURce {INTernal|MANual|EXTernal|BUS} 

Query Format: :TRIGger:SOURce? 

Query Response: {INT|MAN|EXT|BUS}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: INT = Internal Trigger 

 MAN = Manual Trigger 

 EXT = External Trigger 

 BUS = Bus Trigger 

Preset Value: INT 

Example: To set the trigger mode to manual trigger… 

Command: :TRIG:SOUR MAN 

Example: To query the current trigger mode… 

Query: :TRIG:SOUR? 

Related Keys: Meas Setup → Trigger Mode 
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10.3.16 Troidal Core 

10.3.16.1 :TROI:HEIG 

Description: Set and query the troidal core height in the calculation of troidalcore. This command must be enabled with the 

troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :TROIdalcore:HEIGht <number> 

Query Format: :TROIdalcore:HEIGht? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.005 

Unit: m 

Example: To set the troidal core height to 10 mm… 

Command: :TROI:HEIG 0.01 

Example: To query the troidal core height… 

Query: :TROI:HEIG? 

Related Keys: Meas Setup → Troidal Core Height 

10.3.16.2 :TROI:INN 

Description: Set and query the troidal core inner in the calculation of troidalcore. This command must be enabled with the 

troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :TROIdalcore:INNer <number> 

Query Format: :TROIdalcore:INNer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.008 

Unit: m 
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Example: To set the troidal core inner to 10 mm… 

Command: :TROI:INN 0.01 

Example: To query the troidal core inner… 

Query: :TROI:INN? 

Related Keys: Meas Setup → Troidal Core Inner 

10.3.16.3 :TROI:OUT 

Description: Set and query the troidal core outer in the calculation of troidalcore. This command must be enabled with the 

troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :TROIdalcore:OUTer <number> 

Query Format: :TROIdalcore:OUTer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.015 

Unit: m 

Example: To set the troidal core outer to 20 mm… 

Command: :TROI:OUT 0.02 

Example: To query the troidal core outer… 

Command: :TROI:OUT? 

Related Keys: Meas Setup → Troidal Core Outer 

10.3.17 Voltage 

10.3.17.1 :VOLT 

Description: Set and query the voltage level of the point measurement signal source, and automatically set the level mode to 

voltage mode after setting the voltage. 

Command Type: Command/Query 

Syntax: 

Command Format: :VOLTage <number> 

Query Format: :VOLTage? 

Query Response: {<number>}<newline><^END> 
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Parameters: 

Data Type: Double 

Data Range: 0.005 ~ 1 

Preset Value: 0.5 

Unit: V 

Example: To set the voltage to 1 V… 

Command: :VOLT 1 

Example: To query the voltage value… 

Query: :VOLT? 

Related Keys: Meas Setup → OSC Level → Voltage Level 

10.4 Trace Sweep Commands 

This part introduces the related commands of the trace sweep. The commands entered in this part will take effect only if the 

current page belongs to the trace sweep (or its related setting interface). 

10.4.1 Abort 

10.4.1.1 :ABOR 

Description: Immediately terminate the current sweep cycle and start a new one. 

Command Type: Command 

Syntax: 

Command Format: :ABORt 

Related Keys: Trigger Mode → Restart 

10.4.2 Calculate 

10.4.2.1 :CALC<Ch>:AVER 

Description: Set and query the averaging ON/OFF status of the selected measurement channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:AVERage[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>:AVERage[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 
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Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the averaging of channel 1 to ON… 

Command: :CALC1:AVER ON 

Example: To query the averaging ON/OFF status of channel 2… 

Query: :CALC2:AVER? 

Related Keys: Avg → Averaging 

10.4.2.2 :CALC<Ch>:AVER:CLE 

Description: Clear the averaging count of the selected measurement channel and restart. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>:AVERage:CLEar 

Related Keys: Avg → Averaging Restart 

10.4.2.3 :CALC<Ch>:AVER:COUN 

Description: Set and query the averaging count of the selected measurement channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:AVERage:COUNt <number> 

Query Format: :CALCulate<Ch>:AVERage:COUNt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 999 

Preset Value: 1 

Example: To set the averaging count of channel 1 to 5… 

Command: :CALC1:AVER:COUN 5 

Example: To query the averaging count of channel 2… 

Query: :CALC2:AVER:COUN? 

Related Keys: Avg → Avg Factor 
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10.4.2.4 :CALC<Ch>:DATA:FDAT 

Description: Set and query the measured value of the current trace of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:DATA:FDATa <number 1>,<number 2>...<number n × 2> 

Query Format: :CALCulate<Ch>[:SELected]:DATA:FDATa? 

Query Response: {<number 1>},{<number 2>}...{<number n × 2>}<newline><^END> 

Parameters: 

Description: Measured Value of Trace: 

 The number of measurement points is n. Each measurement point corresponds to two 

<number>s. 

 The ith measurement point input parameters are <number i × 2 – 1> and <number i × 2>. 

 If the measured parameters of the trace are complex Z or complex Y, <number i × 2 – 1> 

is the real part of the measurement data of the ith point, and <number i × 2> is the imagi-

nary part of the measured data of the ith point. 

 Otherwise, <number i × 2 – 1> is the measured data of the ith point, and <number i × 2> 

is fixed to 0. 

Data Type: Double 

Note: If the number of <numbers> entered in the command is not equal to n × 2, an error will be returned. 

10.4.2.5 :CALC<Ch>:DATA:FMEM 

Description: Set and query the measured value of the current memory trace of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:DATA:FMEMory <number 1>,<number 2>...<number n × 2> 

Query Format: :CALCulate<Ch>[:SELected]:DATA:FMEMory? 

Query Response: {<number 1>},{<number 2>}...{<number n × 2>}<newline><^END> 

Parameters: 

Description: Measured Value of Memory Trace: 

 The number of measurement points is n. Each measurement point corresponds to two 

<number>s. 

 The ith measurement point input parameters are <number i × 2 – 1> and <number i × 2>. 

 If the measured parameters of the trace are complex Z or complex Y, <number i × 2 – 1> 

is the real part of the measurement data of the ith point, and <number i × 2> is the imagi-

nary part of the measured data of the ith point. 

 Otherwise, <number i × 2 – 1> is the measured data of the ith point, and <number i × 2> 

is fixed to 0. 
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Data Type: Double 

Note: If the number of <numbers> entered in the command is not equal to n × 2, an error will be returned. 

10.4.2.6 :CALC<Ch>:DATA:RDAT 

Description: Set and query the measurement result of the current trace of the specified channel (R-X). 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:DATA:RDATa <number 1>,<number 2>...<number n × 2> 

Query Format: :CALCulate<Ch>[:SELected]:DATA:RDATa? 

Query Response: {<number 1>},{<number 2>}...{<number n × 2>}<newline><^END> 

Parameters: 

Description: Measured Value of Trace: 

 The number of measurement points is n. Each measurement point corresponds to two 

<number>s. 

 The ith measurement point input parameters are <number i × 2 – 1> and <number i × 2>. 

 <number i × 2 – 1> is the R value of the ith point, and <number i × 2> is the X value of the 

ith point. 

Data Type: Double 

Note: If the number of <numbers> entered in the command is not equal to n × 2, an error will be returned. 

10.4.2.7 :CALC<Ch>:DATA:RMEM 

Description: Set and query the measurement result of the current memory trace of the specified channel (R-X). 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:DATA:RMEMory <number 1>,<number 2>...<number n × 2> 

Query Format: :CALCulate<Ch>[:SELected]:DATA:RMEMory? 

Query Response: {<number 1>}, {<number 2>}, ..., {<number n × 2>}<newline><^END> 

Parameters: 

Description: Measured Value of Trace: 

 The number of measurement points is n. Each measurement point corresponds to two 

<number>s. 

 The ith measurement point input parameters are <number i × 2 – 1> and <number i × 2>. 

 <number i × 2 – 1> is the R value of the ith point, and <number i × 2> is the X value of the 

ith point. 

Data Type: Double 

Note: If the number of <numbers> entered in the command is not equal to n*2, an error will be returned. 
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10.4.2.8 :CALC<Ch>:DATA:XAX 

Description: Get the value on the X-axis corresponding to each measurement point. 

Command Type: Query 

Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:DATA:XAXis? 

Query Response: {<number 1>}, {<number 2>}, ..., {<number n>} <newline><^END> 

10.4.2.9 :CALC<Ch>:EPAR 

Description: Execute equivalent circuit analysis of measured data for the selected channels with the selected models. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters[:EXECute] 

Related Keys: Analysis → Equivalent Circuit → Calculate 

10.4.2.10 :CALC<Ch>:EPAR:CIRC 

Description: Set and query the equivalent circuit model of the selected channels. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:CIRCuit[:TYPE] {A|B|C|D|E|F|G} 

Query Format: :CALCulate<Ch>:EPARameters:CIRCuit[:TYPE]? 

Query Response: {A|B|C|D|E|F|G}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: A 

 B 

 C 

 D 

 E 

 F 

 G 

Preset Value: A 

Example: To set the equivalent circuit model of channel 1 to model C… 

Command: :CALC1:EPAR:CIRC C 

Example: To query the equivalent circuit model of channel 2… 

Query: :CALC2:EPAR:CIRC? 

Related Keys: Analysis → Equivalent Circuit → Select Circuit 
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10.4.2.11 :CALC<Ch>:EPAR:CIRC:{A|B|C|D|E|F|G}:C1 

Description: Set and query the capacitance value C1 corresponding to the selected equivalent circuit model in the selected 

channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:C1 <number> 

Query Format: :CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:C1? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: F 

Example: To set the capacitor C1 value of channel 1 model C to 1 nF… 

Command: :CALC1:EPAR:CIRC:C:C1 1E-9 

Example: To query the capacitor C1 value of channel 2 model A… 

Query: :CALC2:EPAR:CIRC:A:C1? 

Related Keys: Analysis → Equivalent Circuit → C1 

10.4.2.12 :CALC<Ch>:EPAR:CIRC:{A|B|C|D|E|F|G}:L1 

Description: Set and query the inductance value L1 corresponding to the selected equivalent circuit model in the selected 

channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:L1 <number> 

Query Format: :CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:L1? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: H 

Example: To set the inductor L1 value of channel 1 model C to 1 nH… 

Command: :CALC1:EPAR:CIRC:C:L1 1E-9 
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Example: To query the inductor L1 value of channel 2 model A… 

Query: :CALC2:EPAR:CIRC:A:L1? 

Related Keys: Analysis → Equivalent Circuit → L1 

10.4.2.13 :CALC<Ch>:EPAR:CIRC:{A|B|C|D|E|F|G}:R1 

Description: Set and query the resistance value R1 corresponding to the selected equivalent circuit model in the selected 

channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:R1 <number> 

Query Format: :CALCulate<Ch>:EPARameters:CIRCuit:{A|B|C|D|E|F|G}:R1? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Ω 

Example: To set the resistor R1 value of channel 1 model C to 1 kΩ… 

Command: :CALC1:EPAR:CIRC:C:R1 1E3 

Example: To query the resistor R1 value of channel 2 model A… 

Query: :CALC2:EPAR:CIRC:A:R1? 

Related Keys: Analysis → Equivalent Circuit → R1 

10.4.2.14 :CALC<Ch>:EPAR:CIRC:E:C0 

Description: Set and query the capacitance value C0 corresponding to the equivalent circuit model E in the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:CIRCuit:E:C0 <number> 

Query Format: :CALCulate<Ch>:EPARameters:CIRCuit:E:C0? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: F 
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Example: To set the capacitor C0 value of channel 1 model E to 1 nF… 

Command: :CALC1:EPAR:CIRC:E:C0 1E-9 

Example: To query the capacitor C0 value of channel 2 model E… 

Query: :CALC2:EPAR:CIRC:E:C0? 

Related Keys: Analysis → Equivalent Circuit → C0 

10.4.2.15 :CALC<Ch>:EPAR:CIRC:{F|G}:R1 

Description: Set and query the resistance value R0 corresponding to the selected equivalent circuit model F or G in the 

selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:CIRCuit:{F|G}:R0 <number> 

Query Format: :CALCulate<Ch>:EPARameters:CIRCuit:{F|G}:R0? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Ω 

Example: To set the resistor R0 value of channel 1 model F to 1 kΩ… 

Command: :CALC1:EPAR:CIRC:F:R0 1E3 

Example: To query the resistor R0 value of channel 2 model G… 

Query: :CALC2:EPAR:CIRC:G:R0? 

Related Keys: Analysis → Equivalent Circuit → R0 

10.4.2.16 :CALC<Ch>:EPAR:DISP 

Description: Set and query the ON/OFF status of the equivalent circuit model and calculation results displayed on the screen. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:DISPlay[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>:EPARameters:DISPlay[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 166 

 1 = ON 

Preset Value: OFF 

Example: To set the equivalent circuit display of channel 1 to ON… 

Command: :CALC1:EPAR:DISP ON 

Example: To query the ON/OFF status of the equivalent circuit display of channel 2… 

Query: :CALC2:EPAR:DISP? 

Related Keys: Analysis → Equivalent Circuit → Display 

10.4.2.17 :CALC<Ch>:EPAR:SIM 

Description: Immediately perform an equivalent circuit simulation calculation for the current set value of the selected channel 

and write the data into the trace and memory trace. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:SIMulate[:IMMediate] 

Related Keys: Analysis → Equivalent Circuit → Simulate 

10.4.2.18 :CALC<Ch>:EPAR:SIM:AUTO 

Description: Set and query the ON/OFF status of the automatic equivalent circuit simulation calculation of the selected chan-

nel. When it is set to ON, if an equivalent circuit parameter is modified, the simulation calculation will be performed automatically 

and the measurement results will be written to the trace and memory trace. When it is set to OFF, the results will not be written 

to the trace after the equivalent circuit simulation calculation is completed. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:EPARameters:SIMulate:AUTO {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>:EPARameters:SIMulate:AUTO? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the equivalent circuit auto simulation of channel 1 to ON… 

Command: :CALC1:EPAR:SIM:AUTO ON 

Example: To query the ON/OFF status of the equivalent circuit auto simulation of channel 2… 

Query: :CALC2:EPAR:SIM:AUTO? 

Related Keys: Analysis → Equivalent Circuit → Simulate 
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10.4.2.19 :CALC<Ch>:LIM 

Description: Set and query the ON/OFF status of the sweep limit test. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:LIMit[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:LIMit[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the trace sweep of channel 1 to ON… 

Command: :CALC1:LIM ON 

Example: To query the ON/OFF status of the trace sweep of channel 2… 

Query: :CALC2:LIM? 

Related Keys: Analysis → Limit Setup → Limit State 

10.4.2.20 :CALC<Ch>:LIM:ADD 

Description: Add a segment of limit line for the specified channel and trace, this command only takes effect after the limit 

reference value is set. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:LIMit:ADD<number 1>,<number 2>,{ABS|DEV|PER|DPER}, 

<number 3>,<number 4> 

Parameters: 

Description: <Number 1>: The start X value of the limit line. The value should be between the start 

value and the end value of the trace scanning; otherwise it will be adjusted automatically. 

 <Number 2>: The ending X value of the limit line. The value should be taken between the 

set trace scanning start value and end value, and not less than the starting X value; oth-

erwise it will be adjusted automatically. 

 {ABS|DEV|PER|DPER}: The upper and lower limit types of the limit line. 

 <Number 3>: The upper limit of the limit line. If the upper and lower limit types are per-

centage or deviation percentage, then the value is a percentage. 

 <Number 4>: The lower limit of the limit line. If the upper and lower limit types are per-

centage or deviation percentage, then the value is a percentage. 
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Data Range (Limit Types): ABS = Absolute Value 

 DEV = Deviation Value 

 PER = Percentage 

 DPER = Deviation Percentage 

Note: If the parameters are wrong or not all parameters are set, an error will be returned! 

Example: To add a limit line for the selected trace of channel 1 (frequency 1MHz ~ 10MHz, deviation percentage type, the 

upper and lower limits of the limit line are -10% ~ 20%)… 

Command: :CALC1:LIM:ADD 1E6,1E7,DPER,20,-10 

10.4.2.21 :CALC<Ch>:LIM:CLE 

Description: Clear all the selected channels and traces. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:LIMit:CLEar 

Related Keys: Analysis → Limit Setup → Edit Limit Line → Clear 

10.4.2.22 :CALC<Ch>:LIM:REF 

Description: Set the limit reference value for selected channel and trace. Changing the trace parameter will clear the reference 

value. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:LIMit:REFerence 

Related Keys: Analysis → Limit Setup → [Data→Reference] 

10.4.2.23 :CALC<Ch>:LIM:SHOW 

Description: Set and query the display state of the selected trace scanning limit line. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:LIMit:SHOW[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:LIMit:SHOW[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data type Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 
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Example: To set the trace scanning limit line state of channel 1 to ON… 

Command: :CALC1:LIM:SHOW ON 

Example: To query the ON/OFF status of the trace scanning limit line of channel 2… 

Query: :CALC2:LIM:SHOW? 

Related Keys: Analysis → Limit Setup → Limit Line 

10.4.2.24 :CALC<Ch>:LIM:TEST 

Description: Query the trace scanning limit result of the currently selected trace. 

Command Type: Query 

Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:LIMit:TEST? 

Query Response: {1|0}<newline><^END> 

Example: To query the trace scanning limit result of the selected trace of channel 1… 

Query: :CALC1:LIM:TEST? 

10.4.2.25 :CALC<Ch>:LIM:TEST:ALL 

Description: Query the combined result of trace scanning limit and marker limit for the currently selected trace. 

Note: If the trace scanning limit is not turned on, it will be judged as limit failure; if the marker is not activated or the marker 

limit is not turned on, the marker will be skipped. 

Command Type: Query 

Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:LIMit:TEST:ALL? 

Query Response: {1|0}<newline><^END> 

Example: To query the combined limit result of the selected trace of channel 1… 

Query: :CALC1:LIM:TEST:ALL? 

10.4.2.26 :CALC<Ch>:MARK<Mk> 

Description: Set and query the ON/OFF status of the selected marker of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 170 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the marker 1 of channel 1 to ON… 

Command: :CALC1:MARK1 ON 

Example: To query the ON/OFF status of marker 2 of channel 2… 

Query: :CALC2:MARK2? 

Related Keys: Marker → Marker 1 ~ Marker 9, Reference Marker 

10.4.2.27 :CALC<Ch>:MARK<Mk>:ACT 

Description: Activate the selected marker of the selected channel in the command. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:ACTivate 

Related Keys: Marker → Marker 1 ~ Marker 9, Reference Marker 

10.4.2.28 :CALC<Ch>:MARK:AOFF 

Description: Turn off all markers in the selected channel. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:AOFF 

Related Keys: Marker → Clear Markers → All OFF 

10.4.2.29 :CALC<Ch>:MARK:COUP 

Description: Set and query the ON/OFF status of the marker couple of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:COUPle {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:COUPle? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 171 

Example: To set the marker of channel 1 to Couple… 

Command: :CALC1:MARK:COUP ON 

Example: To query the marker couple ON/OFF status of channel 2… 

Query: :CALC2:MARK:COUP? 

Related Keys: Marker Function → Couple 

10.4.2.30 :CALC<Ch>:MARK:DISC 

Description: Set and query whether the marker of the selected channel set is allowed to be positioned between the discrete 

points. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:DISCrete {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:DISCrete? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the marker of channel 1 to be able to be positioned only at discrete points… 

Command: :CALC1:MARK:DISC ON 

Example: To query whether or not the marker of channel 2 can be positioned between discrete points… 

Query: :CALC2:MARK:DISC? 

Related Keys: Marker Function → Discrete 

10.4.2.31 :CALC<Ch>:MARK:FUNC:DOM 

Description: Set and query the ON/OFF status of the marker search range of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 
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 1 = ON 

Preset Value: OFF 

Example: To set the marker search unit of channel 1 to ON… 

Command: :CALC1:MARK:FUNC:DOM ON 

Example: To query the ON/OFF status of the marker search range of channel 2… 

Query: :CALC2:MARK:FUNC:DOM? 

Related Keys: Marker Search → Search Data Range → Search Data Range 

10.4.2.32 :CALC<CH>:MARK:FUNC:DOM:STAR 

Description: Set and query the start value of the marker search range. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STARt <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STARt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Unit: Hz 

 V 

 A 

Example: To set the search range start value of channel 1 to 1 kHz… 

Command: :CALC1:MARK:FUNC:DOM:STAR 1E3 

Example: To query the search range start value of channel 2… 

Query: :CALC2:MARK:FUNC:DOM:STAR? 

Related Keys: Marker Search → Search Data Range → Start 

10.4.2.33 :CALC<Ch>:MARK:FUNC:DOM:STOP 

Description: Set and query the termination value of the marker search range. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STOP <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:DOMain:STOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 
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Unit: Hz 

 V 

 A 

Example: To set the search range termination value of channel 1 to 1 MHz… 

Command: :CALC1:MARK:FUNC:DOM:STOP 1E6 

Example: To query the search range termination value of channel 2… 

Query: :CALC2:MARK:FUNC:DOM:STOP? 

Related Keys: Marker Search → Search Data Range → Stop 

10.4.2.34 :CALC<Ch>:MARK<Mk>:FUNC:EXEC 

Description: Immediately perform a marker search. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:EXECute 

Related Keys: Marker Search → Max | Min | Peak | Target | Multi Peak | Multi Target 

10.4.2.35 :CALC<Ch>:MARK:FUNC:MULT:PEXC 

Description: Set and query the multiple peak excursion of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PEXCursion? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 1E15 

Preset Value: 3 

Unit: Depends on measurement parameters 

Example: To set the multiple peak excursion of channel 1 to 1 kΩ… 

Command: :CALC1:MARK:FUNC:MULT:PEXC 1E3 

Example: To query the multiple peak excursion of channel 2… 

Query: :CALC2:MARK:FUNC:MULT:PEXC? 

Related Keys: Marker Search → Multi Peak → Peak Excursion 
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10.4.2.36 :CALC<Ch>:MARK:FUNC:MULT:PPOL 

Description: Set and query the peak polarity of the multiple peaks of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity{POSitive|NEGative| 

BOTH} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:PPOLarity? 

Query Response: {POS|NEG|BOTH}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: POSitive 

 NEGative 

 BOTH 

Preset Value: BOTH 

Example: To set the multiple peak polarity of channel 1 to positive… 

Command: :CALC1:MARK:FUNC:MULT:PPOL POS 

Example: To query the multiple peak polarity of channel 2… 

Query: :CALC2:MARK:FUNC:MULT:PPOL? 

Related Keys: Marker Search → Multi Peak → Peak Polarity 

10.4.2.37 :CALC<Ch>:MARK:FUNC:MULT:TARG 

Description: Set and query the target value of the multiple target values of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TARGet <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TARGet? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on measurement parameters 

Example: To set the target of the multiple target value of channel 1 to 1 kΩ… 

Command: :CALC1:MARK:FUNC:MULT:TARG 1E3 
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Example: To query the target of the multiple target values of channel 2… 

Query: :CALC2:MARK:FUNC:MULT:TARG? 

Related Keys: Marker Search → Multi Target → Target 

10.4.2.38 :CALC<Ch>:MARK:FUNC:MULT:TTR 

Description: Set and query the transition of the multiple target values of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TTRansition{POSitive|NEGative| 

BOTH} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TTRansition? 

Query Response: {POS|NEG|BOTH}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: POSitive 

 NEGative 

 BOTH 

Preset Value: BOTH 

Example: To set the transition of the multiple target value of channel 1 to positive… 

Command: :CALC1:MARK:FUNC:MULT:TTR POS 

Example: To query the transition of the multiple target value of channel 2… 

Query: :CALC2:MARK:FUNC:MULT:TTR? 

Related Keys: Marker Search → Multi Target → Target Transition 

10.4.2.39 :CALC<Ch>:MARK:FUNC:MULT:TYPE 

Description: Set and query whether the marker search of the current channel is multiple search. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TYPE {OFF|PEAK|TARGet} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:FUNCtion:MULTi:TYPE? 

Query Response: {OFF|PEAK|TARG}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: OFF 

 PEAK 

 TARGet 
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Preset Value: BOTH 

Example: To set the marker search of channel 1 to peak… 

Command: :CALC1:MARK:FUNC:MULT:TYPE PEAK 

Example: To query the marker search setting of channel 2… 

Query: :CALC2:MARK:FUNC:MULT:TYPE? 

10.4.2.40 :CALC<Ch>:MARK<Mk>:FUNC:PEXC 

Description: Set and query the peak excursion of the selected marker of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PEXCursion <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PEXCursion? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 1E15 

Preset Value: 3 

Unit: Depends on measurement parameters 

Example: To set the peak excursion of channel 1 marker 1 to 1 kΩ… 

Command: :CALC1:MARK1:FUNC:PEXC 1E3 

Example: To query the peak excursion of channel 2 marker 2… 

Query: :CALC2:MARK2:FUNC:PEXC? 

Related Keys: Marker Search → Peak → Peak Excursion 

10.4.2.41 :CALC<Ch>:MARK<Mk>:FUNC:PPOL 

Description: Set and query the peak polarity of the selected marker peak of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PPOLarity{POSitive|NEGative| 

BOTH} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:PPOLarity? 

Query Response: {POS|NEG|BOTH}<newline><^END> 

Parameters: 

Data Type: String 
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Data Range: POSitive 

 NEGative 

 BOTH 

Preset Value: BOTH 

Example: To set the peak polarity of the channel 1 marker to positive… 

Command: :CALC1:MARK1:FUNC:PPOL POS 

Example: To query the peak polarity of channel 2 marker 2… 

Query: :CALC2:MARK2:FUNC:PPOL? 

Related Keys: Marker Search → Peak → Peak Polarity 

10.4.2.42 :CALC<Ch>:MARK<Mk>:FUNC:TARG 

Description: Set and query the target value of the selected marker of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TARGet <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TARGet? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on measurement parameters 

Example: To set the target of channel 1 marker 1 target value to 1 kΩ… 

Command: :CALC1:MARK1:FUNC:TARG 1E3 

Example: To query the target of channel 2 marker 2 target value… 

Query: :CALC2:MARK2:FUNC:TARG? 

Related Keys: Marker Search → Target → Target 

10.4.2.43 :CALC<Ch>:MARK<Mk>:FUNC:TRAC 

Description: Set and query the ON/OFF status of the marker tracking function of the selected marker of the selected channel. 

When the marker tracking is turned on, the marker will perform a marker search immediately after each sweep cycle is com-

pleted. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TRACking {ON|OFF|1|0} 
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Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TRACking? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the marker tracking of channel 1 marker 1… 

Command: :CALC1:MARK1:FUNC:TRAC ON 

Example: To query the ON/OFF status of the marker tracking of channel 2 marker 2… 

Query: :CALC2:MARK2:FUNC:TRAC? 

Related Keys: Marker Search → Tracking 

10.4.2.44 :CALC<Ch>:MARK<Mk>:FUNC:TTR 

Description: Set and query the transition of the target value of the selected marker of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TTRansition {POSitive|NEGative| 

BOTH} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TTRansition? 

Query Response: {POS|NEG|BOTH}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: POSitive 

 NEGative 

 BOTH 

Preset Value: BOTH 

Example: To set the target transition of channel 1 marker 1 to positive… 

Command: :CALC1:MARK1:FUNC:TTR POS 

Example: To query the target transition setting of channel 2 marker 2… 

Query: :CALC2:MARK2:FUNC:TTR? 

Related Keys: Marker Search → Target → Target Transition 
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10.4.2.45 :CALC<Ch>:MARK<Mk>:FUNC:TYPE 

Description: Set and query the mode of the current marker search. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:{MAXimum|MINimum|PEAK| 

LPEak|RPEak|TARGet|LTARget|RTARget} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:FUNCtion:TYPE? 

Query Response: {MAX|MIN|PEAK|LPE|RPE|TARG|LTAR|RTAR}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: MAXimum = Search Maximum Value 

 MINimum = Search Minimum Value 

 PEAK = Search Peak Value 

 LPEak = Search Left Peak Value 

 RPEak = Search Right Peak Value 

 TARGet = Search Target Value 

 LTARget = Search Left Target Value 

 RTARget = Search Right Target Value 

Preset Value: BOTH 

Example: To set the marker search mode of channel 1 to search maximum… 

Command: :CALC1:MARK:FUNC:TYPE MAX 

Example: To query the marker search mode of channel 2… 

Query: :CALC2:MARK:FUNC:TYPE? 

Related Keys: Marker Search → Max | Min | Target | Peak 

10.4.2.46 :CALC<Ch>:MARK<Mk>:LIM 

Description: Set and query the marker limit state of the selected marker. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 180 

Example: To turn on the marker limit for the current trace marker 1 of channel 1… 

Command: :CALC1:MARK1:LIM ON 

Example: To query the marker limit ON/OFF status of the current trace marker 2 of channel 1… 

Query: :CALC1:MARK2:LIM? 

10.4.2.47 :CALC<Ch>:MARK<Mk>:LIM:LOW 

Description: Set and query the lower limit of marker limit for a selected trace. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:LOWer <numeric> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:LOWer? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on measurement parameter and limit type 

Example: To set the lower limit of the current trace marker 1 of channel 1 to 0.01… 

Command: :CALC1:MARK1:LIM:LOW 0.01 

Example: To query the lower limit of the current trace marker 2 of channel 1… 

Query: :CALC1:MARK2:LIM:LOW? 

10.4.2.48 :CALC<Ch>:MARK<Mk>:LIM:REF 

Description: Set and query the reference value of the marker limit for the selected trace. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:REFerence <numbers> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit: REFerence? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on measurement parameter 
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Example: To set the reference value of the current trace marker 1 of channel 1 to 100… 

Command: :CALC1:MARK1:LIM:REF 100 

Example: To query the reference value of the current trace marker 2 of channel 1… 

Query: :CALC1:MARK2:LIM:REF? 

10.4.2.49 :CALC<Ch>:MARK<Mk>:LIM:TEST 

Description: Query the marker limit results for a selected trace. You need to activate the marker and turn on the limit state of 

this marker, make one measurement and then query the limit result. 

Command Type: Query 

Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:TEST? 

Query Response: {1|0}<newline><^END> 

10.4.2.50 :CALC<Ch>:MARK<Mk>:LIM:TYPE 

Description: Set and query the marker limit type of the selected marker. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:TYPE {ABS|DEV|PER|DPER} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:TYPE? 

Query Response: {ABS|DEV|PER|DPER}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: ABS = Absolute Value 

 DEV = Deviation 

 PER = Percentage 

 DPER = Deviation Percentage 

Preset Value: ABS 

Note: When limit type is set to percentage or deviation percentage, the upper and lower limit values are percentages. 

Example: To set the limit type of the current trace marker 1 of channel 1 to Deviation type… 

Command: :CALC1:MARK1:LIM:TYPE DEV 

Example: To query the limit type of the current trace marker 2 of channel 1… 

Query: :CALC1:MARK2:LIM:TYPE? 

10.4.2.51 :CALC<Ch>:MARK<Mk>:LIM:UPP 

Description: Set and query the upper limit of marker limit for a selected marker. 

Command Type: Command/Query 
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Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:UPPer <Number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:LIMit:UPPer? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on measurement parameter and limit type 

Example: To set the upper limit of the current trace marker 1 of channel 1 to 1000… 

Command: :CALC1:MARK1:LIM:UPP 1000 

Example: To query the upper limit of the current trace marker 2 of channel 1… 

Query: :CALC1:MARK2:LIM:UPP? 

10.4.2.52 :CALC<Ch>:MARK:MATH:STAT 

Description: Set and query the ON/OFF status of the marker statistics. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:MATH:STATistics[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:MATH:STATistics[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the marker statistics state of channel 1… 

Command: :CALC1:MARK:MATH:STAT ON 

Example: To query the ON/OFF status of the marker statistics of channel 2… 

Query: :CALC2:MARK:MATH:STAT? 

Related Keys: Marker Function → Statistics 

10.4.2.53 :CALC<Ch>:MARK:MATH:STAT:DATA 

Description: Query the current statistics data. 

Command Type: Query 
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Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:MATH:STATistics:DATA? 

Query Response: {<number1>},{<number2>},{<number3>},{<number4>}<newline><^END> 

• <Number 1>: Data Range Span 

• <Number 2>: Average Value 

• <Number 3>: Standard Deviation 

• <Number 4>: Peak-to-Peak Value 

10.4.2.54 :CALC<Ch>:MARK:REF 

Description: Set and query the ON/OFF status of the reference marker of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:REFerence[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:REFerence[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the reference marker of channel 1… 

Command: :CALC1:MARK:REF ON 

Example: To query the ON/OFF status of the reference marker of channel 2… 

Query: :CALC2:MARK:REF? 

Related Keys: Marker → Ref Marker Mode 

10.4.2.55 :CALC<Ch>:MARK<Mk>:SET 

Description: Set the position of the selected marker of the selected channel to the stimulus. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:SET {CENTer|STARt|STOP|RLEVel|ZOOM} 

Parameters: 

Data Type: String 

Data Range: STARt = Set the marker position to the stimulus start value 

 STOP = Set the marker position to the stimulus termination value 

 CENTer = Set the marker position to the stimulus center value 

 RLEVel = Set the marker value to the reference value of the response value 
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 ZOOM = Zoom the horizontal axis according to the set zoom ratio 

Example: To set the position of channel 1 marker 1 to the stimulus center value… 

Command: :CALC1:MARK1:SET CENT 

Related Keys: Marker Function → [Marker→Start] | [Marker→Stop] | [Marker→Center] | [Marker→Ref-

erence] | [Marker Zoom] 

10.4.2.56 :CALC<Ch>:MARK<Mk>:X 

Description: Set and query the stimulus value of the selected marker of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:X[:DATA] <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:X[:DATA]? 

Query Response: <number><newline><^END> 

Example: To set the stimulus value of channel 1 marker 1 to 1 MHz… 

Command: :CALC1:MARK1:X 1E6 

Example: To query the stimulus value of channel 2 marker 2… 

Query: :CALC2:MARK2:X? 

Related Keys: Marker → Marker1 ~ Marker9 | Ref Marker 

10.4.2.57 :CALC<Ch>:MARK<Mk>:X:POS 

Description: Set and query the position of the selected marker of the selected channel relative to the measurement point. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:X:POSition <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:X:POSition? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1 ~ Number of Measurement Points 

Preset Value: 1 

Example: To set the position of channel 1 marker 1 to 100… 

Command: :CALC1:MARK1:X:POS 100 

Example: To query the position of channel 2 marker 2… 

Query: :CALC2:MARK2:X:POS? 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 185 

10.4.2.58 :CALC<Ch>:MARK<Mk>:Y 

Description: Query the measured (response) value of the selected marker of the selected channel. 

Command Type: Query 

Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:MARKer<Mk>:Y? 

Query Response: <number><newline><^END> 

10.4.2.59 :CALC<Ch>:MARK:ZAP 

Description: Set and query the marker zooming aperture of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MARKer:ZAPerture <number> 

Query Format: :CALCulate<Ch>[:SELected]:MARKer:ZAPerture? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.01 ~ 100 

Preset Value: 10 

Unit: % 

Example: To set the zooming aperture of channel 1 to 20 %… 

Command: :CALC1:MARK:ZAP 20 

Example: To query the zooming aperture of channel 1… 

Query: :CALC2:MARK:ZAP? 

Related Keys: Marker Function → Zooming Aperture 

10.4.2.60 :CALC<Ch>:MATH:FUNC 

Description: Set and query the data math mode of the selected channel. When the memory trace of the trace does not exist, 

only the normal setting is available; when the number of measurement points of the channel is changed, the value is automat-

ically modified to normal. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MATH:FUNCtion {NORMal|DIVide|MULTiply|SUBTract|ADD} 

Query Format: :CALCulate<Ch>[:SELected]:MATH:FUNCtion? 

Query Response: {NORM|DIV|MULT|SUBT|ADD}<newline><^END> 
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Parameters: 

Data Type: String 

Data Range: NORMal = DATA (no arithmetic) 

 DIVide = DATA / MEM 

 MULTiply = DATA × MEM 

 SUBTract = DATA – MEM 

 ADD = DATA + MEM 

DATA refers to the data in the measurement trace, MEM refers to the data in the memory trace 

Preset Value: NORMal 

Example: To set the data math for the currently selected trace of channel 1 to ADD… 

Command: :CALC1:MATH:FUNC ADD 

Example: To query the data math for the currently selected trace of channel 2… 

Query: :CALC2:MATH:FUNC? 

Related Keys: Display → Data Math 

10.4.2.61 :CALC<Ch>:MATH:MEM 

Description: Copy the measurement data of the current trace of the selected channel to the corresponding memory trace. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MATH:MEMorize 

Related Keys: Display → [Data→Mem] 

10.4.2.62 :CALC<Ch>:MATH:OFFS 

Description: Set and query the data math offset of the current trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MATH:OFFSet <number> 

Query Format: :CALCulate<Ch>[:SELected]:MATH:OFFSet? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 0 

Unit: Depends on measurement parameters 

Example: To set the offset of the current trace of channel 1 to 1k… 

Command: :CALC1:MATH:OFFS 1E3 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 187 

Example: To query the offset of the current trace of channel 2… 

Query: :CALC2:MATH:OFFS? 

Related Keys: Display → Data Math Offset 

10.4.2.63 :CALC<Ch>:MST 

Description: Set and query the ON/OFF status of the statistics of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>[:SELected]:MSTatistics[:STATe] {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>[:SELected]:MSTatistics[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the statistics of channel 1… 

Command: :CALC1:MST ON 

Example: To query the ON/OFF status of the statistic of channel 2… 

Query: :CALC2:MST? 

Related Keys: Marker Function → Statistics 

10.4.2.64 :CALC<Ch>:MST:DATA 

Description: Query the statistical values of the selected channel. 

Command Type: Query 

Syntax: 

Query Format: :CALCulate<Ch>[:SELected]:MSTatistics:DATA? 

Query Response: {<number1>},{<number2>},{<number3>},{<number4>}<newline><^END> 

• <Number 1>: Data Range Span 

• <Number 2>: Average Value 

• <Number 3>: Standard Deviation 

• <Number 4> : Peak-to-Peak Value 

10.4.2.65 :CALC<Ch>:OSCA:DATA 

Description: Query the parameters of OSC analysis of the selected channel. 

Command Type: Query 
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Syntax: 

Query Format: :CALCulate<Ch>:OSweepalysis:DATA? 

Query Response: {<number 1>},{<number 2>},...,{<number 18>}<newline><^END> 

Parameters: 

Description: OSC Analysis Parameters 

 The query returns 18 values. The meaning of each value is as follows: 

• <Number 1>: Free Capacitance Ct 

• <Number 2>: Free Loss Dt 

• <Number 3>: Resonance Frequency Fs 

• <Number 4>: Anti-Resonance Frequency Fp 

• <Number 5>: Impedance Minimum Zmin 

• <Number 6>: Impedance Maximum Zmax 

• <Number 7>: Conductance Maximum Gmax 

• <Number 8>: Half-Power Point Frequency F1 

• <Number 9>: Half-Power Point Frequency F2 

• <Number 10>: Direct Capacitance C0 

• <Number 11>: Dynamic Capacity C1 

• <Number 12>: Dynamic Resistance R1 

• <Number 13>: Dynamic Inductance L1 

• <Number 14>: Phase Angle Maximum θmax 

• <Number 15>: Phase Angle Maximum Point Frequency θmax 

• <Number 16>: Phase Angle Maximum Point Impedance θmax 

• <Number 17>: Phase Angle Maximum Point Capacitance θmax 

• <Number 18>: Electromechanical Coupling Coefficient Kt 

• <Number 19>: Quality Factor Qm 

Data Type: Double 

10.4.2.66 :CALC<Ch>:OSCA:EQUA 

Description: Set and query the equation of calculating the quality factor Qm in the OSC analysis of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:OSweepalysis:EQUAtion {1|2} 

Query Format: :CALCulate<Ch>:OSweepalysis:EQUAtion? 

Query Response: {1|2}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 = Qm =
Fs

F2−F1
 

 2 = Qm =
Fp

2

2πFsRCt(Fp
2 −Fs

2)
 

In the above equations… 

• Qm = Quality Factor 
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• Fs = Resonance Frequency 

• F1, F2 = Half-Power Point; F2 > F1 

• Fp = Anti-Resonance Frequency 

• R = Impedance Min 

• Ct = Free Capacitance 

Preset Value: 1 

Example: To set the Qm calculation equation of channel 1 to equation 1… 

Command: :CALC1:OSCA:EQUA 1 

Example: To query the Qm equation of channel 2… 

Query: :CALC2:OSCA:EQUA? 

Related Keys: Analysis → OSC Analysis → Q Equation 

10.4.2.67 :CALC<Ch>:OSCA:STAT 

Description: Set and query the OSC analysis state of the selected channel, and it is effective only when the sweep mode of 

the selected channel is sweep. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:OSweepalysis:STATe {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>:OSweepalysis:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the OSC analysis of channel 1… 

Command: :CALC1:OSCA:STAT ON 

Example: To query the ON/OFF status of the OSC analysis of channel 2… 

Query: :CALC2:OSCA:STAT? 

Related Keys: Analysis → OSC Analysis → State 

10.4.2.68 :CALC<Ch>:PAR:COUN 

Description: Set and query the number of traces of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:PARameter:COUNt <1|2|3|4> 
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Query Format: :CALCulate<Ch>:PARameter:COUNt? 

Query Response: {1|2|3|4}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 4 

Preset Value: 2 

Example: To set the number of traces of channel 1 to 4… 

Command: :CALC1:PAR:COUN 4 

Example: To query the number of traces of channel 2… 

Query: :CALC2:PAR:COUN? 

Related Keys: Display → Num of Traces 

10.4.2.69 :CALC<Ch>:PAR<Tr>:DEF 

Description: Set and query the measurement parameters of the selected trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:PARameter<Tr>:DEFine {Z|Y|R|X|G|B|LS|LP|CS|CP|RS|RP|Q|D|TZR| 

TZD|TYR |TYD|VAC|IAC} 

Query Format: :CALCulate<Ch>:PARameter<Tr>:DEFine? 

Query Response: {Z|Y|R|X|G|B|LS|LP|CS|CP|RS|RP|Q|D|TZR|TZD|TYR|TYD|VAC|IAC|ER|ER1|ER2|U1| 

U2|TAN} <newline> <^END> 

Parameters: 

Data Type: String 

Data Range: Z = Absolute Impedance Value 

 Y = Absolute Admittance Value 

 TZR = Impedance Phase (Radian) 

 TZD = Impedance Phase (Angle) 

 TYR = Admittance Phase (Radian) 

 TYD = Admittance Phase (Angle) 

 RS = Equivalent Circuit Series Resistance 

 RP = Equivalent Circuit Parallel Resistance 

 LS = Equivalent Circuit Series Inductance 

 LP = Equivalent Circuit Parallel Inductance 

 CS = Equivalent Circuit Series Capacitance 

 CP = Equivalent Circuit Parallel Capacitance 

 R = Equivalent Circuit Resistance 

 G = Equivalent Circuit Conductance 

 X = Equivalent Circuit Reactance 

 B = Equivalent Circuit Susceptance 
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 Q = Quality Factor 

 D = Dissipation Factor 

 VAC = Signal Source AC Voltage 

 IAC = Signal Source AC Current 

 IMP = Complex Z 

 ADM = Complex Y 

 ER = Relative Permittivity |εr| (requires permittivity module support) 

 ER1 = Relative Permittivity Real Part εr' (requires permittivity module support) 

 ER2 = Relative Permittivity Imaginary Part εr'' (requires permittivity module support) 

 U1 = Complex Permeability Real Part μ' (requires troidal core module support) 

 U2 = Complex Permeability Imaginary Part μ'' (requires troidal core module support) 

 TAN = Phase Tan δ (requires troidal core module support) 

Example: To set the measurement parameters of channel 1 trace 1 to the equivalent series resistance… 

Command: :CALC1:PAR1:DEF RS 

Example: To query the measurement parameters of channel 2 trace 2… 

Query: :CALC2:PAR2:DEF? 

Related Keys: Meas → Trace 1 | Trace 2 | Trace 3 | Trace 4 

10.4.2.70 :CALC<Ch>:PAR<Tr>:SEL 

Description: Set the selected trace of the selected channel as the active trace. 

Command Type: Command 

Syntax: 

Command Format: :CALCulate<Ch>:PARameter<Tr>:SELect 

Example: To set the channel 1 trace 1 to active trace… 

Command: :CALC1:PAR1:SEL 

10.4.2.71 :CALC<Ch>:PERM:A1 

Description: Set and query the electrode in the calculation of the permittivity of the selected channel; this command must be 

enabled with the permittivity permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:PERMittivity:A1 {ON|OFF|1|0} 

Query Format: :CALCulate<Ch>:PERMittivity:A1? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF (Electrode is A2) 

 1 = ON (Electrode is A1) 
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Preset Value: ON 

Example: To set the electrode of channel 1 to A1… 

Command: :CALC1:PERM:A1 ON 

Example: To query the electrode of channel 2… 

Query: :CALC2:PERM:A1? 

Related Keys: Meas → Electrode 

10.4.2.72 :CALC<Ch>:PERM:THIC 

Description: Set and query the thickness in the calculation of the permittivity of the selected channel; this command must be 

enabled with the permittivity permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch>:PERMittivity:THICkness <number> 

Query Format: :CALCulate<Ch>:PERMittivity:THICkness? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Unit: m 

Preset Value: 0.01 

Example: To set the thickness of channel 1 to 5 mm… 

Command: :CALC1:PERM:THIC 5E-3 

Example: To query the thickness of channel 2… 

Query: :CALC2:PERM:THIC? 

Related Keys: Meas → Thickness 

10.4.2.73 :CALC<Ch>:TROI:HEIG 

Description: Set and query the troidal core height in the calculation of the troidalcore of the selected channel; this command 

must be enabled with the troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch> :TROIdalcore:HEIGht? 

Query Format: :CALCulate<Ch> :TROIdalcore:HEIGht <number> 

Query Response: {<number>}<newline><^END> 
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Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.005 

Unit: m 

Example: To set the troidal core height of channel 1 to 10 mm… 

Command: :CALC1:TROI:HEIG 0.01 

Example: To query the troidal core height of channel 2… 

Query: :CALC2:TROI:HEIG? 

Related Keys: Meas → Troidal Core Height 

10.4.2.74 :CALC<Ch>:TROI:INN 

Description: Set and query the troidal core inner in the calculation of the troidalcore of the selected channel; this command 

must be enabled with the troidalcore permission before it can be used. 

Command Type: Command/Query 

Syntax: 

Command Format: :CALCulate<Ch> :TROIdalcore:INNer? 

Query Format: :CALCulate<Ch> :TROIdalcore:INNer <number> 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.008 

Unit: m 

Example: To set the troidal core inner of channel 1 to 10 mm… 

Command: :CALC1:TROI:INN 0.01 

Example: To query the troidal core inner of channel 2… 

Query: :CALC2:TROI:INN? 

Related Keys: Meas → Troidal Core Inner 

10.4.2.75 :CALC<Ch> :TROI:OUT 

Description: Set and query the troidal core outer in the calculation of the troidalcore of the selected channel; this command 

must be enabled with the troidalcore permission before it can be used. 

Command Type: Command/Query 
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Syntax: 

Command Format: :CALCulate<Ch> :TROIdalcore:OUTer? 

Query Format: :CALCulate<Ch> :TROIdalcore:OUTer <number> 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-9 ~ 999 

Preset Value: 0.015 

Unit: m 

Example: To set the troidal core outer of channel 1 to 20 mm… 

Command: :CALC1:TROI:OUT 0.02 

Example: To query the troidal core outer of channel 2… 

Query: :CALC2:TROI:OUT? 

Related Keys: Meas → Troidal Core Outer 

10.4.3 Display 

10.4.3.1 :DISP:MAX 

Description: Set and query whether the currently selected channel is in the maximum display state. When the display is 

maximized, only the selected channel will be displayed on the measurement screen. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:MAXimize {ON|OFF|1|0} 

Query Format: :DISPlay:MAXimize? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the current channel maximization display… 

Query: :DISP:MAX ON 

Example: To query the current display state… 

Query: :DISP:MAX? 

Related Keys: Channel Max 
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10.4.3.2 :DISP:SPL 

Description: Set and query the channel distribution method. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:SPLit {D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123| 

D11_23|D12_13|D1234|D1_2_3_4} 

Query Format: :DISPlay:SPLit? 

Query Response: {D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23|D12_13| 

D1234|D1_2_3_4}<newline><^END> 

 

Parameters: 

Data Type: String 

Data Range: D1 

 D1_2 

 D12 

 D1_2_3 

 D12_34 

 D1_1_2 

 D112 

 D12_33 

 D13_23 

 D123 

 D11_23 

 D12_13 

 D1234 

 D1_2_3_4 

Preset Value: D1 

Example: To set the channel distribution to D12… 

Command: :DISP:SPL D12 



ST2851 Precision Impedance Analyzer Command Reference 

v1.0 196 

Example: To query the channel distribution… 

Query: :DISP:SPL? 

Related Keys: Display → Allocate Channels 

10.4.3.3 :DISP:WIND<Ch>:ACT 

Description: Set the selected channel as the active channel. Only the currently displayed channel can be set, otherwise an 

error will be returned. 

Command Type: Command 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:ACTivate 

Related Keys: Channel Prev | Channel Next 

10.4.3.4 :DISP:WIND<Ch>:LAB 

Description: Set and query the ON/OFF status of the display of the Y-axis label of the measurement coordinate system. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:LABel {ON|OFF|1|0} 

Query Format: :DISPlay:WINDow<Ch>:LABel? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the Y-axis label display of channel 1… 

Command: :DISP:WIND1:LAB ON 

Example: To query the status of the Y-axis label of channel 2… 

Query: :DISP:WIND2:LAB? 

Related Keys: Display → Graticule Label 

10.4.3.5 :DISP:WIND<Ch>:MAX 

Description: Set and query whether the active trace of the currently selected channel is in the maximum display state. When 

it is in the maximum display, only the active traces will be displayed on the channel interface. 

Command Type: Command/Query 
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Syntax: 

Command Format: :DISPlay:WINDow<Ch>:MAXimize {ON|OFF|1|0} 

Query Format: :DISPlay:WINDow<Ch>:MAXimize? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the trace maximization display of channel 1… 

Command: :DISP:WIND1:MAX ON 

Example: To query the trace maximization status of channel 2… 

Query: :DISP:WIND2:MAX? 

Related Keys: Trace Max 

10.4.3.6 :DISP:WIND<Ch>:SPL 

Description: Set and query the distribution methods of traces in the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:SPLit {D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33| 

D13_23|D123|D11_23| D12_13|D1234|D1_2_3_4} 

Query Format: :DISPlay:WINDow<Ch>:SPLit? 

Query Response: {D1|D1_2|D12|D1_2_3|D12_34|D1_1_2|D112|D12_33|D13_23|D123|D11_23|D12_13| 

D1234|D1_2_3_4}<newline><^END> 
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Parameters: 

Data Type: String 

Data Range: D1 

 D1_2 

 D12 

 D1_2_3 

 D12_34 

 D1_1_2 

 D112 

 D12_33 

 D13_23 

 D123 

 D11_23 

 D12_13 

 D1234 

 D1_2_3_4 

Preset Value: D1 

Example: To set the trace distribution of channel 1 to D12… 

Command: :DISP:WIND1:SPL D12 

Example: To query the trace distribution of channel 2… 

Query: :DISP:WIND2:SPL? 

Related Keys: Display → Allocate Trace 

10.4.3.7 :DISP:WIND<Ch>:TRAC<Tr>:DATA 

Description: Set and query the ON/OFF status of the data trace of the selected trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:DATA[:STATe] {ON|OFF|1|0} 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:DATA[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the data trace display of channel 1 trace 1… 

Command: :DISP:WIND1:TRAC1:DATA ON 
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Example: To query the data trace display state of channel 2 trace 2… 

Query: :DISP:WIND1:TRAC1:DATA? 

Related Keys: Display → Display 

10.4.3.8 :DISP:WIND<Ch>:TRAC<Tr>:MEM 

Description: Set and query the ON/OFF status of the memory trace of the selected trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:MEMory[:STATe] {ON|OFF|1|0} 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:MEMory[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the memory trace display of channel 1 trace 1… 

Command: :DISP:WIND1:TRAC1:MEM ON 

Example: To query the memory trace display state of channel 2 trace 2… 

Query: :DISP:WIND1:TRAC1:MEM? 

Related Keys: Display → Display 

10.4.3.9 :DISP:WIND<Ch>:TRAC<Tr>:Y:AUTO 

Description: Automatically scale the Y axis of the selected trace of the selected channel. 

Command Type: Command 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:AUTO 

Related Keys: Scale → Auto Scale 

10.4.3.10 :DISP:WIND<Ch>:TRAC<Tr>:Y:BOTT 

Description: Set and query the minimum value of the selected trace of the selected channel when the vertical coordinate is 

logarithmic axis. This command will only be responded to when the vertical coordinate is logarithmic. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:BOTTom <number> 
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Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:BOTTom? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-18 ~ 1E15 

Preset Value: 10 

Unit: Depends on measurement parameters 

Example: To set the lower limit of the logarithmic axis of channel 1 trace 1 to 1000… 

Command: :DISP:WIND1:TRAC1:Y:BOTT 1E3 

Example: To query the lower limit of the logarithmic axis of channel 2 trace 2… 

Query: :DISP:WIND2:TRAC2:Y:BOTT? 

Related Keys: Scale → Log-Y Bottom 

10.4.3.11 :DISP:WIND<Ch>:TRAC<Tr>:Y:PDIV 

Description: Set and query the scale of each region of the selected trace of the selected channel when the vertical coordinate 

is linear axis. This command will only be responded to when the vertical coordinate is linear. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:PDIVision <number> 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:PDIVision? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-18 ~ 1E15 

Preset Value: 0.01 

Unit: Depends on measurement parameters 

Example: To scale the logarithmic axis division scale of channel 1 trace 1 to 10… 

Command: :DISP:WIND1:TRAC1:Y:PDIV 10 

Example: To query the division scale of channel 2 trace 2… 

Query: :DISP:WIND2:TRAC2:Y:PDIV? 

Related Keys: Scale → Scale/Div 
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10.4.3.12 :DISP:WIND<Ch>:TRAC<Tr>:Y:RLEV 

Description: Set and query the reference value of the selected trace of the selected channel when the vertical coordinate is 

linear axis. This command will only be responded to when the vertical coordinate is linear. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RLEVel <number> 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RLEVel? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -1E15 ~ 1E15 

Preset Value: 99 

Unit: Depends on measurement parameters 

Example: To set the vertical coordinate reference value of channel 1 trace 1 to 1M… 

Command: :DISP:WIND1:TRAC1:Y:RLEV 1E6 

Example: To query the vertical coordinate reference value of channel 2 trace 2… 

Query: :DISP:WIND2:TRAC2:Y:RLEV? 

Related Keys: Scale → Reference Y Value 

10.4.3.13 :DISP:WIND<Ch>:TRAC<Tr>:Y:RPOS 

Description: Set and query the relative position of selected trace of the selected channel in the vertical coordinate reference 

value on the vertical coordinate, the value can be set from 0 to the set number of vertical coordinate partitions. This command 

will only be responded to if the vertical coordinate is linear. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RPOSition <number> 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:RPOSition? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 0 ~ 30 

Preset Value: 5 

Example: To set the position of the reference value of channel 1 trace 1 to 5… 

Command: :DISP:WIND1:TRAC1:Y:RPOS 5 
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Example: To query the position of the reference value of channel 2 trace 2… 

Query: :DISP:WIND2:TRAC2:Y:RPOS? 

Related Keys: Scale → Reference Position 

10.4.3.14 :DISP:WIND<Ch>:TRAC<Tr>:Y:TOP 

Description: Set and query the maximum value of the selected trace of the selected channel when the vertical coordinate is 

logarithmic axis. This command is only responded to when the vertical coordinate is logarithmic. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:TOP <number> 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y[:SCALe]:TOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 1E-18 ~ 1E15 

Preset Value: 10k 

Unit: Depends on measurement parameters 

Example: To set the logarithmic upper limit of channel 1 trace 1 to 1M… 

Command: :DISP:WIND1:TRAC1:Y:TOP 1E9 

Example: To query the logarithmic upper limit of channel 2 trace 2… 

Query: :DISP:WIND2:TRAC2:Y:TOP? 

Related Keys: Scale → Log-Y Top 

10.4.3.15 :DISP:WIND<Ch>:TRAC<Tr>:Y:SPAC 

Description: Set and query the Y-axis type (linear/logarithmic axis) of the selected trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y:SPACing {LINear|LOGarithmic} 

Query Format: :DISPlay:WINDow<Ch>:TRACe<Tr>:Y:SPACing? 

Query Response: {LIN|LOG}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: LINear 

 LOGarithmic 

Preset Value: LINear 
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Example: To set the vertical coordinate of channel 1 trace 1 to logarithmic… 

Command: :DISP:WIND1:TRAC<Tr>:Y:SPAC LOG 

Example: To query the vertical coordinate type of channel 2 trace 2… 

Query: :DISP:WIND2:TRAC2:Y:SPAC? 

Related Keys: Format → Y-Axis 

10.4.3.16 :DISP:WIND<Ch>:X:SPAC 

Description: Set and query the type of the X-axis as frequency mode / sequential mode when the sweep type is Segment. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:X:SPACing {LINear|OBASe} 

Query Format: :DISPlay:WINDow<Ch>:X:SPACing? 

Query Response: {LIN|OBA}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: LINear = Frequency base 

 OBASe = Order base 

Preset Value: OBASe 

Example: To set the horizontal coordinate of channel 1 to frequency base… 

Command: :DISP:WIND1:X:SPAC LIN 

Example: To query the horizontal coordinate type of channel 2… 

Query: :DISP:WIND2:X:SPAC? 

Related Keys: Sweep Setup → Segment Display 

10.4.3.17 :DISP:WIND<Ch>:Y:DIV 

Description: Set and query the number of divisions of the Y-axis of the coordinate system. This command will only be re-

sponded to if the vertical coordinate is linear. 

Command Type: Command/Query 

Syntax: 

Command Format: :DISPlay:WINDow<Ch>:Y[:SCALe]:Divisions <number> 

Query Format: :DISPlay:WINDow<Ch>:Y[:SCALe]:DIVisions? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 4 ~ 30 
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Preset Value: 10 

Example: To divide the Y-axis of channel 1 into 10 divisions… 

Command: :DISP:WIND1:Y:DIV 10 

Example: To query the number of Y-axis divisions of channel 2… 

Query: :DISP:WIND2:Y:DIV? 

Related Keys: Scale → Divisions 

10.4.4 Initiation 

10.4.4.1 :INIT<Ch> 

Description: When the command is input, if the trigger state of the selected channel is in hold mode, the trigger state of the 

channel will be set to single mode for one sweep cycle; when the sweep cycle is finished, the trigger state returns to hold mode. 

If the trigger mode of this channel is not in hold mode, then return an error. 

Command Type: Command 

Syntax: 

Command Format: :INITiate<Ch>[:IMMediate] 

Related Keys: Trigger Mode → Single 

10.4.4.2 :INIT<Ch>:CONT 

Description: Set and query whether the trigger mode of the selected channel is continuous mode. 

Command Type: Command/Query 

Syntax: 

Command Format: :INITiate<Ch>:CONTinuous {ON|OFF|1|0} 

Query Format: :INITiate<Ch>:CONTinuous? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To set the trigger mode of channel 1 to continuous mode… 

Command: :INIT1:CONT ON 

Example: To query whether the trigger mode of channel 2 is continuous mode… 

Query: :INIT2:CONT? 

Related Keys: Trigger Mode → Continuous 
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10.4.5 Memory 

10.4.5.1 :MMEM:_COPY 

Description: Copy the file from file name 1 to file name 2. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:COPY "<filename1>", "<filename2>" 

Example: To copy a file from D:\temp1.txt to D:\temp2.txt… 

Command: :MMEM:COPY "D:\temp1.txt", "D:\temp2.txt" 

10.4.5.2 :MMEM:DEL 

Description: Delete the file in the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:DEL "<filename>" 

Example: To delete a file named D:\temp1.txt… 

Command: :MMEM:DEL "D:\temp1.txt" 

10.4.5.3 :MMEM:LOAD 

Description: Load the sweep state settings file of the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:LOAD[:STATe] "<filename>" 

Related Keys: Save/Recall → Recall State → Recall State 

10.4.5.4 :MMEM:LOAD:CHAN 

Description: Load the sweep channel state settings of the specified gear. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:LOAD:CHANnel[:STATe] {A|B|C|D} 

Related Keys: Save/Recall → Recall Channel 

10.4.5.5 :MMEM:LOAD:LIM 

Description: Load the sweep limit test file of the specified location. 

Command Type: Command 
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Syntax: 

Command Format: :MMEMory:LOAD:LIMit "<filename>" 

Related Keys: Analysis → Limit Test → Edit Limit Line → Import 

10.4.5.6 :MMEM:LOAD:SEGM 

Description: Load the sweep segment state settings file of the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:LOAD:SEGMemt "<filename>" 

Related Keys: Sweep Setup → Edit Frequency Segment → Import 

10.4.5.7 :MMEM:STOR 

Description: Save the sweep state settings file in the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe[:STATe] "<filename>" 

Related Keys: Save/Recall → Save State → Save State 

10.4.5.8 :MMEM:STOR:CHAN 

Description: Load the sweep channel state settings in the specified gear. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:CHANnel[:STATe] {A|B|C|D} 

Related Keys: Save/Recall → Save Channel 

10.4.5.9 :MMEM:STOR:CHAN:CLE 

Description: Clear all saved channel settings. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:CHANnel:CLEar 

Related Keys: Save/Recall → Save Channel → Clear States 
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10.4.5.10 :MMEM:STOR:EPAR 

Description: Save the equivalent circuit simulation result file in the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:EPARameters[:STATe] "<filename>" 

Related Keys: Analysis → Equivalent Circuit → Export 

10.4.5.11 :MMEM:STOR:FDAT 

Description: Save the measurement data of the current active channel of the active trace at the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:FDATa "<filename>" 

Related Keys: Save/Recall → Save Trace Data → Scope → Single 

10.4.5.12 :MMEM:STOR:IMAG 

Description: Save the screenshot of the current screen in the specified location (please do not set the file path to the root of 

the C drive). 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:IMAGe "<filename>" 

Related Keys: System → Dump Screen Image 

10.4.5.13 :MMEM:STOR:LIM 

Description: Save the sweep limit test settings file in the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:LIMit "<filename>" 

Related Keys: Analysis → Limit Test → Edit Limit Line → Export 

10.4.5.14 :MMEM:STOR:SALL 

Description: Set and query the save mode when the sweep state is saved, it only saves the currently displayed channels and 

traces, or saves all channels and traces. 

Command Type: Command/Query 

Syntax: 

Command Format: :MMEMory:STORe:SALL {ON|OFF|1|0} 
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Query Format: :MMEMory:STORe:SALL? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To set the save mode to save all channels and traces… 

Command: :MMEM:STOR:SALL ON 

Example: To query the current save mode… 

Query: :MMEM:STOR:SALL? 

Related Keys: Save/Recall → Channel/Trace 

10.4.5.15 :MMEM:STOR:SEGM 

Description: Save the sweep segment state settings file in the specified location. 

Command Type: Command 

Syntax: 

Command Format: :MMEMory:STORe:SEGMemt "<filename>" 

Related Keys: Sweep Setup → Edit Frequency Segment → Export 

10.4.5.16 :MMEM:STOR:STYP 

Description: Set and query the save range when the sweep state is saved, only the setup state is saved, or the trace data is 

also saved. 

Command Type: Command/Query 

Syntax: 

Command Format: :MMEMory:STORe:STYPe {STATe|DSTate} 

Query Format: :MMEMory:STORe:STYPe? 

Query Response: {STAT|DST}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: STATe = Save the setting state only 

 DSTate = Save both setup state and trace data 

Preset Value: STATe 

Example: To set the save scope to save the setup state and trace data… 

Command: :MMEM:STOR:STYP DST 
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Example: To query the current save scope… 

Query: :MMEM:STOR:STYP? 

Related Keys: Save/Recall → Save Type 

10.4.6 Sense 

10.4.6.1 :SENS:APER 

Description: Set and query the sweep time of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:APERture[:TIME] {1|2|3|4|5} 

Query Format: :SENSe<Ch>:APERture[:TIME]? 

Query Response: {1|2|3|4|5}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 5 

Preset Value: 1 

Example: To set the measurement time of channel 1 to 2… 

Command: :SENS1:APER 2 

Example: To query the measurement time of channel 2… 

Query: :SENS2:APER? 

Related Keys: Avg → Meas Time 

10.4.6.2 :SENS<Ch>:AVER 

Description: Set and query the point average of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:AVERage[:STATe] {ON|OFF|1|0} 

Query Format: :SENSe<Ch>:AVERage[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 
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Example: To turn on the point average of channel 1… 

Command: :SENS1:AVER ON 

Example: To query the point average ON/OFF status of channel 2… 

Query: :SENS2:AVER? 

Related Keys: Avg → Point Avg 

10.4.6.3 :SENS<Ch>:AVER:COUN 

Description: Set and query the point average count of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:AVERage:COUNt <number> 

Query Format: :SENSe<Ch>:AVERage:COUNt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 999 

Preset Value: 1 

Example: To set the point average count of channel 1 to 5… 

Command: :SENS1:AVER:COUN 5 

Example: To query the point average count of channel 2… 

Query: :SENS2:AVER:COUN? 

Related Keys: Avg → Point Avg Factor 

10.4.6.4 :SENS<Ch>:DC:MEAS:CLE 

Description: Clear the DC monitor data of the selected channel. 

Command Type: Command 

Syntax: 

Command Format: :SENSe<Ch>:DC:MEASure:CLEar 

Related Keys: Meas → DC Monitor Setup → Clear 

10.4.6.5 :SENS<Ch>:DC:MEAS:DATA:DCI 

Description: Query the DC monitor current of the specified channel 

Command Type: Query 
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Syntax: 

Query Format: :SENSe<Ch>:DC:MEASure:DATA:DCI? 

Query Response: {<number>}<newline><^END> 

10.4.6.6 :SENS<Ch>:DC:MEAS:DATA:DCV 

Description: Query the DC monitoring voltage of the specified channel. 

Command Type: Query 

Syntax: 

Query Format: :SENSe<Ch>:DC:MEASure:DATA:DCV? 

Query Response: {<number>}<newline><^END> 

10.4.6.7 :SENS<Ch>:DC:MEAS:ENAB 

Description: Set and query the ON/OFF status of DC monitor of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:DC:MEASure:ENABle {ON|OFF|1|0} 

Query Format: :SENSe<Ch>:DC:MEASure:ENABle? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the DC monitor of channel 1… 

Command: :SENS1:DC:MEAS:ENAB ON 

Example: To query the ON/OFF state of the DC monitor of channel 2… 

Query: :SENS2:DC:MEAS:ENAB? 

Related Keys: Meas → DC Monitor Setup 

10.4.6.8 :SENS<Ch>:FREQ 

Description: Set and query the CW frequency of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:FREQuency[:CW] <number> 

Query Format: :SENSe<Ch>:FREQuency[:CW]? 

Query Response: {<number>}<newline><^END> 
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Parameters: 

Data Type: Double 

Data Range: 10 ~ 130 M 

Unit: Hz 

Preset Value: 1 M 

Example: To set the CW frequency of channel 1 to 10 MHz… 

Command: :SENS1:FREQ 1E7 

Example: To query the CW frequency of channel 2… 

Query: :SENS2:FREQ? 

Related Keys: Sweep Setup → CW Frequency 

10.4.6.9 :SENS<Ch>:FREQ:CENT 

Description: Set and query the center value of the sweep frequency of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:FREQuency:CENTer <number> 

Query Format: :SENSe<Ch>:FREQuency:CENTer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 10 ~ 130 M 

Unit: Hz 

Preset Value: 50.5 k 

Example: To set the sweep frequency center value of channel 1 to 1 MHz… 

Command: :SENS1:FREQ:CENT 1E6 

Example: To query the sweep frequency center value of channel 2… 

Query: :SENS2:FREQ:CENT? 

Related Keys: Center 

10.4.6.10 :SENS<Ch>:FREQ:DATA 

Description: Query the measurement frequency of all measurement points in the specified channel. 

Command Type: Query 

Syntax: 

Query Format: :SENSe<Ch>:FREQuency:DATA? 

Query Response: {<number 1>},{<number 2>}...{<number n>}<newline><^END> 
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10.4.6.11 :SENS<Ch>:FREQ:SPAN 

Description: Set and query the span value of the sweep frequency of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:FREQuency:SPAN <number> 

Query Format: :SENSe<Ch>:FREQuency:SPAN? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 129 000 000 

Unit: Hz 

Preset Value: 99 k 

Example: To set the sweep frequency span value of channel 1 to 100 kHz… 

Command: :SENS1:FREQ:SPAN 1E5 

Example: To query the sweep frequency span value of channel 2… 

Query: :SENS2:FREQ:SPAN? 

Related Keys: Span 

10.4.6.12 :SENS<Ch>:FREQ:STAR 

Description: Set and query the start value of the sweep frequency of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:FREQuency:STARt <number> 

Query Format: :SENSe<Ch>:FREQuency:STARt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 10 ~ 130 M 

Unit: Hz 

Preset Value: 1 k 

Example: To set the sweep frequency start value of channel 1 to 1 MHz… 

Command: :SENS1:FREQ:STAR 1E6 

Example: To query the sweep frequency start value of channel 2… 

Query: :SENS2:FREQ:STAR? 

Related Keys: Start 
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10.4.6.13 :SENS<Ch>:FREQ:STOP 

Description: Set and query the termination value of the sweep frequency of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:FREQuency:STOP <number> 

Query Format: :SENSe<Ch>:FREQuency:STOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 10 ~ 130 M 

Unit: Hz 

Preset Value: 100 k 

Example: To set the sweep frequency termination value of channel 1 to 10 MHz… 

Command: :SENS1:FREQ:STOP 1E7 

Example: To query the sweep frequency termination value of channel 2… 

Query: :SENS2:FREQ:STOP? 

Related Keys: Stop 

10.4.6.14 :SENS<Ch>:SEGM:DATA 

Description: Set and query the segment setting data of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SEGMent:DATA <data> 

Query Format: :SENSe<Ch>:SEGMent:DATA? 

Query Response: {<data>}<newline><^END> 

Parameters: 

Description: Segment Settings: 

The segment setup data is arranged in the following order, N represents the number of 

segments and n represents any number between 1 and N. 

<data> = { 

• <start bit>, 

• <frequency mode>, 

• <source level setting state>, 

• <DC bias setting state>, 

• <measurement speed setting state>, 

• <average factor setting state>, 
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• <measurement time setting state>, 

• <time delay setting state>, 

• <number of segments>, 

• <segment 1 frequency>, 

• <segment 1 frequency2>, 

• <segment 1 points>, 

• [segment 1 source level mode], 

• [segment 1 source level value], 

• [segment 1 DC bias mode], 

• [segment 1 DC bias value], 

• [segment 1 measurement speed], 

• [segment 1 average count], 

• [segment 1 measurement time], 

• [segment 1 delay time], 

• ..., 

• <segment N frequency 1>, 

• <segment N frequency 2>, 

• <segment N points>, 

• [segment N source level mode], 

• [segment N source level value], 

• [segment N DC bias mode], 

• [segment N DC bias value], 

• [segment N measurement speed], 

• [segment N average count], 

• [segment N measurement time], 

• [segment N delay time]} 

The individual parameters are described below: 

• <start bit> 

Always 7 

• <frequency mode> 

0 = Frequency setting mode is start/stop 

1 = Frequency setting mode is center/span 

• <source level setting state>: Whether the source level is set for each segment 

0 = OFF 

1 = ON 

• <DC bias setting state>: Whether the DC bias is set for each segment 

0 = OFF 

1 = ON 

• <measurement speed setting state>: Whether the measurement speed is set for 

each segment 

0 = OFF 

1 = ON 

• <average count setting state>: Whether the average count is set for each segment 

0 = OFF 
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1 = ON 

• <measurement time setting state>: Whether the measurement time is set for each 

segment 

0 = OFF 

1 = ON 

• <delay setting state>: Whether the delay time is set for each segment 

0 = OFF 

1 = ON 

• <number of segments>: Total number of segments 

• <segment n frequency 1>: Segment n start frequency / center frequency, depending 

on <frequency mode> 

• <segment n frequency 2>: Segment n stop frequency / span frequency, depending 

on <frequency mode> 

• <segment n points>: Number of points in segment n (at least 1; total number of 

points in all segments between 2 ~ 1601) 

• [segment n source level mode] 

0 = Voltage Mode 

1 = Current Mode 

Not necessary to set when <source level setting state> = 0 

• [segment n source level value]: Not necessary to set when <source level setting 

state> = 0 

• [segment n DC bias mode]: DC bias mode for segment n 

0 = Voltage Mode 

1 = Current Mode 

Not necessary to set when <DC bias setting state> = 0 

• [segment n DC bias value]: Not necessary to set when <DC bias setting state> = 0 

• [segment n measurement speed]: Measurement speed (1 ~ 5) of segment n. Not 

necessary to set when <Measurement speed setting state> = 0 

• [segment n average count]: Average count of each measurement point for seg-

ment n. Not necessary to set when <Average count setting state> = 0 

• [segment n measurement time]: Not necessary to set when <measurement time 

setting state> = 0 

• [segment n delay time]: Measurement delay time of each point of segment n. Not 

necessary to set when <delay time setting state> = 0 

An error will be returned if any necessary parameters are missing or if any value is set incorrectly. 

Preset Value: 7,0,0,0,0,0,0,0,0,0,1,20,1000000,2 

Related Keys: Sweep Setup → Edit Segment Table 

10.4.6.15 :SENS<Ch>:SEGM:SWE:POIN 

Description: Query the total number of points in the segment settings of the specified channel. 

Command Type: Query 
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Syntax: 

Query Format: :SENSe<Ch>:SEGMent:SWEep:POINts? 

Query Response: {<number>}<newline><^END> 

10.4.6.16 :SENS<Ch>:SWE:DEL 

Description: Set and query the sweep delay of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SWEep:DELay <number> 

Query Format: :SENSe<Ch>:SWEep:DELay? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 30 

Preset Value: 0 

Unit: s 

Example: To set the sweep delay of channel 1 to 1 s… 

Command: :SENS1:SWE:DEL 1 

Example: To query the sweep delay of channel 2… 

Query: :SENS2:SWE:DEL? 

Related Keys: Sweep Setup → Sweep Delay 

10.4.6.17 :SENS<Ch>:SWE:DIR 

Description: Set and query the sweep direction of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SWEep:DIRection {UP|DOWN} 

Query Format: :SENSe<Ch>:SWEep:DIRection? 

Query Response: {UP|DOWN}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: UP 

 DOWN 

Preset Value: UP 
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Example: To set the sweep direction of channel 1 to DOWN… 

Command: :SENS1:SWE:DIR DOWN 

Example: To query the sweep direction of channel 2… 

Query: :SENS2:SWE:DIR? 

Related Keys: Sweep Setup → Direction 

10.4.6.18 :SENS<Ch>:SWE:PDEL 

Description: Set and query the point delay of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SWEep:PDEL <number> 

Query Format: :SENSe<Ch>:SWEep:PDEL? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 30 

Preset Value: 0 

Unit: s 

Example: To set the point delay of channel 1 to 1 s… 

Command: :SENS1:SWE:PDEL 1 

Example: To query the point delay of channel 2… 

Query: :SENS2:SWE:PDEL? 

Related Keys: Sweep Setup → Point Delay 

10.4.6.19 :SENS<Ch>:SWE:POIN 

Description: Set and query the number of measurement points of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SWEep:POINts <number> 

Query Format: :SENSe<Ch>:SWEep:POINts? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 2 ~ 1601 
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Preset Value: 201 

Example: To set the number of measurement points of channel 1 to 100… 

Command: :SENS1:SWE:POIN 100 

Example: To query the number of measurement points of channel 2… 

Query: :SENS2:SWE:POIN? 

Related Keys: Sweep Setup → Points 

10.4.6.20 :SENS<Ch>:SWE:TIME 

Description: Set and query the sweep time of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SWEep:TIME <number> 

Query Format: :SENSe<Ch>:SWEep:TIME? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 86400 

Preset Value: 0 

Unit: s 

Example: To set the measurement time of channel 1 to 10 s… 

Command: :SENS1:SWE:TIME 10 

Example: To query the measurement time of channel 2… 

Query: :SENS2:SWE:TIME? 

Related Keys: Sweep Setup → Sweep Time 

10.4.6.21 :SENS<Ch>:SWE:TYPE 

Description: Set and query the sweep type (stimulus value) of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SENSe<Ch>:SWEep:TYPE {LINear|LOGarithmic|SEGMent|POWer|BIAS|LBIas} 

Query Format: :SENSe<Ch>:SWEep:TYPE? 

Query Response: {LIN|LOG|SEGM|POW|BIAS|LBI}<newline><^END> 

Parameters: 

Data Type: String 
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Data Range: LINear = Stimulus value is linear frequency 

 LOGarithmic = Stimulus value is logarithmic frequency 

 SEGMent = Stimulus value is segment 

 POWer = Stimulus value is signal source level 

 BIAS = Stimulus value is linear DC bias 

 LogBIas = Stimulus value is logarithmic DC bias 

Preset Value: LINear 

Example: To set the sweep type of channel 1 to the signal source level… 

Command: :SENS1:SWE:TYPE POW 

Example: To query the sweep type of channel 2… 

Query: :SENS2:SWE:TYPE? 

Related Keys: Sweep Type 

10.4.7 Service 

10.4.7.1 :SERV:ACH:ACT 

Description: Set and query the currently active channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SERVice:ACHannel:ACTive <number> 

Query Format: :SERVice:ACHannel:ACTive? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 4 

Preset Value: 1 

Example: To set channel 1 as the active channel… 

Command: :SERV:ACH:ACT 1 

Example: To query the currently active channel… 

Query: :SERV:ACH:ACT? 

Related Keys: Channel Prev | Channel Next 

10.4.7.2 :SERV:ACH:COUN 

Description: Query the number of currently displayed channels. 

Command Type: Query 
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Syntax: 

Query Format: :SERVice:AChannel:COUNt? 

Query Response: {<number>}<newline><^END> 

10.4.7.3 :SERV:CHAN<Ch>:ATR:ACT 

Description: Set and query the active trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SERVice:CHANnel<Ch>:ATRace:ACTive <number> 

Query Format: :SERVice:CHANnel<Ch>:ATRace:ACTive? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 1 ~ 4 

Preset Value: 1 

Example: To set the channel 1 trace 1 as the active trace… 

Command: :SERV:CHAN1:ATR:ACT 1 

Example: To query the active trace of channel 2… 

Query: :SERV:CHAN2:ATR:ACT? 

Related Keys: Trace Prev | Trace Next 

10.4.7.4 :SERV:CHAN<Ch>:ATR:COUN 

Description: Query the number of traces of the currently selected channel. 

Command Type: Query 

Syntax: 

Query Format: :SERVice:CHANnel<Ch>:ATRace:COUNt? 

Query Response: {<number>}<newline><^END> 

10.4.7.5 :SERV:CHAN<Ch>:SEGM:DATA 

Description: Query the number of data to be set for the trace segments of the currently selected channel. 

Command Type: Query 

Syntax: 

Query Format: :SERVice:CHANnel<Ch>:SEGMent:DATA? 

Query Response: {<number>}<newline><^END> 
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10.4.7.6 :SERV:CHAN<Ch>:SWE:POIN 

Description: Query the number of measurement points in the current sweep span. 

Command Type: Query 

Syntax: 

Query Format: :SERVice:CHANnel<Ch>:SWEep:POINt? 

Query Response: {<number>}<newline><^END> 

10.4.7.7 :SERV:CHAN<Ch>:TRAC<Tr>:AMRK:ACT 

Description: Set and query the active marker of the selected trace of the selected channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SERVice:CHANnel<Ch>:TRACe<Tr>:AMRKer:ACTive <number> 

Query Format: :SERVice:CHANnel<Ch>:TRACe<Tr>:AMRKer:ACTive? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 0 ~ 10 

 0 = Marker Not Selected 

 10 = Reference Marker 

Preset Value: 0 

Example: To set the active marker of channel 1 trace 1 to 1… 

Command: :SERV:CHAN1:TRAC1:AMRK:ACT 1 

Example: To query the active marker of channel 2 trace 2… 

Query: :SERV:CHAN2:TRAC2:AMRK:ACT? 

Related Keys: Marker → Marker 1 ~ Marker 9, Reference Marker 

10.4.7.8 :SERV:SWE:FREQ:MAX 

Description: Query the maximum frequency of this machine. 

Command Type: Query 

Syntax: 

Query Format: :SERVice:SWEep:FREQuency:MAXimum? 

Query Response: {<number>}<newline><^END> 
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10.4.7.9 :SERV:SWE:FREQ:MIN 

Description: Query the minimum frequency of this machine. 

Command Type: Query 

Syntax: 

Query Format: :SERVice:SWEep:FREQuency:MINimum? 

Query Response: {<number>}<newline><^END> 

10.4.7.10 :SERV:SWE:POIN 

Description: Query the maximum number of measurement points of this machine. 

Command Type: Query 

Syntax: 

Query Format: :SERVice:SWEep:POINts? 

Query Response: {<number>}<newline><^END> 

10.4.8 Source 

10.4.8.1 :SOUR<Ch>:ALC 

Description: Set and query the ON/OFF status of automatic level control (ALC) of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:ALC[:STATe] {ON|OFF|1|0} 

Query Format: :SOURce<Ch>:ALC[:STATe]? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: ON 

Example: To turn on the ALC of channel 1… 

Command: :SOUR1:ALC 1 

Example: To query the ON/OFF status of the ALC of channel 2… 

Query: :SOUR2:ALC? 

Related Keys: Sweep Setup → OSC Level → ALC → ALC Control 
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10.4.8.2 :SOUR<Ch>:ALC:COUN 

Description: Set and query the maximum number of attempts of automatic level control of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:ALC:COUNt <number> 

Query Format: :SOURce<Ch>:ALC:COUNt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Integer 

Data Range: 2 ~ 10 

Preset Value: 10 

Example: To set the maximum number of ALC attempts of channel 1 to 10… 

Command: :SOUR1:ALC:COUN 10 

Example: To query the maximum number of ALC attempts of channel 2… 

Query: :SOUR2:ALC:COUN? 

Related Keys: Sweep Setup → OSC Level → ALC → Max Iteration 

10.4.8.3 :SOUR<Ch>:ALC:TOL 

Description: Set and query the target accuracy of automatic level control of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:ALC:TOLerance <Value> 

Query Format: :SOURce<Ch>:ALC:TOLerance? 

Query Response: <number><newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.05 ~ 10 

Preset Value: 5 

Unit: % 

Example: To set the ALC target accuracy of channel 1 to 1 %… 

Command: :SOUR1:ALC:TOL 1 

Example: To query the ALC target accuracy of channel 2… 

Query: :SOUR2:ALC:TOL? 

Related Keys: Sweep Setup → OSC Level → ALC → Target % 
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10.4.8.4 :SOUR<Ch>:BIAS:CURR:AMPL 

Description: Set and query the DC bias current output of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:CURRent[:LEVel][:IMMediate]:AMPLitude <number> 

Query Format: :SOURce<Ch>:BIAS:CURRent[:LEVel][:IMMediate]:AMPLitude? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -0.1 ~ 0.1 

Preset Value: 0 

Unit: A 

Example: To set the bias current of channel 1 to 0.1 A… 

Command: :SOUR1:BIAS:CURR:AMPL 0.1 

Example: To query the bias current of channel 2… 

Query: :SOUR2:BIAS:CURR:AMPL? 

Related Keys: Sweep Setup → DC Bias → Current Level 

10.4.8.5 :SOUR<Ch>:BIAS:CURR:CENT 

Description: Set and query the center value of the bias current of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:CURRent:CENTer <number> 

Query Format: :SOURce<Ch>:BIAS:CURRent:CENTer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -0.1 ~ 0.1 

Preset Value: 0 

Unit: A 

Example: To set the bias current center value of channel 1 to 0.1 A… 

Command: :SOUR1:BIAS:CURR:CENT 0.1 

Example: To query the bias current center value of channel 2… 

Query: :SOUR2:BIAS:CURR:CENT? 

Related Keys: Center (Sweep mode is DC bias) 
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10.4.8.6 :SOUR<Ch>:BIAS:CURR:SPAN 

Description: Set and query the span value of the bias current of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:CURRent:SPAN <number> 

Query Format: :SOURce<Ch>:BIAS:CURRent:SPAN? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 0.2 

Preset Value: 0 

Unit: A 

Example: To set the bias current span value of channel 1 to 0.1 A… 

Command: :SOUR1:BIAS:CURR:SPAN 0.1 

Example: To query the bias current span value of channel 2… 

Query: :SOUR2:BIAS:CURR:SPAN? 

Related Keys: Span (Sweep mode is DC bias) 

10.4.8.7 :SOUR<Ch>:BIAS:CURR:STAR 

Description: Set and query the start value of the bias current of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:CURRent:STARt <number> 

Query Format: :SOURce<Ch>:BIAS:CURRent:STARt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -0.1 ~ 0.1 

Preset Value: 0 

Unit: A 

Example: To set the bias current start value of channel 1 to 0.1 A… 

Command: :SOUR1:BIAS:CURR:STAR 0.1 

Example: To query the bias current start value of channel 2… 

Query: :SOUR2:BIAS:CURR:STAR? 

Related Keys: Start (Sweep mode is DC bias) 
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10.4.8.8 :SOUR<Ch>:BIAS:CURR:STOP 

Description: Set and query the bias current termination value of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:CURRent:STOP <number> 

Query Format: :SOURce<Ch>:BIAS:CURRent:STOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -0.1 ~ 0.1 

Preset Value: 0 

Unit: A 

Example: To set the bias current termination value of channel 1 to -0.1 A… 

Command: :SOUR1:BIAS:CURR:STOP -0.1 

Example: To query the bias current termination value of channel 2… 

Query: :SOUR2:BIAS:CURR:STOP? 

Related Keys: Stop (Sweep mode is DC bias) 

10.4.8.9 :SOUR<Ch>:BIAS:DEL 

Description: Set and query the bias delay of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:DELay <Value> 

Query Format: :SOURce<Ch>:BIAS:DELay? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 30 

Preset Value: 0 

Unit: s 

Example: To set the bias delay of channel 1 to 100 ms… 

Command: :SOUR1:BIAS:DEL 0.1 

Example: To query the bias delay of channel 2… 

Query: :SOUR2:BIAS:DEL? 

Related Keys: Sweep Setup → DC Bias → Bias Delay 
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10.4.8.10 :SOUR<Ch>:BIAS:MODE 

Description: Set and query the DC bias mode of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:MODE {VOLTage|CURRent} 

Query Format: :SOURce<Ch>:BIAS:MODE? 

Query Response: {VOLT|CURR}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: VOLT = Voltage Mode 

 CURR = Current Mode 

Preset Value: VOLT 

Example: To set the DC bias mode of channel 1 to voltage mode… 

Command: :SOUR1:BIAS:MODE VOLT 

Example: To query the DC bias mode of channel 2… 

Query: :SOUR2:BIAS:MODE? 

Related Keys: Sweep Setup → DC Bias → DC Bias Mode 

10.4.8.11 :SOUR<Ch>:BIAS:RANG 

Description: Set and query the DC bias range of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:RANGe {M1|M10|M100} 

Query Format: :SOURce<Ch>:BIAS:RANGe? 

Query Response: {M1|M10|M100}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: M1 = 1 mA 

 M10 = 10 mA 

 M100 = 100 mA 

Preset Value: M1 

Example: To set the DC bias range of channel 1 to 1 mA… 

Command: :SOUR1:BIAS:RANG M1 

Example: To query the DC bias range of channel 2… 

Query: :SOUR2:BIAS:RANG? 

Related Keys: Sweep Setup → DC Bias → Meas Data Range 
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10.4.8.12 :SOUR<Ch> :BIAS:STAT 

Description: Set and query the ON/OFF status of the DC bias of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:STATe {ON|OFF|1|0} 

Query Format: :SOURce<Ch>:BIAS:STATe? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the DC bias of channel 1… 

Command: :SOURce1:BIAS:STAT ON 

Example: To query the ON/OFF status of the DC bias of channel 2… 

Query: :SOURce2:BIAS:STAT? 

Related Keys: Sweep Setup → DC Bias → DC Bias State 

10.4.8.13 :SOUR<Ch>:BIAS:VOLT:AMPL 

Description: Set and query the DC bias voltage output of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:VOLTage[:LEVel][:IMMediate]:AMPLitude <number> 

Query Format: :SOURce<Ch>:BIAS:VOLTage [:LEVel][:IMMediate]:AMPLitude? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -40 ~ 40 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage of channel 1 to 1 V… 

Command: :SOUR1:BIAS:VOLT:AMPL 1 

Example: To query the bias voltage of channel 2… 

Query: :SOUR2:BIAS:VOLT:AMPL? 

Related Keys: Sweep Setup → DC Bias → Voltage Level 
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10.4.8.14 :SOUR<Ch>:BIAS:VOLT:CENT 

Description: Set and query the center value of the bias voltage of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:VOLTage:CENTer <number> 

Query Format: :SOURce<Ch>:BIAS:VOLTage:CENTer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -40 ~ 40 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage center value of channel 1 to 1 V… 

Command: :SOUR1:BIAS:VOLT:CENT 1 

Example: To query the bias voltage center value of channel 2… 

Query: :SOUR2:BIAS:VOLT:CENT? 

Related Keys: Center (Sweep mode is DC bias) 

10.4.8.15 :SOUR<Ch>:BIAS:VOLT:SPAN 

Description: Set and query the span value of the bias voltage of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:VOLTage:SPAN <number> 

Query Format: :SOURce<Ch>:BIAS:VOLTage:SPAN? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 80 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage span value of channel 1 to 10 V… 

Command: :SOUR1:BIAS:VOLT:SPAN 10 

Example: To query the bias voltage span value of channel 2… 

Query: :SOUR2:BIAS:VOLT:SPAN? 

Related Keys: Span (Sweep mode is DC bias) 
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10.4.8.16 :SOUR<Ch>:BIAS:VOLT:STAR 

Description: Set and query the start value of the bias voltage of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:VOLTage:STARt <number> 

Query Format: :SOURce<Ch>:BIAS:VOLTage:STARt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -40 ~ 40 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage start value of channel 1 to -1 V… 

Command: :SOUR1:BIAS:VOLT:STAR -1 

Example: To query the bias voltage start value of channel 2… 

Query: :SOUR2:BIAS:VOLT:STAR? 

Related Keys: Start (Sweep mode is DC bias) 

10.4.8.17 :SOUR<Ch>:BIAS:VOLT:STOP 

Description: Set and query the bias voltage termination value of the specified channel when the stimulus value is DC bias. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:BIAS:VOLTage:STOP <number> 

Query Format: :SOURce<Ch>:BIAS:VOLTage:STOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: -40 ~ 40 

Preset Value: 0 

Unit: V 

Example: To set the bias voltage termination value of channel 1 to 1 V… 

Command: :SOUR1:BIAS:VOLTage:STOP 1 

Example: To query the bias voltage termination value of channel 2… 

Query: :SOUR2:BIAS:VOLTage:STOP? 

Related Keys: Stop (Sweep mode is DC bias) 
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10.4.8.18 :SOUR<Ch>:CURR 

Description: Set and query the signal source current output of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:CURRent[:LEVel][:IMMediate][:AMPLitude] <number> 

Query Format: :SOURce<Ch>:CURRent[:LEVel][:IMMediate][:AMPLitude]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.0002 ~ 0.02 

Preset Value: 0.02 

Unit: A 

Example: To set the signal source current of channel 1 to 10 mA… 

Command: :SOUR1:CURR 0.01 

Example: To query the signal source current of channel 2… 

Query: :SOUR2:CURR? 

Related Keys: Sweep Setup → OSC Level → Current Level 

10.4.8.19 :SOUR<Ch>:CURR:CENT 

Description: Set and query the center value of the signal source current of the specified channel when the stimulus value is 

signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:CURRent:CENTer <number> 

Query Format: :SOURce<Ch>:CURRent:CENTer? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.0002 ~ 0.02 

Preset Value: 0.0101 

Unit: A 

Example: To set the center value of the signal source current of channel 1 to 1 mA… 

Command: :SOUR1:CURR:CENT 1E-3 
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Example: To query the center value of the signal source current of channel 2… 

Query: :SOUR2:CURR:CENT? 

Related Keys: Center (Sweep mode is signal source level) 

10.4.8.20 :SOUR<Ch>:CURR:SPAN 

Description: Set and query the span value of the signal source current of the specified channel when the stimulus value is 

signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:CURRent:SPAN <number> 

Query Format: :SOURce<Ch>:CURRent:SPAN? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 0.0198 

Preset Value: 0.0198 

Unit: A 

Example: To set the span value of the signal source current of channel 1 to 10 mA… 

Command: :SOUR1:CURR:SPAN 0.01 

Example: To query the span value of the signal source current of channel 2… 

Query: :SOUR2:CURR:SPAN? 

Related Keys: Span (Sweep mode is signal source level) 

10.4.8.21 :SOUR<Ch>:CURR:STAR 

Description: Set and query the start value of the signal source current of the specified channel when the stimulus value is 

signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:CURRent:STARt <number> 

Query Format: :SOURce<Ch>:CURRent:STARt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.0002 ~ 0.02 

Preset Value: 0.0002 

Unit: A 
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Example: To set the start value of signal source current of channel 1 to 1 mA… 

Command: :SOUR1:CURR:STAR 1E-3 

Example: To query the start value of signal source current of channel 2… 

Query: :SOUR2:CURR:STAR? 

Related Keys: Start (Sweep mode is signal source level) 

10.4.8.22 :SOUR<Ch>:CURR:STOP 

Description: Set and query the termination value of the signal source current of the specified channel when the stimulus value 

is signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:CURRent:STOP <number> 

Query Format: :SOURce<Ch>:CURRent:STOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.0002 ~ 0.02 

Preset Value: 0.02 

Unit: A 

Example: To set the termination value of the signal source current of channel 1 to 10 mA… 

Command: :SOUR1:CURR:STOP 0.01 

Example: To query the termination value of the signal source current of channel 2… 

Query: :SOUR2:CURR:STOP? 

Related Keys: Stop (Sweep mode is DC bias) 

10.4.8.23 :SOUR<Ch>:MODE 

Description: Set and query the signal source mode of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:MODE {VOLTage|CURRent} 

Query Format: :SOURce<Ch>:MODE? 

Query Response: {VOLT|CURR}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: VOLT = Voltage Mode 
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 CURR = Current Mode 

Preset Value: VOLT 

Example: To set the signal source mode of channel 1 to voltage mode… 

Command: :SOUR1:MODE VOLT 

Example: To query the signal source mode of channel 2… 

Query: :SOUR2:MODE? 

Related Keys: Sweep Setup → OSC Level → OSC Unit 

10.4.8.24 :SOUR<Ch>:VOLT 

Description: Set and query the signal source voltage output of the specified channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:VOLTage[:LEVel][:IMMediate][:AMPLitude] <number> 

Query Format: :SOURce<Ch>:VOLTage[:LEVel][:IMMediate][:AMPLitude]? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.005 ~ 1 

Preset Value: 0.5 

Unit: V 

Example: To set the signal source voltage of channel 1 to 100 mV… 

Command: :SOUR1:VOLT 0.1 

Example: To query the signal source voltage of channel 2… 

Query: :SOUR2:VOLT? 

Related Keys: Sweep Setup → OSC Level → Voltage Level 

10.4.8.25 :SOUR<Ch>:VOLT:CENT 

Description: Set and query the center value of the signal source voltage of the specified channel when the stimulus value is 

signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:VOLTage:CENTer <number> 

Query Format: :SOURce<Ch>:VOLTage:CENTer? 

Query Response: {<number>}<newline><^END> 
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Parameters: 

Data Type: Double 

Data Range: 0.005 ~ 1 

Preset Value: 0.5025 

Unit: V 

Example: To set the center value of the signal source voltage of channel 1 to 100 mV… 

Command: :SOUR1:VOLT:CENT 0.1 

Example: To query the center value of the signal source voltage of channel 2… 

Query: :SOUR2:CURR:CENT? 

Query Response: {<number>}<newline><^END> 

Related Keys: Center (Sweep mode is signal source level) 

10.4.8.26 :SOUR<Ch>:VOLT:SPAN 

Description: Set and query the span value of the signal source voltage of the specified channel when the stimulus value is 

signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:VOLTage:SPAN <number> 

Query Format: :SOURce<Ch>:VOLTage:SPAN? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 0.995 

Preset Value: 0.995 

Unit: V 

Example: To set the span value of the signal source voltage of channel 1 to 500 mV… 

Command: :SOUR1:VOLT:SPAN 0.5 

Example: To query the span value of the signal source voltage of channel 2… 

Query: :SOUR2:VOLT:SPAN? 

Related Keys: Span (Sweep mode is signal source level) 

10.4.8.27 :SOUR<Ch>:VOLT:STAR 

Description: Set and query the start value of the signal source voltage of the specified channel when the stimulus value is 

signal source level. 

Command Type: Command/Query 
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Syntax: 

Command Format: :SOURce<Ch>:VOLTage:STARt <number> 

Query Format: :SOURce<Ch>:VOLTage:STARt? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.005 ~ 1 

Preset Value: 0.005 

Unit: V 

Example: To set the start value of the signal source voltage of channel 1 to 10 mV… 

Command: :SOUR1:VOLT:STAR 0.01 

Example: To query the start value of the signal source voltage of channel 2… 

Query: :SOUR2:VOLT:STAR? 

Related Keys: Start (Sweep mode is signal source level) 

10.4.8.28 :SOUR<Ch>:VOLT:STOP 

Description: Set and query the termination value of the signal source voltage of the specified channel when the stimulus value 

is signal source level. 

Command Type: Command/Query 

Syntax: 

Command Format: :SOURce<Ch>:VOLTage:STOP <number> 

Query Format: :SOURce<Ch>:VOLTage:STOP? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0.005 ~ 1 

Preset Value: 1 

Unit: V 

Example: To set the termination value of the signal source voltage of channel 1 to 100 mV… 

Command: :SOUR1:VOLT:STOP 0.1 

Example: To query the termination value of the signal source voltage of channel 2… 

Query: :SOUR2:VOLT:STOP? 

Related Keys: Stop (Sweep mode is DC bias) 
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10.4.9 Trigger 

10.4.9.1 :TRIG 

Description: When the trigger source is manual trigger and the trigger mode is not hold mode, a measurement is triggered. 

Command Type: Command 

Syntax: 

Command Format: :TRIGger 

10.4.9.2 :TRIG:AVER 

Description: Set and query the ON/OFF status of the average trigger of the current channel. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger[:SEQuence]:AVERage {ON|OFF|1|0} 

Query Format: :TRIGger[:SEQuence]:AVERage? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 

Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the average trigger… 

Command: :TRIG:AVER ON 

Example: To query the ON/OFF status of the average trigger… 

Query: :TRIG:AVER? 

Related Keys: Avg → Avg Trigger 

10.4.9.3 :TRIG:POIN 

Description: Set and query the ON/OFF status of the point-by-point trigger mode. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger[:SEQuence]:POINt {ON|OFF|1|0} 

Query Format: :TRIGger[:SEQuence]:POINt? 

Query Response: {1|0}<newline><^END> 

Parameters: 

Data Type: Boolean 
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Data Range: 0 = OFF 

 1 = ON 

Preset Value: OFF 

Example: To turn on the point-by-point trigger… 

Command: :TRIG:POIN ON 

Example: To query the ON/OFF status of the point-by-point trigger… 

Query: :TRIG:POIN? 

Related Keys: Trigger Mode → Trigger Event 

10.4.9.4 :TRIG:EXT:DEL 

Description: Set and query the trigger delay of the external trigger. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger[:SEQuence]:EXTernal:DELay <number> 

Query Format: :TRIGger[:SEQuence]:EXTernal:DELay? 

Query Response: {<number>}<newline><^END> 

Parameters: 

Data Type: Double 

Data Range: 0 ~ 10 

Preset Value: 0 

Unit: s 

Example: To set the trigger delay to 1 ms… 

Command: :TRIG:EXT:DEL 1E-3 

Example: To query the trigger delay… 

Query: :TRIG:EXT:DEL? 

Related Keys: Trigger Mode → Trigger Delay 

10.4.9.5 :TRIG:SOUR 

Description: Set and query the trigger source of the sweep mode. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger[:SEQuence]:SOURce {INTernal|EXTernal|MANual|BUS} 

Query Format: :TRIGger[:SEQuence]:SOURce? 

Query Response: {INT|MAN|EXT|BUS}<newline><^END> 
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Parameters: 

Data Type: String 

Data Range: INTernal = Internal Trigger 

 MANual = Manual Trigger 

 EXTernal = External Trigger 

 BUS = Bus Trigger 

Preset Value: INTernal 

Example: To set the trigger source to manual mode… 

Command: :TRIG:SOUR INT 

Example: To query the trigger source… 

Query: :TRIG:SOUR? 

Related Keys: Trigger Mode → Trigger Source 

10.4.9.6 :TRIG:SCOP 

Description: Set and query the trigger scope for all channels in turn or only the active channels. 

Command Type: Command/Query 

Syntax: 

Command Format: :TRIGger[:SEQuence]:SCOPe {ALL|ACTive} 

Query Format: :TRIGger[:SEQuence]:SCOPe? 

Query Response: {ALL|ACTive}<newline><^END> 

Parameters: 

Data Type: String 

Data Range: ALL = Trigger All Channels 

 ACTive = Trigger the Active Channel Only 

Preset Value: ALL 

Example: To set the trigger scope to all channels… 

Command: :TRIG:SCOP ALL 

Example: To query the trigger scope… 

Query: :TRIG:SCOP? 

Related Keys: Trigger Mode → Trigger Scope 

10.4.9.7 :TRIG:SING 

Description: When the trigger source is bus trigger and the trigger mode is not hold mode, immediately trigger a measurement. 

Command Type: Command 

Syntax: 

Command Format: :TRIGger[:SEQuence]:SINGle 
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11 Handler Instructions 
ST2851 provides users with Handler interface, which is mainly used for the output of instrument sorting results. When the 

instrument is used in the automatic component sorting test system, this interface provides the communication signal with the 

system and the sorting result output signal. The sorting result output varies depending on the measurement mode. 

The Handler interface design is flexible. After using different operating procedures, all output signal states are defined according 

to the usage requirements. 

11.1 Definition Description 

The information provided in this chapter includes the necessary description of the signal lines and electrical characteristics for 

using the Handler interface. 

11.1.1 Signal Line Definition 

The Handler interface uses three signals: sorting output, control input, and control output. The signal lines of the sorting function 

in different measurement modes are respectively defined as different sorting output signals and control input signals. The 

following are the signal definitions of the Handler interface when the sorting function is used. 

PIN Name Description 

1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

/BIN1 

/BIN2 

/BIN3 

/BIN4 

/BIN5 

/BIN6 

/BIN7 

/BIN8 

/BIN9 

/OUT 

Sorting result output 

11 /AUX_ List scan sorting result output 

12 

13 
/EXT.TRIG_ 

External Trigger: 

When the trigger mode is set to EXT.TRIG (external trigger), the instrument is triggered by 

the rising edge pulse signal applied to this pin. 

14 

15 
/EXT.DCV2 

External DC Voltage 2: 

The DC power supply pin for the photoelectrically coupled signals (/EXT_TRIG, /ALARM, 

/INDEX, /EOM, / KEY LOCK) in the instrument. 

16 

17 

18 

+ 5 V 

Instrument internal power supply + 5 V: 

Generally, users are not recommended to use the power supply inside the instrument. If it 

must be used, please ensure that the current used is less than 0.3 A, and the signal line 

should be kept away from the interference source. 

19 

20 

21 

/PHI 

/PLO 

/SREJ 

List scan sorting result output 



ST2851 Precision Impedance Analyzer Handler Instructions 

v1.0 242 

22 

23 

/SHI 

/SIN 

24 /SLO The sorting measurement result is invalid (Invalid) output 

25 /KEYLOCK Spare input pin 

26 NC No connection 

27 

28 
/EXT.DCV1 

External DC Voltage 1: 

Pull-up DC power supply pin for photoelectrically coupled signals (/BIN-/BIN9, /AUX, /OUT, 

/PHI, /PLO, /SREJ) in the instrument. 

29 /ALARM When a power-down occurs, /ALARM is active. 

30 /INDEX 

The /INDEX signal is valid when the analog measurement is completed and the instrument 

can connect the next device under test (DUT) at the UNKNOWN test terminal. However, 

the comparison result signal is not active until /EOM is active. 

31 /EOM 

End of Measurement: 

This signal is valid when the measurement data and comparison result are valid. 

32 

33 
COM2 Ground reference used by external power supply EXTV2 

34 

35 

36 

COM1 Reference used by external power supply EXTV1 
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11.1.1.1 Signal Definition for Single Point Measurement 

Sorting Signal Output: 

• /BIN1 ~ /BIN9 

• /OUT 

• /SLO (abnormal measurement result) 

Control Signal Output: 

• /INDEX (analog measurement completion signal) 

• /EOM (measurement end and comparison data valid signal) 

• /ALARM (instrument power-down signal) 

Control Signal Input: 

• /EXT.TRIG (external trigger signal) 

• /KEYLOCK 

The timing diagram is shown below: 

 

Time Minimum Value Maximum Value 

T1 Trigger Pulse Width 1 μs — 

T2 Measurement Start Delay Time 200 μs Display Time + 200 μs 

T3 Trigger Delay Time After /EOM Output 0 μs — 

1) Refer to the operation manual of this instrument for measurement time. 

2) The typical comparison time is about 1 ms. 

3) The typical display time of each display page is as follows: 

• Component Measurement Display Page: about 8 ms 

• Sorting Display Page: about 5 ms 

• Sorting Count Display Page: about 0.5 ms 
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11.1.1.2 Signal Definition for List Scan 

The function signal definition of list scan is different from the definition in point test function. Its definition is as follows: 

Sorting Signal Output: 

• /BIN1 ~ /BIN9 

• /AUX (BIN10) 

• /OUT 

• /PHI (BIN11) 

• /PLO (BIN12) 

• /SREJ (BIN13) 

• /SHI (BIN14) 

• /SIN (BIN15) 

• /SLO (measurement result abnormal/out of tolerance) 

The sorting result will be output after the entire list scan measurement is completed. 

Control Signal Output: 

• /INDEX (analog measurement completion signal) 

• /EOM (measurement end and comparison data valid signal) 

• /ALARM (instrument power-down signal) 

Among them, the /INDEX signal is asserted when the analog measurement of the last sweep point is completed. The /EOM 

signal is asserted when all sorting results are valid after the entire list scan measurement is complete. 

Control Signal Input: 

• /EXT.TRIG (external trigger signal) 

• /KEYLOCK 

The timing diagram is shown in the following figure: 

 

T1, T2, T3: Please refer to the definition of spot measurement. 

11.1.1.3 Signal Definition for Curve Sweep 

The signal definition of curve sweep function differs from that of point measurement and list function. Its definition is as follows: 

Sorting Signal Output: 

• /BIN1 ~ /BIN4 are the output of the current scan channel's curve 1 ~ curve 4 sorting pass; 

• /BIN5 ~ /BIN8 are the current scan channel's curve 1 ~ curve 4 sorting fail output. 
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Control Signal Output: 

• /INDEX (analog measurement completion signal) 

• /EOM (measurement end and comparison data valid signal) 

• /ALARM (instrument power-down signal) 

Among them, the /INDEX signal is asserted when the analog measurement of the last sweep point is completed. The /EOM 

signal is asserted when all sorting results are valid after the entire list scan measurement is complete. 

Control Signal Input: 

• /EXT.TRIG (external trigger signal) 

• /KEYLOCK 

The timing diagram is shown in the following figure: 

 

T1, T2, T3: Please refer to the definition of spot measurement. 

11.1.2 Electrical Characteristic 

As mentioned earlier, the definition of a signal differs in different measurement modes, but the electrical characteristics of the 

signal are consistent. The following description therefore applies to all measurement modes. 

DC Isolated Outputs: Each DC output (PINs 1 ~ 16) is isolated via an open collector optocoupler output. The output voltage 

of each line is set by a pull-up resistor on the Handler interface board. Pull-up resistor and internally supplied voltage (+5 V) 

connection or connect with external supply voltage (EXTV: +5 V) via jumper. 

The electrical characteristics of the DC isolated output are divided into two types, as shown in the table below: 

Output Signal 

Output Rated Voltage 

Maximum Current Circuit Reference Ground 

LOW HIGH 

Sorting Signal 

/BIN1 ~ /BIN9 

/AUX 

/OUT 

/PHI 

/PLO 

≤ 0.5 V +5 V ~ +24 V 6 mA 
Internal Pull-Up Voltage: Measuring Instrument 

External Voltage (EXTV1): COM1 

Control Signal 

/INDEX 

/EOM 

/ALARM 

≤ 0.5 V +5 V ~ +24 V 5 mA 
Internal Pull-up Voltage: Measuring Instrument 

External Voltage (EXTV2): COM2 
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11.2 Handler Interface Board Circuit 

Sorting Result Signal Output Circuit: 
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JP2 JP1 

+5 V 

JP3 

ST2851Common 

EXT.DCV1 
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/BIN1 
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Control Signal Output Circuit: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Control Signal Input Circuit: 
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JP5 JP4 

+5 V 

EXT.DCV2 
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ST2851 Common 
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12 Technical Description 

12.1 Definition 

Technical Indicators: 

Guaranteed performance. All specifications are at 23°C (±5°C) unless otherwise noted and it is valid within the temperature 

range and the instrument has been warmed up for 90 minutes. Specifications include guard bands, which take into account 

expected statistical performance distributions, measurement uncertainty, and performance variations due to environmental 

conditions. 

Typical Value: 

Expected performance of typical devices, excluding guard bands. Typical values are not covered by the product warranty. 

General Features: 

A generic descriptive term that does not indicate a level of performance. 

12.2 Basic Measurement Feature 

12.2.1 Measurement Parameters 

Impedance Parameter |Z|, θz, |Y|, θy, Cp, Cs, Lp, Ls, Rp, Rs, D, Q, R, X, G, B, DCR 

Level Monitoring V AC, I AC, V DC, I DC 

12.2.2 Measurement Terminal 

Configuration Four-terminal pair configuration 

Connector Type Four BNC (female) connectors 

12.3 Signal Source Characteristics 

12.3.1 Frequency 

Scope 

• 10 Hz ~ 130 MHz (Model ST2851-130) 

• 10 Hz ~ 80 MHz (Model ST2851-80) 

• 10 Hz ~ 50 MHz (Model ST2851-50) 

• 10 Hz ~ 30 MHz (Model ST2851-30) 

• 10 Hz ~ 15 MHz (Model ST2851-15) 

Resolution 1 MHz 

Relative Error ± 0.0007 % (at 5 ~ 40 °C temperature range, typical) 

12.3.2 Voltage Signal Level 

Scope 
5 mVrms ~ 1 Vrms (output resistance 25 Ω) 

5 mVrms ~ 2 Vrms (output internal resistance 100 Ω and test frequency ≤1 MHz) 

Resolution 1 mV 
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Precision 

At the test port of ST2851: 

± [(10 + 0.05 × f) % + 1 mV] (typ., output resistance 25 Ω) 

± [(10 + 0.5 × f) % + 1 mV] (typ., output resistance 100 Ω) 

Note: 

1) f = frequency [MHz]. 

2) The above characteristics apply when all ports are open. 

3) When the DUT impedance is ≤ 50 Ω, the test signal level should be ≤ 0.5 Vrms. 

4) When the temperature exceeds 23 ± 5 °C, the test signal level setting accuracy is half the described value. 

12.3.3 Current Signal Level 

Scope 50 μArms ~ 20 mArms 

Resolution 10 μA 

Precision 
± [(10 + 0.3 × f) % + 50 μA] (typ., output resistance 25 Ω) 

± [(10 + 0.5 × f) % + 50 μA] (typ., output resistance 100 Ω) 

Note: 

1) f = frequency [MHz] 

2) The above characteristics apply when all ports are open. 

3) When the DUT impedance is ≤ 50 Ω, the test signal level should be ≤ 0.5 Vrms. 

4) When the temperature exceeds 23 ± 5 °C, the test signal level setting accuracy is half the described value. 

12.3.4 Signal Level Detection 

Voltage Range 5 mVrms ~ 2 Vrms 

Level Detection Accuracy ± (10 + 0.05 × f + 100 / Zx) [%] (typ.) 

Current Range 200 μArms ~ 20 mArms 

Current Detection Accuracy ± (10 + 0.05 × f + 100 / Zx) [%] (typ.) 

Note: 

1) f = frequency [MHz] 

2) Zx = Impedance Test Value [Ω] 

3) When the temperature exceeds 23 ± 5 °C, the test signal current setting accuracy is half the described value. 

12.3.5 Output Impedance 

25 Ω / 100 Ω (typ.) 
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12.3.6 DC Bias Function 

DC Voltage Bias Range 

Scope 0 ~ ± 40 V 

Resolution 1 mV 

Precision 
± [0.1 % + (5 + 30 × |Imon|) mV] 

± [0.2 % + (10 + 30 × |Imon|) mV] (temperature > 23 ± 5 °C) 

DC Current Bias 

DC Current Bias Range 0 ~ ± 100 mA 

DC Current Bias Resolution 40 μA 

DC Current Bias Accuracy 
± [2 % + (0.2 + |Vmon| / 20) mA] 

± [4 % + (0.4 + |Vmon| / 20) mA] (temperature > 23 ± 5 °C) 

DC Voltage Bias 

Detection Accuracy 

± [0.2 % + (5 + 0.3 × |Imon|) mV] 

± [0.4 % + (10 + 0.3 × |Imon|) mV] (temperature > 23 ± 5 °C) 

DC Current Bias 

Detection Accuracy 

± [1 % + (0.5 + |Vmon| / 10000) mA] 

± [2 % + (1.0 + |Vmon| / 5000) mA] (temperature > 23 ± 5 °C) 

Output Impedance 25 Ω / 100 Ω (nominal) 

Note: 

• Vmon: DC voltage offset monitor reading value [mV] 

• Imon: DC current offset monitor reading value [mA] 

DC Bias Voltage/Current Range: 

 

12.4 Scan Feature 

Scannable Parameters 

• Frequency 

• Signal Voltage 

• Signal Current 

• DC Bias Voltage 

• DC Bias Current 

Scan Type 

• Linear Frequency 

• Logarithmic Frequency 

• OSC Level (voltage, current) 

• DC Offset (voltage, current) 

• Logarithmic DC Bias (voltage, current) 

Scan Direction Up-value scan, down-value scan 

Measurement Points 2 ~ 1601 points 
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Segmented Scan (used to measure waveform points per segment) 

Available Setup Parameters 

for the Signal 

• Sweep Frequency Range 

• Level (voltage, current) 

• DC Offset (voltage, current) 

• Measurement Time 

• Point Average Coefficient 

• Segment Time 

• Segment Delay 

Number Of Segments 1 ~ 201 

Sweep Type Sequential scan or frequency scan 

Delay Time 

Type 

• Spot Delay 

• Sweep Delay 

• Segment Delay 

• DC Offset Delay 

Scope 0 ~ 30 s 

Resolution 1 ms 

12.5 Trigger Function 

Trigger Type 

• Continuous Trigger 

• Single Trigger 

• Average Trigger 

Trigger Source 

• Internal (Auto Trigger, External (Handler Connector Input) 

• GPIB/USB/LAN 

• Manual (Front Panel Keys) 

Trigger Event Type 
• Point Trigger 

• Sweep Trigger 

12.6 Measurement Time/Average 

Measurement Time Range 0 (fast) ~ 5 (precise), 6 steps 

Average Type 
• Point Average 

• Sweep Moving Average 

Average Coefficient 1 ~ 999 (integer value) 
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Measurement Time: 

 

Note: 

1) Additional time is required for each test when switching test ranges or when paranoid voltage/current is turned on: 

7 × test frequency period + 5 ms 

2) When automatic level control is turned on, additional test time needs to be added, and the added time varies according 

to the set conditions. 

Test speed 0 can shorten the test time of test speed 1 by about 2 ms, and the fastest test time is less than 2.5 ms each time. 

The specific shortened test time varies according to the frequency and range settings. 

12.7 Measurement Accuracy 

|Z|, |Y| Accuracy ±𝐄[%] 

Theta Accuracy ±E/100[rad] 

L, C, X, B Accuracy 

When Dx ≤ 0.1 ±E[%] 

When Dx > 0.1 ±E × √1 + Dx
2[%] 

R Accuracy 

When Dx ≤ 0.1 (Qx ≥ 10) 

Rp : ±
E

Dx ∓ E/100
[%] 

Rs : ±
E

Dx
[%] 

When 0.1 < Dx < 10 

(0.1 < Qx < 10) 

Rp : ± E ×
√1 + Dx

2

Dx ∓ E/100 × √1 + Dx
2

[%] 

Rs : ± E ×
√1 + Dx

2

Dx
[%] 

When Dx ≥ 10 (Qx ≤ 0.1) ±E[%] 

D Accuracy 

When Dx ≤ 0.1 ±E/100 
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When 0.1 < Dx ≤ 1 ±E × (1 + Dx)/100 

Q Accuracy (When Qx × Da < 1) 

When Qx ≤ 10 (Dx ≥ 0.1) ±
Qx

2 × E(1 + Dx)/100

1 ∓ Qx × E(1 + Dx)/100
 

When Qx > 10 (Dx < 0.1) ±
Qx

2 × E/100

1 ∓ Qx × E/100
 

G Accuracy 

When Dx > 0.1 ±E ×
√1 + Dx

2

Dx
[%] 

When Dx ≤ 0.1 ±E/Dx[%] 

Note: 

• Dx = Measured Value of D 

• Qx = Measured Value of Q 

• Da = Measurement Accuracy of D 

In an AC magnetic field, the following equations can be used to calculate the measurement accuracy. 

E × (1 + B × (5 + 500/Vmv))[%] (typ. ) 

• B = Magnetic Induction [ Gauss ] 

Impedance measurement accuracy of four-terminal-to-port 

Impedance measurement accuracy of four-terminal pair port [%] (typ.): 

E = Ep
′ + (

Zs
′

|Zx|
+ Yo

′ × |Zx|) × 100 

in: 

• Ep
′ = Epl + Epbw + Eposc + Ep[%] 

• Yo
′ = Yol + Kbw × Kyosc × (Yodc + Yo)[S] 

• Zs
′ = Zsl + Kbw × Kzosc × Zs[Ω] 

Epl [%] 

Cable Length Correction Factor: 

0 m: 0 

1 m: 0.02 + 2 × fm / 100 

2 m: 0.02 + 3 × fm / 100 

Epbw [%] 

Measurement Time 5: 0 

Measurement Time 4: 0.06 (when frequency < 50 kHz) 

 0.03 (when frequency ≥ 50 kHz) 

Measurement Time 3: 0.2 (when frequency < 50 kHz) 

 0.1 (when frequency ≥ 50 kHz) 

Measurement Time 2: 0.4 (when frequency < 50 kHz) 
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 0.2 (when frequency ≥ 50 kHz) 

Measurement Time 1: 0.8 (when frequency < 50 kHz) 

 0.4 (when frequency ≥ 50 kHz) 

Eposc [%] 

Vosc > 500 mV: 0.018 × (1000 / Vmv – 1) + fm / 100 

200 mV < Vosc ≤ 500 mV: 0.018 × (500 / Vmv – 1) 

100 mV < Vosc ≤ 200 mV: 0.018 × (200 / Vmv – 1) 

Vosc ≤ 100 mV: (100 / Vmv – 1) × (0.018 + Epbw) 

Ep [%] 

20 Hz ≤ fm < 100 Hz: 0.5 

100 Hz ≤ fm ≤ 800 Hz: 0.3 

800 Hz < fm ≤ 1 MHz: 0.075 

1 MHz < fm ≤ 15 MHz: 0.1 × fm 

15 MHz < fm ≤ 120 MHz: 1.5 

Yol [S] 

0 m: 0 

1 m: 500 n × fm / 100 

2 m: 1 μ × fm / 100 

Kbw 

Measurement Time 5: 1 

Measurement Time 4: 1 

Measurement Time 3: 3 (when frequency ≤ 1 MHz) 

 4 (when frequency > 1 MHz) 

Measurement Time 2: 4 (when frequency ≤ 1 MHz) 

 5 (when frequency > 1 MHz) 

Measurement Time 1: 6 (when frequency ≤ 1 MHz) 

 10 (when frequency > 1 MHz) 

Kyosc 
Vosc > 500 mV: 1000 / Vmv 

Vosc ≤ 500 mV: 500 / Vmv 

Yodc [S] 

0 mA ≤ DC current < 1 mA: 0 

1 mA ≤ DC current < 10 mA: 1 μ 

10 mA ≤ DC current hour: 10 μ 

Yo [S] 

20 Hz ≤ fm < 100 Hz: 10 n 

100 Hz ≤ fm ≤ 200 kHz: 2.5 n 

200 kHz < fm ≤ 500 kHz: 5 n 

500 kHz < fm ≤ 1 MHz: 10 n 

1 MHz < fm ≤ 15 MHz: 100 n 

15 MHz < fm ≤ 120 MHz: 500 n 

Zsl [Ω] 

0 m: 0 

1 m, 2 m: 

20 Hz ≤ fm < 500 Hz: 5 m 

500 Hz ≤ fm ≤ 120 MHz: 2 m 
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Kzosc 

Vosc > 500 mV: 2 

200 mV < Vosc ≤ 500 mV: 1 

100 mV < Vosc ≤ 200 mV: 200 / Vmv 

Vosc ≤ 100 mV: 100 / Vmv 

Zs [Ω] 
20 Hz ≤ fm < 100 Hz: 10 m 

100 Hz ≤ fm ≤ 120 MHz: 2.5 m 

Note: 

• fm: Measurement Frequency [MHz] 

• Vosc: Test Level 

• Vmv: Vosc [mV] 

 

Note: 

1) Typical value of impedance measurement accuracy of four ports on the front panel of ST2851 (test signal level 0.5 Vrms, 

measurement time is 5) 

2) Other areas that do not indicate the test accuracy are not used as accuracy indicators. 
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	10.4.9.2 :TRIG:AVER
	10.4.9.3 :TRIG:POIN
	10.4.9.4 :TRIG:EXT:DEL
	10.4.9.5 :TRIG:SOUR
	10.4.9.6 :TRIG:SCOP
	10.4.9.7 :TRIG:SING
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